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Chapter 1. Overview of WebSphere Adapter for JD Edwards
EnterpriseOne

With WebSphere® Adapter for JD Edwards EnterpriseOne, you can create
integrated processes that include the exchange of information with a JD Edwards
EnterpriseOne server, without special coding.

The adapter provides a standard interface that eliminates the need for the
component to understand the lower-level implementation details or data structures
of the application. Using the adapter, a component (the program or piece of code
that performs a specific business function) can send requests to the JD Edwards
EnterpriseOne server (for example, to query a customer record in a JD Edwards
EnterpriseOne table or to update an order document).

WebSphere Adapter for JD Edwards EnterpriseOne complies with the Java 2
Platform, Enterprise Edition (J2EE) Connector Architecture (JCA). JCA standardizes
the way application components, application servers, and enterprise information
systems, such as a JD Edwards EnterpriseOne server, interact with each other.
WebSphere Adapter for JD Edwards EnterpriseOne makes it possible for
JCA-compliant application servers to connect to and interact with the JD Edwards
EnterpriseOne server. Clients running on the JCA-compliant server can then
communicate with the JD Edwards EnterpriseOne server in a standard way (using
business objects or JavaBeans).

The following example assumes you are setting up an adapter using IBM®

Integration Designer and deploying the module that contains the adapter to IBM
Business Process Manager or WebSphere Enterprise Service Bus.

Suppose a medium-sized retail company uses JD Edwards EnterpriseOne to
coordinate most of its business operations. JD Edwards EnterpriseOne includes a
business function that can return a real-time list of inventory items for its 100
stores located across the United States. An application component might be able to
use this business function as part of an overall business process. For example, an
employee of a retail company can access the real-time list of available inventory
items, thus providing correct, real-time information to a customer.

Hardware and software requirements
The hardware and software requirements for WebSphere Adapters are provided on
the IBM Support website.

To view hardware and software requirements for WebSphere Adapters, see
http://www.ibm.com/support/docview.wss?uid=swg27006249.

Additional information

The following links provide additional information you might need to configure
and deploy your adapter:
v The compatibility matrix for WebSphere Business Integration Adapters and

WebSphere Adapters identifies the supported versions of required software for
your adapter. To view this document, go to the WebSphere Adapters support
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page: http://www-947.ibm.com/support/entry/portal/Overview/Software/
WebSphere/WebSphere_Adapters_Family.

v Technotes for WebSphere Adapters provide workaround and additional
information that are not included in the product documentation. To view the
technotes for your adapter, go to the following Web page, select the name of
your adapter from the Product category list, and click the search icon:
http://www.ibm.com/support/search.wss?tc=SSMKUK&rs=695&rank=8
&dc=DB520+D800+D900+DA900+DA800+DB560&dtm.

Technical overview of the Adapter for JD Edwards EnterpriseOne
IBM WebSphere Adapter for JD Edwards EnterpriseOne provides a way for
applications to interact with data on JD Edwards EnterpriseOne servers. Outbound
processing, which is the processing of requests from an application through the
adapter to the JD Edwards EnterpriseOne server, is supported.

The adapter processes requests using one of two types of business objects: business
functions and XML Lists. A business function is a business object container that
can contain one or many business objects which can be processed as a single
transaction. An XML List is a single business objects that can query a table and
return multiple records.

You create business objects by using the external service wizard, a tool launched
from IBM Integration Designer. The business objects generated by the external
service wizard have predefined business object definitions. If you want to add or
remove functionality from a generated business object, you can use the business
object editor, another tool launched from IBM Integration Designer, to change the
properties of the generated business object definition. You can also change or set
configuration properties for business objects in the administration console of IBM
Integration Designer.

Outbound processing
Adapter for JD Edwards EnterpriseOne supports synchronous outbound request
processing. This means that when the adapter receives a request, in the form of a
business object, from the module, it processes the request and returns the result,
when applicable, in a business object.

WebSphere Adapter for JD Edwards EnterpriseOne business applications supports
synchronous outbound processing. This implies that the component sends a
request in the form of a WebSphere business object hierarchy to the adapter, the
adapter processes the request and returns a WebSphere business object hierarchy
that represents the result of the operation.

When the adapter receives a WebSphere business object hierarchy, the adapter
processes it as follows:
1. Extracts metadata from the WebSphere business object hierarchy.
2. Identifies the appropriate JD Edwards EnterpriseOne objects to access (for

example, JD Edwards EnterpriseOne business objects and business components,
or JD Edwards EnterpriseOne business function, or JD Edwards EnterpriseOne
XML List) depending on the objects against which the artifacts were generated.

3. Extracts the outbound operation to perform from the WebSphere business
object hierarchy.
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4. Retrieves the data for XML List, or performs the corresponding business
function method, after accessing the required JD Edwards EnterpriseOne
objects.

5. Populates that JD Edwards EnterpriseOne object (business function or XML List
hierarchy) with data from the hierarchy of WebSphere business objects, if there
are updates (Create, Update, Delete), the adapter.

Supported outbound operations

When the adapter receives a request, it processes the request using the JD Edwards
EnterpriseOne Dynamic Java connector to invoke either a business function or an
XML List.

Business functions support the following types of operations:
v Create
v Delete
v Execute
v Retrieve
v Update

XML Lists support the following operation:
v retrieveAll

Table 1.

Operations Description

Create Creates the business object.

Delete Deletes the business object and its children. Because the adapter supports
only logical deletes, objects are marked as deleted but not removed.

Exists Checks for the existence of incoming business objects.

Retrieve Retrieves the JD Edwards EnterpriseOne component and maps component
data onto the business object.

RetrieveAll Retrieves multiple instances of the JD Edwards EnterpriseOne component
and maps component data onto the business object.

Update Updates the corresponding JD Edwards EnterpriseOne component with
the incoming business object.

Inbound processing
WebSphere Adapter for JD Edwards EnterpriseOne supports asynchronous
inbound processing. This means that the adapter polls theJD Edwards
EnterpriseOne server at specified intervals for events. When the adapter receives
an event, it converts the event data into a business object and sends the business
object to the component.

WebSphere Adapter for JD Edwards EnterpriseOne supports real-time events. A
real-time event is a business transaction that provides information from the JD
Edwards EnterpriseOne server that can be used to interoperate with a third-party
system. Real-time events can be generated wherever business functions run, such
as HTML, WIN32, and enterprise servers. Real-time events are useful for
producing notifications in real-time. The adapter supports both single and
container real-time events.
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When the adapter gets a real-time event from the JD Edwards EnterpriseOne
transaction server by invoking JD Edwards EnterpriseOne Dynamic Java Connector
API, it parses the content of this real-time event and converts it into a business
object. The adapter then sends the business object to the event endpoints. For
example, if a company is updated, the JD Edwards EnterpriseOne server captures
this change immediately, and one real-time event is generated by JD Edwards
EnterpriseOne transaction server. The adapter then communicates with the JD
Edwards EnterpriseOne transaction server, retrieves this real-time event, and
processes it. After converting it into a business object, the adapter delivers this
business object to the event endpoint.

WebSphere Adapter for JD Edwards EnterpriseOne processes events as follows:
1. Invokes JD Edwards EnterpriseOne Dynamic Java Connector API to get a

real-time event.
2. Parses the content of this real-time event.
3. Populates the associated business object with the values it retrieves from the

payload of this real-time event.
4. Sends the generated business object to each registered application.

Note: You must configure the JD Edwards EnterpriseOne to support real-time
events before inbound processing operation.

Event persistence
The adapter supports event persistence for inbound processing in case of abrupt
termination. Event persistence (or assured-once delivery) is a way to make sure
that events are delivered once, and only once, to the endpoint in the case of a
failure. During event processing, the adapter persists the event state in an event
store located at the data source.

You must set up this data source using IBM Business Process Manager or
WebSphere Enterprise Service Bus before you can create the event store. To use the
recovery feature provided by IBM Business Process Manager or WebSphere
Enterprise Service Bus, you set the AssuredOnceDelivery property in the activation
specification to True. This recovery feature is set to True by default.

The adapter also provides for event persistence using an in-memory representation
of the event store. When you use this feature, you need not create a JNDI data
source or an external event store, and event processing is faster. However, with this
feature there is no support for event recovery. In the case of server failure, the
in-memory event stores are lost.

To prevent the loss of events in the case of server failure, the recommended
approach is to use the database event store. To use the in-memory event
persistence capability of the adapter, you must not set the EP_DataSource_JNDIName
property.

When a failed event occurs and the file cannot be written to disk the JDE adapter
will print the content of this failed event to a JDE trace file, to avoid event loss.
The content will be between two "##########", and the trace level is INFO. The
content can be copied into a new file and saved with the event ID as the file name
in the directory "FailedEventFolder". When the status of the failed event record is
changed from -1 to 0 in the event table the event will be handled again.
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Event store
The event store is a persistent cache where event records are saved until the
polling adapter can process them. The adapter uses event stores to keep track of
inbound events as they make their way through the system. Each time a real-time
event is received, the adapter updates the status of the event in an event store. The
status of each event is continually updated by the adapter for recovery purposes
until the events are delivered to the endpoint.

If the adapter detects that there is no event store for the inbound module in the
IBM Business Process Manager or WebSphere Enterprise Service Bus, it
automatically creates one when the application is deployed to the runtime. Each
event store created by the adapter is associated with a specific inbound module.
The adapter does not support multiple adapter modules pointing to the same
event store.

When the adapter polls the JD Edwards EnterpriseOne transaction server and
receives a real-time event, it creates an entry in the event store for each event that
matches the search criteria specified in the activation specification properties. The
adapter records the status of each new entry as NEW.

If a real-time event is successfully delivered, the corresponding event store entries
are deleted. For failed events, the entries remain in the event store.

Assured-once delivery

The JD Edwards EnterpriseOne transaction server provides guaranteed event
delivery quality of service. This means that all the real-time events that the adapter
subscribes to are delivered to the adapter without any loss of events. Because it is
possible for the JD Edwards EnterpriseOne transaction server to send duplicate
real-time events to the adapter, the adapter provides assured-once event delivery.
This means that each event is delivered once and only once. To enable
assured-once delivery, you must set the AssuredOnceDelivery activation
specification property to True.

Note: When you set the AssuredOnceDelivery activation specification property to
True, you must set the AutoAcknowledge activation specification property to False.
Otherwise, the assured-once delivery feature will not work.

When you set the AssuredOnceDelivery activation specification property to True,
the adapter stores an XID (transaction ID) value for each event in the event store.

When a real-time event is obtained, it is processed as follows:
1. The XID value for the event is updated in the event store.
2. The event is delivered to its corresponding endpoint.
3. The event entry is deleted from the event store.
4. An acknowledgement is issued to the JD Edwards EnterpriseOne transaction

server.

Business objects
A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent either a business entity, such as an invoice or an employee record, or
unstructured text. The adapter uses business objects to send data to, or obtain data
from the JD Edwards EnterpriseOne server.
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How the adapter uses business objects

The adapter uses the JD Edwards EnterpriseOne Dynamic Java Connector APIs to
communicate with the JD Edwards EnterpriseOne application. The adapter
exchanges information with JD Edwards EnterpriseOne through business functions,
XML List calls and the real-time event mechanism.

The following figures illustrate how business objects are used by the adapter for JD
Edwards EnterpriseOne for outbound and inbound processing.

JD Edwards
EnterpriseOne

server

IBM Business Process Manager
or

IBM WebSphere Enterprise Service Bus

Application

JD EnterpriseOne
Dynamic Java Connector

IBM WebSphere
Adapter for
JD Edwards

EnterpriseOne

Request

XML List

Business
function

Business objects

Figure 1. How the adapter for JD Edwards EnterpriseOne uses business objects during
outbound processing
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How business objects are created

You create business objects by using the external service wizard, which is launched
from IBM Integration Designer. The external service wizard connects to the
application, discovers data structures in the application, and generates business
objects to represent them. It also generates other artifacts needed by the adapter.

The following figure illustrates the high-level flow of steps involved in creating
business objects using the external service wizard.

JD Edwards
EnterpriseOne

Transaction
Server

IBM Business Process Manager
or

IBM WebSphere Enterprise Service Bus

Endpoint

JD EnterpriseOne
Dynamic Java Connector

IBM
WebSphere
Adapter for
JD Edwards

EnterpriseOne

Business
object

XML Message

Real-time
event

Figure 2. How the adapter for JD Edwards EnterpriseOne uses business objects during inbound processing
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Business object structure

The adapter supports processing of hierarchical business objects. The top-level
business object that comes under the business graph is a wrapper container
business object. A container business object representing a JD Edwards
EnterpriseOne operation is a wrapper object that contains single or multiple child
business function objects, also called simple business function objects. Each
business function object represents a specific function call in the JD Edwards
EnterpriseOne application.

The following figures show diagram views of a business graph, a business object
container, a simple (or child) business object, a container business object for a
container real-time event, and a flat business object for a single real-time event.

Start

Finish

Establish connection
to JD Edwards
EnterpriseOne

Run query

Select objects to add
to business object

Enter configuration
criteria

Business object
is generated

Figure 3. Creating business objects using the external service wizard
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Figure 4. The structure of a business object graph, shown in a diagram view in IBM
Integration Designer

Figure 5. The structure of a business object container, shown in a diagram view in IBM
Integration Designer

Figure 6. The structure of a child business object, shown in a diagram view in IBM Integration
Designer

Chapter 1. Overview of WebSphere Adapter for JD Edwards EnterpriseOne 9



During adapter configuration, you can optionally choose to generate a business
graph. In version 6.0.2, each top-level business object is contained in a business
graph, which includes a verb that an application can use to specify additional
information about the operation to be performed. Beginning version 7.0, business
graphs are optional; they are required only when you are adding business objects
to a module created with an earlier version. If business graphs exist, they are
processed, but the verb is ignored.

The external service wizard
The external service wizard is a tool you use to configure your adapter before
deploying it to IBM Business Process Manager or WebSphere Enterprise Service
Bus. The external service wizard establishes a connection to the JD Edwards
EnterpriseOne server, discovers services (based on search criteria you provide), and
generates business objects and interfaces based on the services discovered.

Figure 7. Container business object for a container real-time event

Figure 8. Flat business object for a single real-time event
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Business faults
The adapter supports business faults, which are exceptions that are anticipated and
declared in the outbound service description, or import. Business faults occur at
predictable points in a business process, and are caused by a business rule
violation or a constraint violation.

Although IBM Business Process Manager and WebSphere Enterprise Service Bus
support other types of faults, the adapter generates only business faults, which are
called simply faults in this documentation. Not all exceptions become faults. Faults
are generated for errors that are actionable, that is, errors that can have a recovery
action that does not require the termination of the application. For example, the
adapter generates a fault when it receives a business object for outbound
processing that does not contain the required data or when the adapter encounters
certain errors during outbound processing.

Fault business objects

The external service wizard creates a business object for each fault that the adapter
can generate. In addition, the wizard creates a WBIFault superset business object,
which has information common to all faults, such as the message, errorCode, and
primarySetKey attributes as shown in Figure 9.

Some faults contain the matchCount attribute, to provide additional information
about the error. For others, WBIFault contains all the information needed to handle
the fault.

Figure 9. The structure of the WBIFault business object
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Chapter 2. Planning for adapter implementation

Before you configure WebSphere Adapter for JD Edwards EnterpriseOne, become
familiar with all of the security and performance options that are required for your
environment, including which deployment option to use. Also, if you are migrating
from an earlier version of WebSphere Adapter for JD Edwards EnterpriseOne,
perform any migration tasks.

Before you begin
Before you begin to set up and use the adapter, you should possess a thorough
understanding of business integration concepts, the capabilities and requirements
of the integration development tools and runtime environment you will use, and
the JD Edwards EnterpriseOne environment where you will build and use the
solution.

To configure and use WebSphere Adapter for JD Edwards EnterpriseOne, you
should understand and have experience with the following concepts, tools, and
tasks:
v The business requirements of the solution you are building.
v Business integration concepts and models, including the Service Component

Architecture (SCA) programming model.
v The capabilities provided by the integration development tools you will use to

build the solution. You should know how to use these tools to create modules,
test components, and complete other integration tasks.

v The capabilities and requirements of the runtime environment you will use for
the integration solution. You should know how to configure and administer the
host server and how to use the administrative console to set and modify
property definitions, configure connections, and manage events.

Note: When you deploy the JDE adapter in IBM Business Process Manager that is
running on a Unix platform, you need to run the following configuration file in
IBM Business Process Manager, else an exception error is thrown by IBM Business
Process Manager.

The configuration file, jaxp.properties.sample, can be located in the lib subdirectory
of the JRE of IBM Business Process Manager. The
javax.xml.parsers.SAXParserFactory, javax.xml.parsers.DocumentBuilderFactory,
javax.xml.xpath.XPathFactory, and javax.xml.transform.TransformerFactory
properties are defined in the jaxp.properties.sample file, but are commented out.
You need to uncomment the javax.xml.parsers.SAXParserFactory,
javax.xml.parsers.DocumentBuilderFactory, javax.xml.xpath.XPathFactory and
javax.xml.transform.TransformerFactory properties and rename the file from
jaxp.properties.sample to jaxp.properties.

Support for protecting sensitive user data in log and trace files
You can configure the adapter to prevent sensitive or confidential data, in the log
and trace files, from being viewed by users without authorization.

Log and trace files for the adapter can contain data from your JD Edwards
EnterpriseOne server, which might contain sensitive or confidential information.
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Sometimes these files might be seen by individuals without authorization to view
sensitive data. For example, a support specialist must use the log and trace files to
troubleshoot a problem.

To protect the data in such situations, the adapter lets you specify whether you
want to prevent confidential user data from displaying in the adapter log and trace
files. You can select this option in the external service wizard or change the
HideConfidentialTrace property. When this property is enabled, the adapter
replaces the sensitive data with XXX's.

See “Managed connection factory properties” on page 138 for information about
this optional property.

The following types of information are considered potentially sensitive data and
are disguised:
v The contents of a business object
v The contents of the object key of the event record
v User name, Password, Environment, and Role
v The URL used to connect to the JD Edwards EnterpriseOne server

The following types of information are not considered user data and are not
hidden:
v The contents of the event record that are not part of the event record object key,

for example, the XID, event ID, business object name, and event status
v Business object schemas
v Transaction IDs
v Call sequences

Security
The adapter uses the J2C authentication data entry, or the authentication alias
feature of Java 2 security to provide secure user name and password
authentication. For more information about security features, see the
documentation for IBM Business Process Manager or WebSphere Enterprise Service
Bus.

User authentication
The adapter supports several methods for supplying the user name and password
that are needed to connect to the JD Edwards EnterpriseOne server. By
understanding the features and limitations of each method, you can pick a method
that provides the appropriate level of security and convenience for your
application.

To integrate an adapter into your application, a user name and password are
needed at the following times:
v When the external service wizard connects to JD Edwards EnterpriseOne server

to extract, or discover, information about the objects and services that you can
access with the adapter.

v At run time on IBM Business Process Manager or WebSphere Enterprise Service
Bus, when the adapter connects to JD Edwards EnterpriseOne server to process
outbound requests.
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Authentication in the wizard

The external service wizard prompts for the connection information for the
discovery process, and then reuses it as the default values of the adapter properties
that specify the connection information used at run time. You can use a different
user name and password while running the wizard than you use when the
application is deployed to the server. You can even connect to a different JD
Edwards EnterpriseOne server, although the schema name must be the same in
both databases. For example, while developing and integrating an application that
uses WebSphere Adapter for JD Edwards EnterpriseOne, you might not use the
production database; using a test database with the same data format but fewer,
simulated records lets you develop and integrate the application without impacting
the performance of a production database and without encountering restrictions
caused by the privacy requirements for customer data.

The wizard uses the user name and password that you specify for the discovery
process only during the discovery process; they are not accessible after the wizard
is completed.

Authentication at run time

At run time, the adapter needs to provide the user name and password to connect
to the JD Edwards EnterpriseOne server. To connect without user intervention, the
adapter must access a saved copy of the user information. In a server environment,
there are several methods for saving user information. You can configure the
adapter to get your user information, through any of the following methods:
v Adapter properties
v Data source
v J2C authentication alias

Saving the user name and password in adapter properties is a direct way to
provide this information at run time. You provide this user name and password
when you use the external service wizard to configure your module. Although
directly specifying the user name and password seems the most straightforward
method, it has important limitations. Adapter properties are not encrypted; the
password is stored as clear text in fields that are accessible to others on the server.
Also, when the password changes, you must update the password in all instances
of the adapter that access that JD Edwards EnterpriseOne server. This includes the
adapters embedded in application EAR files as well as adapters that are separately
installed on the server.

Using a data source lets you use a connection already established for another
application. For example, if multiple applications access the same database with
the same user name and password, the applications can be deployed using the
same data source. The user name and password can be known only to the first
person who deploys an application to that data source or who defines a data
source separately.

Using a J2C authentication data entry, or authentication alias, created with the Java
Authentication and Authorization Service (JAAS) feature of Java 2 security is a
robust, secure way to deploy applications. An administrator creates the
authentication alias that is used by one or more applications that need to access a
system. The user name and password must be known only to that administrator,
who can change the password in a single place, when a change is required.
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Deployment options
There are two ways to deploy the adapter. You can either embed it as part of the
deployed application, or you can deploy it as a stand-alone RAR file. The
requirements of your environment affect the type of deployment option you
choose.

The following are the deployment options:
v With module for use by single application: With the adapter files embedded in

the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.

v On server for use by multiple applications: If you do not include the adapter
files in a module, you must install them as a stand-alone adapter on each
application server where you want to run the module. Use a stand-alone adapter
when multiple modules can use the same version of the adapter and you want
to administer the adapter in a central location. A stand-alone adapter can also
reduce the resources required by running a single adapter instance for multiple
modules.

An embedded adapter is bundled within an enterprise archive (EAR) file and is
available only to the application with which it is packaged and deployed.

Files

IBM Business Process Manager or
IBM WebSphere Enterprise Service Bus

Application

Enterprise information
system

Business
function

Embedded
AdapterModule

Module

ModuleModule

Module

Module

A stand-alone adapter is represented by a stand-alone resource adapter archive
(RAR) file, and when deployed, it is available to all deployed applications in the
server instance.
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Stand-alone
Adapter

Files

IBM Business Process Manager or
IBM WebSphere Enterprise Service Bus

Application A

Enterprise information
system

Business
function

Application B

Module

Module

ModuleModule

Module

Module

Module

Module

Module

While creating the project for your application using IBM Integration Designer, you
can choose how to package the adapter [either bundled with the (EAR) file or as a
stand-alone (RAR) file]. Your choice affects how the adapter is used in the run time
environment, as well as how the properties for the adapter are displayed on the
administrative console.

Choosing either to embed an adapter with your application or to deploy the
adapter as a stand-alone module depends on how you want to administer the
adapter. If you want a single copy of the adapter and do not care about disruption
to multiple applications when you upgrade the adapter, then you would be more
likely to deploy the adapter as a stand-alone module.

If you plan to run multiple versions, and if you care more about potential
disruption when you upgrade the adapter, you would be more likely to embed the
adapter with the application. Embedding the adapter with the application allows
you to associate an adapter version with an application version and administer it
as a single module.

Considerations for embedding an adapter in the application

Consider the following items if you plan to embed the adapter with your
application:
v An embedded adapter has class loader isolation.

A class loader affects the packaging of applications and the behavior of
packaged applications deployed on run time environments. Class loader isolation
means that the adapter cannot load classes from another application or module.
Class loader isolation prevents two similarly named classes in different
applications from interfering with each other.

v Each application in which the adapter is embedded must be administered
separately.
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Considerations for using a stand-alone adapter

Consider the following items if you plan to use a stand-alone adapter:
v Stand-alone adapters have no class loader isolation.

Because stand-alone adapters have no class loader isolation, only one version of
any given Java artifact is run and the version and sequence of that artifact is
undetermined. For example, when you use a stand-alone adapter there is only
one resource adapter version, one adapter foundation class (AFC) version, or one
third-party JAR version. All adapters deployed as stand-alone adapters share a
single AFC version, and all instances of a given adapter share the same code
version. All adapter instances using a given third-party library must share that
library.

v If you update any of these shared artifacts, all applications using the artifacts are
affected.
For instance, if you have an adapter that is working with server version X, and
you update the version of the client application to version Y, your original
application might stop working.

v Adapter Foundation Classes (AFC) is compatible with previous versions, but the
latest AFC version must be in every RAR file that is deployed in a stand-alone
manner.
If more than one copy of any JAR file is in the class path in a stand-alone
adapter, the one that is used is random; therefore, they all must be the latest
version.

Note:

When you install multiple adapters with different versions of
CWYBS_AdapterFoundation.jar, and if a lower version of the
CWYBS_AdapterFoundation.jar is loaded during runtime, the adapter will return
the ResourceAdapterInternalException error message, due to a version conflict. For
example, when you install Oracle E-Business Suite adapter version 7.0.0.3 and
WebSphere Adapter for JD Edwards EnterpriseOne version 7.5, the following error
message is displayed: IBM WebSphere Adapter for JD Edwards EnterpriseOne has
loaded file:/C:/IBM/WebSphere/ProcServer7/profiles/ProcSrv01/
installedConnectors/CWYOE_OracleEBS.rar/CWYBS_AdapterFoundation.jar with
version 7.0.0.3. However, the base level of this jar required is version 7.5. When
you install multiple adapters with different CWYBS_AdapterFoundation.jar
versions, the adapter returns the ResourceAdapterInternalException message, due
to a version conflict.

WebSphere Adapters in clustered environments
You can improve adapter performance and availability by deploying a module on
a clustered server environment. Clusters are groups of servers that are managed
together to balance workloads and to provide high availability and scalability.

The module you deployed is replicated across all servers in a cluster, regardless of
whether you deploy the module using a stand-alone or an embedded adapter. The
following IBM products support WebSphere Adapters in a clustered environment:
v IBM Business Process Manager or WebSphere Enterprise Service Bus
v WebSphere Application Server Network Deployment
v WebSphere Extended Deployment
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When you set up a server cluster, you create a Deployment Manager profile. The
HAManager, a subcomponent of the Deployment Manager, notifies the Java 2
Platform, Enterprise Edition (J2EE) Connector Architecture (JCA) container to
activate an adapter instance. For information about creating clustered
environments, see the following link: http://publib.boulder.ibm.com/infocenter/
wasinfo/v8r0/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/
trun_wlm_cluster_v61.html.

Using WebSphere Extended Deployment, you can optionally enhance the
performance of adapter instances in your clustered environment. WebSphere
Extended Deployment extends the WebSphere Application Server Network
Deployment capabilities by using a dynamic Workload Manager instance instead of
a static Workload Manager. The dynamic Workload Manager instance can optimize
the performance of adapter instances in the cluster by dynamically balancing the
load of the requests. This means that application server instances can be
automatically stopped and started based on the load variations, allowing systems
with different capacities and configurations to handle load variations evenly. For
information about the benefits of WebSphere Extended Deployment, see
http://publib.boulder.ibm.com/infocenter/wxdinfo/v6r1m1/index.jsp.

In clustered environments, adapter instances for WebSphere Adapter for JD
Edwards EnterpriseOne can handle outbound processes only.

High availability for inbound processes

Inbound processes are based on events triggered as a result of updates to data in
the JD Edwards EnterpriseOne server. WebSphere Adapter for JD Edwards
EnterpriseOne is configured to detect updates by polling an event table. The
adapter then publishes the event to its endpoint.

When you deploy a module to a cluster, the Java 2 Platform, Enterprise Edition
(J2EE) Connector Architecture (JCA) container checks the enableHASupport
resource adapter property. If the value for the enableHASupport property is true,
which is the default setting, all of the adapter instances are registered with the
HAManager with a policy 1 of N. This policy means that only one of the adapter
instances starts polling for events. Although other adapter instances in the cluster
are started, they remain dormant with respect to the active event until the active
adapter instance finishes processing the event. If the server on which the polling
thread was started shuts down for some reason, an adapter instance that is
running on one of the backup servers is activated.

Note: In the active-passive configuration mode of the adapters, the endpoint
application of the passive adapter instance also listens to the events/messages even
if the enableHASupport property is set to True. This is because the
alwaysactivateAllMDBs property in the JMS activation specification is set to True.
To stop the endpoint application of the passive adapter instance from listening to
the events, you must set the alwaysactivateAllMDBs property value to False. For
more information, see “Disabling end point applications of the passive adapter” on
page 122.

Note: In clustered environments, when the adapter works in a Active-Active
configuration, it provides both high availability and load balancing support. This
functionality is useful in production environments where high performance is
needed.

Important: Do not change the setting of the enableHASupport property.
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High availability for outbound processes

In clustered environments, multiple adapter instances are available to perform
outbound process requests. Accordingly, if your environment has multiple
applications that interact with WebSphere Adapter for JD Edwards EnterpriseOne
for outbound requests, then you might improve performance by deploying the
module to a clustered environment. In a clustered environment, multiple outbound
requests can be processed simultaneously, as long as they are not attempting to
process the same record.

If multiple outbound requests are attempting to process the same record, such as a
Customer address, the workload management capability in WebSphere Application
Server Network Deployment distributes the requests among the available adapter
instances in the sequence they were received. As a result, these types of outbound
requests in a clustered environment are processed in the same manner as those in a
single server environment: one adapter instance processes only one outbound
request at a time. For more information about workload management, see the
following link: http://publib.boulder.ibm.com/infocenter/wasinfo/v8r0/
index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/trun_wlm.html.

Migrating to version 7.5 of WebSphere Adapter for JD Edwards
EnterpriseOne

By migrating to version 7.5 of WebSphere Adapter for JD Edwards EnterpriseOne,
you automatically upgrade from the previous version of the adapter. Additionally,
you can migrate your applications that embed an earlier version of the adapter, so
that the applications can use features and capabilities present in version 7.5.

Migration considerations
WebSphere Adapter for JD Edwards EnterpriseOne version 7.5 may have some
features and updates that might affect your existing adapter applications. Before
migrating applications that use WebSphere Adapter for JD Edwards EnterpriseOne,
you must consider some factors that might affect your existing applications.

Compatibility with earlier versions

WebSphere Adapter for JD Edwards EnterpriseOne version 7.5 is fully compatible
with the custom business objects (XSD files) and data bindings that are created
using the adapter version 6.1x, version 6.2x, and version 7.0 and enables the
existing business objects and data bindings to work well in the latest version of the
adapter.

Because version 7.5 of WebSphere Adapter for JD Edwards EnterpriseOne is fully
compatible with version 6.1x, version 6.2x, and version 7.0, any of your
applications that used previous versions of WebSphere Adapter for JD Edwards
EnterpriseOne runs unchanged when you upgrade to version 7.5. However, if you
want your applications to use features and functionality present in version 7.5 of
the adapter, perform the migration of the artifacts as well as the upgrade of the
adapter.

The migration wizard replaces (upgrades) version 6.1.x, version 6.2.x, or version
7.0 of the adapter with version 7.5 and enables version 7.5 features and
functionality for use with your applications.
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Note: The migration wizard does not create components or modify existing
components, such as mappers and mediators to work with version 7.5 of the
adapters. If any of your applications embed an adapter that is version 7.0 or earlier
and you are upgrading to version 7.5, and you want your applications to take
advantage of the features and functions in version 7.5, you might need to change
those applications.

If the artifacts within a module have inconsistent versions, the entire module is
marked as unavailable for migration and cannot be selected. Version
inconsistencies are recorded in the workspace log, as they indicate that a project
might be corrupted.

The adapter migration wizard in IBM Integration Designer version 7.5 only
supports the migration of adapters from version 6.1x, version 6.2x, and version 7.0
to version 7.5. It does not support the adapter migration from lower versions to
any of the versions prior to version 7.5.

Deciding whether to upgrade or to upgrade and migrate

The default processing of the migration wizard is to perform an upgrade of the
adapter and to migrate the application artifacts so that the applications can use
features and functions in version 7.5 of the adapter. When you choose to upgrade
the adapter by selecting a project, the wizard automatically selects the associated
artifacts for migration.

If you decide that you want to upgrade the adapter from 6.1.x, version 6.2.x and
version 7.0 to version 7.5, but you do not want to migrate the adapter artifacts,
you can do so by deselecting the adapter artifacts from the appropriate area of the
migration wizard.

Running the migration wizard without selecting any adapter artifacts installs and
upgrades your adapter. As the artifacts are not migrated, your applications cannot
take advantage of the features and capabilities that exist in version 7.5 of the
adapter.

Migrating multiple adapters referred within a project

When a module contains one or more connector projects, each of which references
to different adapters (for example, a module project that contains connector
projects referring to JDBC and SAP adapters), the migration wizard identifies the
artifacts belonging to each adapter and migrates these artifacts without disrupting
the artifacts of other adapters.

When you select the module project and launch the migration wizard:
v The Source connector field lists the connector projects with the selected module

project.
v The Dependent artifact projects area lists only the selected module project.

If you select the connector project and launch the migration wizard:
v The Source connector field lists only the selected connector project.
v The Dependent artifact projects area lists all projects which reference the

selected connector project, including the module project.
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Run the migration wizard in a test environment

Because adapter migration might require you to change those applications that use
version 7.5 of WebSphere Adapter for JD Edwards EnterpriseOne, you must always
perform the migration in a development environment first and test your
applications before deploying the application to a production environment.

The migration wizard is fully integrated with the development environment.

Deprecated features

Become familiar with the deprecated features in version 7.0 and make any required
changes to your applications.

A deprecated feature is one that is supported but no longer recommended and that
might become obsolete. The following features from earlier versions of WebSphere
Adapter for JD Edwards EnterpriseOne have been deprecated in version 7.0 and
might require changes to your applications:
v In version 7.0, the Timeout property moved from a Resource Adapter property

to a Managed Connection Factory (J2C) property. In order provide compatibility
with earlier version with artifacts that were generated with the Timeout property
set as a Resource Adapter property (version 6.2.x), the Adapter for JD Edwards
EnterpriseOne, version 6.2.x behaves as follows:
1. The adapter looks for the Timeout property setting in the Managed

Connection Factory (J2C) properties.
2. If the Timeout property is not set as a Managed Connection Factory (J2C)

property, the adapter looks for it in the Resource Adapter properties.
3. If the Timeout property is not set as either a Managed Connection Factory

property or a Resource Adapter property, the adapter assigns the default
setting for the Timeout property of 30 seconds.

For more information about the Timeout property, refer to “Managed connection
factory properties” on page 138.

Performing the migration
You can migrate a project or EAR file to version 7.5 using the adapter migration
wizard. When the tool is finished, the migration is complete and you can work in
the project or deploy the module.

Before you begin

Review the information in Migration considerations.

About this task

To perform the migration in IBM Integration Designer, complete the following
steps.

Note: After migration is complete, the module is no longer compatible with
previous versions of the IBM Business Process Manager or WebSphere Enterprise
Service Bus runtimes or IBM Integration Designer.

The following steps describe how to run the adapter migration wizard from the
connector project menu while in the Java EE perspective in IBM Integration
Designer.
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Procedure
1. Import the PI (project interchange) file for an existing project into the

workspace.

Note: Ensure that you do not modify the contents of the RAR or copy the
adapter JAR file outside the connector project.

2. When projects are created in an earlier version of IBM Integration Designer, the
Workspace Migration wizard starts automatically and selects the projects to
migrate. Follow the wizard and complete the workspace migration. For more
information, see http://publib.boulder.ibm.com/infocenter/dmndhelp/
v7r5mx/topic/com.ibm.wbpm.wid.imuc.doc/topics/tmigsrcart.html.

3. Change to the Java EE perspective.
4. Right-click the module and select Migrate connector project. For example, the

adapter RAR module.
You can also launch the adapter migration wizard in the following ways:
v Right-click the project in the Java EE perspective and select Migrate adapter

artifacts.
v From the Problems view, right-click a migration-specific message and select

Quick Fix to correct the problem.
5. In the Select Projects window, perform the following steps:

a. The Source connector field displays the name of the connector project that
you are migrating. If you are migrating a module project, this field lists all
the connector projects in the module project. Select the source project from
the list. For more information, see “Migrating multiple adapters referred
within a project” on page 21.

b. The Target connector field displays the name of the connector to which you
are migrating. If you are working with more than one adapter version, this
list displays the names of all the compatible connectors. Select the connector
you want to migrate.

c. The Target version field displays the version corresponding to the target
connector that you selected in the previous step.

d. The Dependent artifacts project area lists the adapter artifacts that are
migrated. If you are migrating a module project, this area lists only the
selected module project. If you are migrating a connector project within the
module project, this area lists all projects which reference the selected
connector project, including the module project. By default, all the
dependent artifact projects are selected. If you do not select a dependent
artifact project, that project is not migrated. You can migrate any project that
you have not selected at a later time. Previously migrated projects, projects
with a current version, and projects that contain errors are unavailable for
migration and are not selected. For more information, see “Upgrading but
not migrating a project” on page 24.

e. Click Next. A warning window is displayed with the message, “Properties
that are not supported in this version of the target adapter will be removed
during the migration”.

f. Click OK.
6. In the Review Changes window, review the migration changes that occur in

each of the artifacts that you are migrating. To view the details, expand each
node by clicking the + sign.

7. To complete the migration:
v Click Finish.
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v If the files that need to be updated during migration are in read-only mode,
you will be unable to click on the Finish button. To view these files, click
Next. The Update Read-only files window displays the read-only files. To
update these files and continue with the migration, click Finish. To exit the
wizard without migrating the adapter, click Cancel.

Before running the migration process, the wizard performs a backup of all
projects affected by the migration. The projects are backed up to a temporary
folder within the workspace. If the migration fails for any reason, or if you
decide to cancel the migration before it completes, the wizard deletes the
modified projects and replaces them with the projects stored in the temporary
folder.
Upon completing the migration successfully, all backed up projects are deleted.

8. If you are migrating an EAR file, optionally create a new EAR file with the
migrated adapter and artifacts, and deploy it to IBM Business Process Manager
or WebSphere Enterprise Service Bus. For more information about exporting
and deploying an EAR file, see the topics devoted to it in this documentation.

Results

The project or EAR file is migrated to version 7.5. You do not need to run the
external service wizard after exiting the adapter migration wizard.

Upgrading but not migrating a project
You can upgrade the adapter from an earlier version, to version 7.5 while choosing
not to migrate the adapter project artifacts.

About this task

Running the migration wizard without selecting any adapter artifacts installs and
upgrades your adapter. As the artifacts are not migrated, your applications cannot
take advantage of the features and capabilities that exist in version 7.5 of the
adapter.

Procedure
1. Import the PI (project interchange) file into the workspace.
2. When projects are created in an earlier version of IBM Integration Designer, the

Workspace Migration wizard starts automatically and selects the projects to
migrate. Follow the wizard and complete the workspace migration. For more
information, see http://publib.boulder.ibm.com/infocenter/dmndhelp/
v7r5mx/topic/com.ibm.wbpm.wid.imuc.doc/topics/tmigsrcart.html.

3. In the Java EE perspective, right-click the project name and click Migrate
connector project. The Adapter Migration wizard is displayed.

4. In the Select Projects window, clear the dependent artifact projects, and click
Next. A warning window is displayed with the message, “The properties that
are not supported in the version of the target adapter will be removed during
the migration.”

5. Click OK.
6. In the Review Changes window, review the migration changes that occur

during updating the project. To view the details, expand each node by clicking
the + sign.

7. To complete the migration:
v Click Finish.
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v If the files that need to be updated during migration are in read-only mode,
you will be unable to click on the Finish button. To view these files, click
Next. The Update Read-only files window displays the read-only files. To
update these files and continue with the migration, click Finish. To exit the
wizard without migrating the adapter, click Cancel.

Results

The project can now be used with WebSphere Adapter for JD Edwards
EnterpriseOne, version 7.5.

Migrating WebSphere Business Integration applications
You need to migrate the WebSphere Business Integration applications so that they
become compatible with Version 7.5 of your adapter.

About this task

Migrating WebSphere Business Integration applications for use with Version 7.5 of
your WebSphere adapter is a multistep process. First, the artifacts from WebSphere
InterChange Server are migrated and converted. A project is then created for the
artifacts in IBM Integration Designer. In the remaining steps, the adapter-specific
artifacts are migrated and converted into the JCA-compliant format supported by
Version 7.5 of the adapter.

Example

The following diagram shows the wizards that you use to migrate WebSphere
Business Integration solutions from WebSphere InterChange Server, so that these
applications can be used with Version 7.5 of your adapter.

IBM Integration Designer
WebSphere InterChange Server

Installation directory

Imports/converts
WebSphere InterChange

artifacts
Jar file

The imported jar file
becomes a project in

-IBM Integration Designer
The adapter artifacts are
not fully
JCA-compliant at this point

Enterprise service
wizard

Migrating WebSphere Business Integration solutions

WebSphere
Interchange

Server migration
wizard

1

2 Run the External
service wizard to
import the connector
project

3 Adapter migration
wizard

Run the Adapter
migration wizard to
convert WBI adapter
artifacts into JCA-compliant
artifacts for use within
IBM Business Process
Manager

Migrating applications from WebSphere InterChange Server
To use Version 7.5 of WebSphere Adapter for JD Edwards EnterpriseOne with
applications from WebSphere InterChange Server, you need to migrate the
application artifacts and convert them so that they can be deployed and run on
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IBM Business Process Manager or WebSphere Enterprise Service Bus.
Understanding this task at a high level helps you perform the steps that are
needed to accomplish the task.

The following figure illustrates the flow of the migration task. The steps that
follow the figure describe this task at a high level only. See the topics following
this roadmap for the details on how to perform each of these steps.

Migrating applications from WebSphere InterChange Server

This task consists of the following steps:
1. Run the WebSphere InterChange Server migration wizard.

The WebSphere InterChange Server migration wizard moves the application
artifacts into IBM Integration Designer. The migrated adapter artifacts are not
fully JCA-compliant at the completion of this task.

2. Verify that the WebSphere InterChange Server migration is successful.
Review all messages from the Migration results window and take action if
required.

3. Consider the implications of using Version 7.5 of WebSphere Adapter for JD
Edwards EnterpriseOne.
In addition to considerations for migrating WebSphere InterChange Server
applications, you need to consider how Version 7.5 of WebSphere Adapter for
JD Edwards EnterpriseOne works with the migrated applications. Some of the
adapter operations supported by WebSphere InterChange Server applications
might be supported and implemented differently with Version 7.5 of the
adapter.

4. Run the adapter migration wizard.
Run the adapter migration wizard to update adapter-specific artifacts such as
the schemas and service definition files (.import,.export, and .wsdl files) for use
with Version 7.5 of the adapter.

Figure 10. Roadmap for migrating applications from WebSphere InterChange Server
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Migration considerations for WebSphere Business Integration
adapters

By migrating to WebSphere Adapter for JD Edwards EnterpriseOne Version 7.5,
you have an adapter that is compliant with the Java 2 Platform, Enterprise Edition
(J2EE) Connector Architecture (JCA) and designed specifically for service-oriented
architecture.

Application artifacts

Before running the adapter migration wizard, use the WebSphere InterChange
Server migration wizard to generate the application artifacts for the WebSphere
Business Integration adapter, including the business objects, maps, and
collaborations. Then you can run the adapter migration wizard to update the
adapter-specific artifacts such as the schemas and service definition files
(.import,.export, and .wsdl) so that they are suitably converted into a format that is
compliant with JCA.

Run the migration wizard in a test environment first

Because migrating from a WebSphere Business Integration adapter to WebSphere
Adapter for JD Edwards EnterpriseOne might require changes to the applications
that use Version 7.5 of WebSphere Adapter for JD Edwards EnterpriseOne, always
perform the migration in a development environment first and test your
applications before deploying the application to a production environment.

Migrating application artifacts from WebSphere InterChange
Server

To migrate the application artifacts into IBM Integration Designer, run the
WebSphere InterChange Server migration wizard. The wizard imports and converts
most of the artifacts into a format that is compatible with IBM Business Process
Manager or WebSphere Enterprise Service Bus.

Before you begin

Launch the WebSphere InterChange Server migration wizard from within IBM
Integration Designer to migrate the application artifacts from WebSphere
InterChange Server format into artifacts that are compatible with IBM Business
Process Manager or WebSphere Enterprise Service Bus.

For information about how to prepare to migrate artifacts from WebSphere
InterChange Server and for detailed instructions on performing the migration and
verifying that the migration was successful, see http://publib.boulder.ibm.com/
infocenter/dmndhelp/v7r5mx/topic/com.ibm.wbpm.wid.imuc.doc/topics/
twics.html.

About this task

Running WebSphere InterChange Server migration wizard might not fully convert
adapter-specific artifacts (such as service descriptors, service definitions, and
business objects) into IBM Business Process Manager or WebSphere Enterprise
Service Bus compatible artifacts. To complete the migration of adapter-specific
artifacts, run the adapter migration wizard after you have successfully run the
WebSphere InterChange Server migration wizard.
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Note: While you run the WebSphere InterChange Server migration wizard, ensure
that you set each connector in the repository to the same adapter version.

Results

The project and application artifacts are migrated and converted into IBM Business
Process Manager compatible artifacts.

What to do next

Run the adapter migration wizard to migrate the adapter-specific artifacts.

Migrating adapter-specific artifacts
After a project is created for the artifacts in IBM Integration Designer, you can
migrate the project using the adapter migration wizard. The adapter migration
wizard updates adapter-specific artifacts such as the schemas and service definition
files (.import, .export, and .wsdl) for use with version 7.5 of the adapter. When you
finish running the adapter migration wizard, the migration is complete and you
can work in the project or deploy the module.

Before you begin

Before running the adapter migration wizard, you should do the following steps:
v Review the information in “Migration considerations” on page 20.
v Run the WebSphere InterChange Server migration wizard to migrate the project

and convert data objects for use with IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

After migration is complete, the module will work only with Version 7.5 of your
adapter.

To perform the migration in IBM Integration Designer, complete the following
steps.

Procedure
1. Import the PI (project interchange) file for an existing project into the

workspace.
2. When projects are created in an earlier version of IBM Integration Designer, the

Workspace Migration wizard starts automatically and selects the projects to
migrate. Follow the wizard and complete the workspace migration. For more
information, see http://publib.boulder.ibm.com/infocenter/dmndhelp/
v7r5mx/topic/com.ibm.wbpm.wid.imuc.doc/topics/tmigsrcart.html.

3. Change to the Java EE perspective.
4. Right-click the connector project and select Migrate connector project.

You can also launch the adapter migration wizard by using the right-click
option and selecting the module project in the Java EE perspective and
selecting Migrate adapter artifacts.

Note:

If the adapter type (for example, CICS/IMS adapter) is not supported by the
migration wizard, the Migrate connector project and Migrate adapter artifacts

28 IBM WebSphere Adapters: IBM WebSphere Adapter for JD Edwards EnterpriseOne User Guide

http://publib.boulder.ibm.com/infocenter/dmndhelp/v7r5mx/topic/com.ibm.wbpm.wid.imuc.doc/topics/tmigsrcart.html
http://publib.boulder.ibm.com/infocenter/dmndhelp/v7r5mx/topic/com.ibm.wbpm.wid.imuc.doc/topics/tmigsrcart.html


menus are not available for selection. If the adapter project is of the latest
version and the module projects referencing this adapter project are also of the
latest version, these menus are disabled.
When you launch the migration wizard from the connector project while in the
Java EE perspective, by default all the dependent artifact projects are selected.
If you do not select a dependent artifact project, that project is not migrated.

5. In the Select Projects window, perform the following steps:
a. The Source connector field displays the name of the connector project that

you are migrating. Select the source project from the list.
b. The Target connector field displays the name of the connector to which you

are migrating. If you are working with more than one adapter version, this
list displays the names of all the compatible connectors. Select the connector
to which you want to migrate.

c. The Target version field displays the version corresponding to the target
connector you selected in the previous step.

d. The Dependent artifacts project area lists the adapter artifacts that are
migrated.

e. Review the tasks and warnings presented on the welcome page, and click
Next. A warning window is displayed with the message, “The properties
that are not supported in the version of the target adapter are removed
during the migration.”

Note: If the business object type is unsupported (non Object Discovery
Agent standard business object), the wizard displays an error message.
Correct the non ODA definition manually and run the migration wizard
again.

f. Click OK.
6. In the Review Changes window, review the migration changes that occur in

each of the artifacts that you are migrating. To view the details, expand each
node by clicking the + sign.

7. To complete the migration:
v Click Finish.
v If the files that need to be updated during migration are in read-only mode,

you will be unable to click on the Finish button. To view these files, click
Next. The Update Read-only files window displays the read-only files. To
update these files and continue with the migration, click Finish. To exit the
wizard without migrating the adapter, click Cancel.

Chapter 2. Planning for adapter implementation 29



Before performing the migration process, the wizard backs up all projects
affected by the migration. The projects are backed up to a temporary folder
within the workspace. If the migration fails for any reason, or if you decide to
cancel the migration before it completes, the wizard deletes the modified
projects and replaces them with the projects stored in the temporary folder.

8. Select Project > Clean, to refresh and rebuild the workspace for the changes to
take effect.

9. If you are migrating an EAR file, create a new EAR file with the migrated
adapter and artifacts, and deploy it to IBM Business Process Manager or
WebSphere Enterprise Service Bus. For information about exporting and
deploying an EAR file, see “Deploying the module for production” on page 92.

Results

The project is migrated to Version 7.5. You do not need to run the external service
wizard after exiting the adapter migration wizard.

Changes to the import, export, and WSDL files after migration
When the WebSphere InterChange Server migration wizard moves the application
artifacts into IBM Integration Designer, changes made are reflected in the service
definition files: the import, export and WSDL files.

The migrated adapter artifacts are not fully JCA-compliant at the completion of
this task. You can complete the migration of the adapter-specific artifacts (such as
service descriptors, service definitions, and business objects) to a JCA compatible
format by running the adapter migration wizard.

Changes to the import file

During migration, the affected module artifacts are migrated to an import file. The
existing JMS Binding property is changed to the EIS Binding property in the
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import file. The other property details added in the import file include information
about the data binding configuration, changes to the connection information in the
Managed Connection Factory properties, and several new method bindings.

Changes to the export file

During migration, the affected module artifacts are migrated to an export file. The
existing JMS Binding property is changed to the EIS Binding property in the export
file. The other property details added in the export file include information about
the data binding configuration, changes to the connection information in the
Activation Specification properties, and several new method bindings.

Changes to the WSDL file after migration

During migration, the affected module artifacts are migrated to corresponding
WSDL files that include adapter specific service description WSDL artifacts. The
service description files become JCA compatible. The WSDL files will have an
input and output type for each operation. Both the inbound and outbound
operations work on their specific input types to produce corresponding output
types after the operations are performed.

Note:

v The WebSphere Business Integration Adapter for JD Edwards EnterpriseOne
properties that are either not valid or not supported by WebSphere Adapter for
JD Edwards EnterpriseOne are removed from the migrated artifacts.

v As WebSphere Business Integration Adapter for JD Edwards EnterpriseOne and
WebSphere Adapter for JD Edwards EnterpriseOne use different runtimes, the
JDE migration inbound operation is not supported. You need to manually
configure the properties for inbound operations.

v Copy the JDE drivers to the following location: <your IID workspace> ->
CWYED_JDE -> connectorModule.

v After you migrate the adapter artifacts, you need to manually configure the
required property ‘Role'. If the property is not configured the adapter will not be
deployed on IBM Business Process Manager.
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Chapter 3. Samples and tutorials

To help you use WebSphere Adapters, samples and tutorials are available from the
Business Process Management Samples and Tutorials website.

You can access the samples and tutorials in either of the following ways:
v From the welcome page of IBM Integration Designer, click Go to Samples and

Tutorials. In the Samples and Tutorials pane, under More samples, click
Retrieve. Browse the displayed categories to make your selection.

v From the Business Process Management Samples and Tutorials website:
http://publib.boulder.ibm.com/bpcsamp/index.html.
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Chapter 4. Configuring the module for deployment

To configure the adapter so that it can be deployed on IBM Business Process
Manager or WebSphere Enterprise Service Bus, use IBM Integration Designer to
create a module, which is exported as an EAR file when you deploy the adapter.
You then specify the business objects you want to discover and the system on
which you want to discover them.

Road map for configuring the module
Before you can use WebSphere Adapter for JD Edwards EnterpriseOne in a
runtime environment, you must configure the module. Understanding this task at
a high level helps you perform the steps that are needed to accomplish the task.

You configure the module for the adapter to use by using IBM Integration
Designer. The following figure illustrates the flow of the configuration task, and
the steps that follow the figure describe this task at a high level only. See the topics
following this road map for the details on how to perform each of these steps.

Configuring the module for deployment environment

This task consists of the following step:

b) Configure
the selected
objects

a) Select
business
objects and
services

c) Set
deployment
properties

5. Configure the module

1. Create an authentication alias

2. Create the project

3. Add external software
dependencies

4. Set connection properties

Start

End
Success

Figure 11. Road map for configuring the module
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1. Create an authentication alias to access the JD Edwards EnterpriseOne server
with an encrypted password. This step is optional, depending on your policy
for handling passwords and IDs. You perform this step using the server.

2. Create the project. First, start the external service wizard in IBM Integration
Designer to begin the process of creating and deploying a module. The wizard
creates a project that is used to organize the files associated with the module.

3. Add the external software dependencies required by WebSphere Adapter for JD
Edwards EnterpriseOne to the project. These dependencies are also required
when you export the module as an EAR file, and deploy the EAR file to the
server.

4. Set connection properties that the external service wizard needs to connect to
the JD Edwards EnterpriseOne server for discovery of objects and services.

5. Configure the module for inbound processing or outbound processing by using
the external service wizard to find and select business objects and services from
the JD Edwards EnterpriseOne server, and to generate business object
definitions and related artifacts.
a. Select business objects and services for inbound or outbound processing

from the business integration components discovered by the external service
wizard.

b. Configure the selected objects by specifying operations and other properties
that apply to all the business objects.

c. Set deployment properties that the adapter uses to connect to the JD
Edwards EnterpriseOne server at run time. Then, generate the service by
using the external service wizard to save the new module, which contains
the business object or objects you configured, the import file or export file,
and the service interface.

Creating an authentication alias
An authentication alias is a feature that encrypts the password used by the adapter
to access the JD Edwards EnterpriseOne server. The adapter can use it to connect
to the JD Edwards EnterpriseOne server instead of using a user ID and password
stored in an adapter property.

Before you begin

To create an authentication alias, you must have access to the administrative
console. The following procedure shows you how to gain access to the
administrative console through Integration Designer.

The following procedure shows you how to gain access to the administrative
console through IBM Integration Designer. If you are using the administrative
console directly (without going through IBM Integration Designer), log in to the
administrative console and skip to step 2 on page 37.

About this task

Using an authentication alias eliminates the need to store the password in clear
text in an adapter configuration property, where it might be visible to others.

To create an authentication alias, use the following procedure.

Procedure
1. Start the administrative console.
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To start the administrative console through Integration Designer, perform the
following steps:
a. In the Business Integration perspective of Integration Designer, click the

Servers tab.
b. If the server does not show a status of Started, right-click the name of the

server (for example, WebSphere Process v6.2 Server) and click Start.
c. Right-click the name of the server and click Run administrative console.
d. Log on to the administrative console. If your administrative console requires

a user ID and password, type the ID and password and click Log in. If the
user ID and password are not required, click Log in.

2. In the administrative console, click Security > Secure administration,
applications, and infrastructure.

3. Under Authentication, expand Java Authentication and Authorization Service,
then click J2C authentication data.

4. Create an authentication alias.
a. In the list of J2C authentication aliases that is displayed, click New.
b. In the Configuration tab, type the name of the authentication alias in the

Alias field.
c. Type the user ID and password that are required to establish a connection

to the JD Edwards EnterpriseOne server.
d. Optional: Type a description of the alias.
e. Click OK.

The newly created alias is displayed.
The full name of the alias contains the node name and the authentication
alias name you specified. For example, if you create an alias on the node
widNode with the name ProductionServerAlias, then the full name is
widNode/ProductionServerAlias. This full name is the one you use in
subsequent configuration windows.

f. Click Save, and then click Save again.
5. Click New.

Results

You have created an authentication alias, which you will use when you configure
the adapter properties.

Creating the project
To begin the process of creating and deploying a module, you start the external
service wizard in IBM Integration Designer. The wizard creates a connector project,
which is used to organize the files associated with the module.

Before you begin

Ensure that you have gathered the information you need to establish a connection
to the JD Edwards EnterpriseOne server. For example, you need the name or IP
address of the JD Edwards EnterpriseOne server and the user ID and password to
access it.
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About this task

If you have an existing project, you can use it instead of creating a new one. Select
it before you start the wizard.

Procedure
1. To start the external service wizard, go to the Business Integration perspective

of IBM Integration Designer, and then click File > New > External Service.
Click Next.

2. In the New External Service window, expand the Adapters folder, select J D
Edwards, and then click Next.

3. In the Select an Adapter window, select IBM WebSphere Adapter for JD
Edwards EnterpriseOne (IBM : version), where version is the version of the
adapter you want to use, and then click Next.

4. In the Import a RAR File window, accept the default project name in the
Connector project field or type a different name.

5. In the Target runtime field, select the type of server where you want to deploy
the module. The wizard creates the artifacts that are appropriate to that server.

6. Click Next. The Locate the Required Files and Libraries window is displayed.

Results

A new connector project is created, which contains the adapter RAR file. The
project is listed in the Business Integration perspective .

What to do next

Continue working in the external service wizard. The next step is to add
database-specific files to the project.

Adding external software dependencies
The JD Edwards EnterpriseOne application requires that you add external software
dependencies to the project. These software dependencies enable the external
service wizard to communicate with the JD Edwards EnterpriseOne environment.

Before you begin

Create the project, or select an existing project.

About this task

To obtain the required software dependency files and specify their location, use the
following procedure.

Procedure
1. Obtain the JD Edwards EnterpriseOne software dependency files from your JD

Edwards EnterpriseOne administrator. The necessary files are listed in the
following table.

Note: The software dependencies differ, depending on which version of JD
Edwards EnterpriseOne Tools you use.
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Table 2. External software dependency files required by JD Edwards EnterpriseOne Tools

JD Edwards
EnterpriseOne Tools,
version 8.9 (SP1, SP2),
8.93

JD Edwards
EnterpriseOne Tools,
version 8.94

JD Edwards EnterpriseOne
Tools, version 8.95, 8.96

JD Edwards EnterpriseOne
Tools, version 8.97, 8.98

connector.jar Common_Jar.jar ApplicationAPIs_JAR.jar ApplicationAPIs_JAR.jar

database.jar Connector.jar ApplicationLogic_JAR.jar ApplicationLogic_JAR.jar

jdeinterop.ini database.jar Base_JAR.jar Base_JAR.jar

jdeLog.properties EventProcessor_EJB.jar BizLogicContainer_JAR.jar BizLogicContainerClient_JAR.jar

kernel.jar jdeutil.jar BizLogicContainerClient_JAR.jar BizLogicContainer_JAR.jar

log4j.jar jdbj.ini bootstrap.jar BusinessLogicServices_Jar.jar

owra.jar jdeinterop.ini castor.jar castor.jar

xalan.jar jdelog.properties Connector.jar commons-httpclient-3.0.jar

xerces.jar kernel.jar ecutils.jar commons-logging.jar

JDBC driver files

For example, if you are
using an Oracle
database server, use the
following JDBC driver
files:

v tnsnames.ora

v ojdbc6.jar

log4j.jar EventProcessor_JAR.jar Connector.jar

xalan.jar EventProcessor_EJB.jar EventProcessor_EJB.jar

xerces.jar jdbj.ini EventProcessor_JAR.jar

JDBC driver files

For example, if you are
using an Oracle
database server, use the
following JDBC driver
files:

v tnsnames.ora

v ojdbc6.jar

JdbjBase_JAR.jar Generator_JAR.jar

JdbjInterfaces_JAR.jar jdbj.ini

jdeinterop.ini JdbjBase_JAR.jar

jdelog.properties JdbjInterfaces_JAR.jar

JdeNet_JAR.jar jdeinterop.ini

lmproxy.jar jdelog.properties

log4j.jar JdeNet_JAR.jar

messagingClient.jar jmxremote.jar

naming.jar jmxremote_optional.jar

PMApi_JAR.jar jmxri.jar

Spec_JAR.jar log4j.jar

System_JAR.jar ManagementAgent_JAR.jar

urlprotocols.jar Metadata.jar

xalan.jar MetadataInterfaces_JAR.jar
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Table 2. External software dependency files required by JD Edwards EnterpriseOne Tools (continued)

JD Edwards
EnterpriseOne Tools,
version 8.9 (SP1, SP2),
8.93

JD Edwards
EnterpriseOne Tools,
version 8.94

JD Edwards EnterpriseOne
Tools, version 8.95, 8.96

JD Edwards EnterpriseOne
Tools, version 8.97, 8.98

xerces.jar PMApi_JAR.jar

JDBC driver files

For example, if you are using
an Oracle database server, use
the following JDBC driver files:

v tnsnames.ora

v ojdbc6.jar

Spec_JAR.jar

SystemInterfaces_JAR.jar

System_JAR.jar

xalan.jar

xerces.jar

xmlparserv2.jar

JDBC driver files

For example, if you are using
an Oracle database server, use
the following JDBC driver files:

v tnsnames.ora

v classes12.zip

2. Copy the external dependency files to a temporary location. For example, copy
them to C:\temp\JDE_dependencies\.

Tip: If you put the JDBC driver files in their own folder, it makes them easier
to browse to from the external service wizard. For example, if you are using an
Oracle database server, you can specify the tnsnames.ora and the
classes12.zip files in the following location: C:\temp\JDE_dependencies\
jdbc_driver\.

3. In the Required Files and Libraries window, use the following procedure to add
the external dependency files to the project. The following figure shows the
Required Files and Libraries window, with all of the required files selected for
JD Edwards EnterpriseOne Tools, version 8.98.
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a. Select the version of JD Edwards EnterpriseOne Tools from the left pane.
The required files for the version you choose are displayed in the right
pane.

b. To locate and select the required JAR, INI, and PROPERTIES files, click
Browse, navigate to the folder that contains the files listed, then click OK.

c. To add the JDBC driver files, click Add, navigate to the location of the JDBC
driver files, select the tnsnames.ora and classes12.zip files, then click OK.

4. Click Next.

Results

The adapter is configured with the names of the files it needs to communicate with
the JD Edwards EnterpriseOne server.

Figure 12. Required Files and Libraries window, showing the required files selected for JD
Edwards EnterpriseOne tools, version 8.98
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What to do next

Verify or edit the connection information in some of the external software
dependency files to make sure the external service wizard can connect with the JD
Edwards EnterpriseOne server.

Editing external dependency files
Some of the external dependency files for JD Edwards EnterpriseOne contain
editable information, such as the IBM Integration Designer workplace location and
JD Edwards EnterpriseOne server name and port number. This type of information
may need to be edited before you can establish a connection between the external
service wizard and the JD Edwards EnterpriseOne server.

Before you begin

Make sure you have added the external dependency files to your project and that
you know the location of the IBM Integration Designer workplace.

About this task

Verify that the information in your external dependency files correctly reflects the
IBM Integration Designer workplace location and the connection information
required by the JD Edwards EnterpriseOne environment. To do this, use the
following procedure.

For further information about configuring the external software dependency files,
refer to the JD Edwards EnterpriseOne Tools Connectors documentation for your
version of JD Edwards EnterpriseOne.

Procedure
1. If the external service wizard is open, click Cancel to close it.
2. In the Business Integration pane, expand the project name, then expand

connecorModule.
3. Verify the information in the jdbj.ini file.

a. Double-click jdbj.ini to open it. The file opens in Notepad.
b. Press Ctrl+F to search the file.
c. Enter tns in the Find what field.
d. Verify that the location listed for the tnsnames.ora file is the correct location

for the IBM Integration Designer workplace for this project. For example:
tns=C:\IBM\wid6.1\workspace\CWYED_JDE\connectorModule\tnsnames.ora

e. Click File > Save to save any changes you made to the file.
4. Verify the information in the jdeinterop.ini file.

a. Double-click jdeinterop.ini to open it. The file opens in Notepad.
b. Verify that the server name and the port number are correct. You can obtain

this information from the JD Edwards EnterpriseOne administrator.
c. Click File > Save to save any changes you made to the file.

5. Verify the information in the jdelog.properties file.
a. Double-click jdelog.properties to open it. The file opens in the right-pane of

IBM Integration Designer.
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b. Verify that the information in this file is correct. This file specifies log levels
and log file locations. You can obtain this information from the JD Edwards
EnterpriseOne administrator.

c. Click File > Save to save any changes you made to the file.

Results

The wizard has the files it needs to connect to the JD Edwards EnterpriseOne
server.

What to do next

In the Discovery and Configuration window, specify the connection properties that
the external service wizard needs to communicate with the JD Edwards
EnterpriseOne environment.

Setting connection properties for the external service wizard
To set connection properties for the external service wizard so that it can access the
JD Edwards EnterpriseOne server, specify such information as the user name and
password you use to access the server as well as the environment name and role
name required by the JD Edwards EnterpriseOne environment.

Before you begin

Make sure you have successfully added the external software dependency files,
and that you have edited the connection information in the dependency files.

About this task

Specify the connection properties that the external service wizard needs to connect
to the JD Edwards EnterpriseOne environment and discover its business objects
and services.

Note: You can optionally set bidirectional properties and logging properties in the
same external service wizard window as you set the connection properties.

To specify the required connection properties and optional bidirectional and
logging properties, use the following procedure.

Procedure
1. In the Select the Processing Direction window, select Outbound to pass data

from your service import to the adapter or Inbound to pass data from the
adapter to your service export, and then click Next. The Specify the Discovery
Properties window is displayed.

2. In the Select the Processing Direction window, specify the configuration
properties:
a. In the Environment field, type the name of the JD Edwards EnterpriseOne

environment.
b. In the Role field, type the role name you use to access the JD Edwards

EnterpriseOne environment.
c. In the User name field, type the user name required to access the JD

Edwards EnterpriseOne server.
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d. In the Password field, type the password you use to access the JD Edwards
EnterpriseOne server.

3. Optional: To set additional advanced properties, click Advanced.
4. Optional: To enable bidirectional support for the adapter at run time:

a. In the Bidi properties area, select Bidi transformation.
b. Set the ordering schema, text direction, symmetric swapping, character

shaping, and numeric shaping properties to control how bidirectional
transformation is performed.

5. Optional: To change the location of the log files for the wizard or the amount of
information included in the logs, click Change logging properties for wizard,
and then provide the following information:
a. In Log file output location, specify the location of the log file for the

wizard.
b. In Logging level, specify the severity of errors that you want logged.

Note: This log information is for the wizard only; at run time, the adapter
writes messages and trace information into the standard log and trace files
for the server.

6. Click Next.

Results

The external service wizard contacts the JD Edwards EnterpriseOne server, using
the information you provided (such as user name and password) to log in. You see
the Object Discovery and Selection window.

What to do next

Specify search criteria that the external service wizard uses to discover functions or
data on the JD Edwards EnterpriseOne server.

Configuring the module for outbound processing
To configure a module to use the adapter for outbound processing, use the external
service wizard in IBM Integration Designer to find and select business objects and
services from the JD Edwards EnterpriseOne server, and to generate the business
object definitions and related artifacts.

Generating business functions using external service
discovery

To configure WebSphere Adapter for JD Edwards EnterpriseOne using business
functions, use the external service wizard in IBM Integration Designer to select
business functions that are in the JD Edwards EnterpriseOne server, and generate
business object definitions and related artifacts for outbound processing.

Selecting business objects and services
To specify which business function you want to call and which data you want to
process, you provide information in the external service wizard.

Before you begin

Make sure you have set the connection properties for the external service wizard.
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About this task

Specify search criteria that the external service wizard uses to discover business
functions on the JD Edwards EnterpriseOne server. The external service wizard
returns a list of business functions that meet the search criteria.

To specify the search criteria and select a business function, use the following
procedure.

Procedure
1. In the Find Objects in the Enterprise System window, make sure the query is

set up to find business objects in the JD Edwards EnterpriseOne server. In the
Query field, make sure you see Business Functions=true. If you see Business
Functions=false, use the following procedure to set Business Functions to true.
a. Click Edit Query.
b. In the Query Properties window, clear the check box for XML Lists so that

query finds only business functions. The Add button in the Query
Properties window is grayed out.

c. Click OK.
2. Click Run Query.
3. In the Discovered objects list, select business function node and expand it.

a. Expand Business functions. This enables the filter button.
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b. Search for business functions using one of the following methods.
v Click the filter button if you know the Library name (for example, CFIN),

the C File name (for example, B01000033), and the business function
name (for example, GetEffectiveAddress) for the business function you
want.

v If you do not know the Library name, C File name, or business function
name, expand Business functions, expand the Library name, expand the
C File name, then select the business function.

Tip: The mouseover text indicates the purpose of each Library name and
C File name, as indicated in the following two figures.

Figure 13. Find Objects in the Enterprise System window
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4. Select the business function. For example, if you navigated to Business
Functions > CFIN > B0100033, select GetEffectiveAddress.

5. Click the arrow button to add the business function to the Selected objects list.

Figure 14. Find Objects in the Enterprise System window, showing discovered business
functions with the mouseover text for the CFIN Library displayed

Figure 15. Find Objects in the Enterprise System window, showing discovered business
functions with the mouseover text for the B0100033 C File displayed
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6. In the Specify the Configuration Properties for 'object' window, either accept
the default business object name or type a different name. The default name is
the name of the business function.

Note: The business object name has no semantic value, so you can give it a
meaningful name, and the name you assign it will not impact how the business
object functions.

7. Click OK to add the business function to the list of business objects to be
imported.

8. Click Next.

Results

You have selected the business function you want to work with and selected a
name for it.

What to do next

From the Specify Composite Properties window, specify a business object container
name and associated operation. Optionally specify a namespace and directory to
which the generated business object will be stored and indicate whether you want
a business graph generated.

Configuring the selected objects
To configure the business function, you specify information about the object, such
as the name of the object and the operation associated with the object.

Figure 16. Clicking arrow to add business function to Selected objects list
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Before you begin

Make sure you have selected and imported the business function.

About this task

To configure the business function, use the following procedure.

Procedure
1. Optional: In theSpecify Composite Properties window, enter the following

information.
a. If you do not want the business function to be enclosed within a business

graph, do not select the Business Graph check box. To enclose the business
function within a business graph, select the Business Graph check box.

b. In the Business object namespace field, use the default namespace
(http://www.ibm.com/xmlns/prod/websphere/j2ca/jde) except in the
following circumstance: if you are adding the business object to an existing
module and the module already includes that business object (from an
earlier run of the external service wizard), change the namespace value. For
example, you could change the namespace to http://www.ibm.com/xmlns/
prod/websphere/j2ca/jde1.

c. In the Relative path field, specify the directory to store the business object.
2. Required: Add a business object container to the business function, and assign

a name to the business object container. All business functions require that you
add a business object container.

Note: You can add one or many business functions inside a single business
object container.
a. Click the Add button.
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b. In the Add window, type a name in the Value field. You can type any
meaningful name. For example, if the business function is called
GetEffectiveAddress, you can type GetEffectiveAddressContainer.

3. Required: In the Operations Field, specify the Execute operation to be
associated with the business object.

Figure 17. Specify Composite Properties window, showing the "Add " window

50 IBM WebSphere Adapters: IBM WebSphere Adapter for JD Edwards EnterpriseOne User Guide



4. Required: Associate the business functions with an operation.
a. Click the Add button to create a business function.

Figure 18. Specify Composite Properties displaying the Operations field
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b. In the Add window, select the corresponding the business function, then
click OK.

5. Optional: Run a business function multiple times.
a. Select the corresponding business function.
b. Click the Add button to specify the properties for the business function.

Figure 19. Specify Composite Properties window
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c. Select the Array check box, to run the business function multiple times.
d. Select the RollBackOnWarning check box, to run the business function even

if the business function returns warnings.
e. Select the RunOnError check box, to run the business function even if the

business function returns an error.
6. Click Next.

Results

You specified a name for the business object container and selected an operation
for the business function. The Specify the Service Generation and Deployment
Properties window is displayed.

What to do next

Generate a deployable module that includes the adapter and the business objects.

Figure 20. Specify Composite Properties window, showing the "Add/Edit properties" window
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Setting deployment properties and generating the service
To generate the module, which is the artifact that is deployed on IBM Business
Process Manager or WebSphere Enterprise Service Bus, you create the module, and
associate the adapter with the module.

Before you begin

Make sure you have configured the business function. The Specify the Service
Generation and Deployment Properties window should be displayed.

About this task

Generate the module, which includes the adapter and configured business object.
The module is the artifact you deploy on the server.

To generate the module, use the following procedure.

Procedure
1. Optional: To change the default operation name, use the following procedure.

a. Click Edit Operations.
b. In the Edit Operation Names window, select the operation you want to

edit, then click Edit.
c. In the Add/Edit properties window, type a new operation name and

optional description, then click Finish.
2. Indicate whether you will use an authentication alias (instead of typing a user

ID and password) to establish a connection to the JD Edwards EnterpriseOne
server:
v To specify an authentication alias, leave Specify a Java Authentication and

Authorization Services (JAAS) alias security credential selected. Then, in
the J2C Authentication Data Entry field, enter the name you specified in
the Security section of the administrative console.

v If you are not going to use an authentication alias, clear Specify a Java
Authentication and Authorization Services (JAAS) alias security
credential.

3. Select With module for use by single application to embed the adapter files
in a module that is deployed to the application server, or select On server for
use by multiple applications to install the adapter files as a stand-alone
adapter.
v With module for use by single application: With the adapter files

embedded in the module, you can deploy the module to any application
server. Use an embedded adapter when you have a single module using the
adapter or if multiple modules need to run different versions of the adapter.
Using an embedded adapter enables you to upgrade the adapter in a single
module without the risk of destabilizing other modules by changing their
adapter version.

v On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter
on each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.
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4. If you selected On server for use by multiple applications in the previous
step, the Connection properties list becomes active. Make one of the
following selections:
v Select Specify connection properties if you want to provide configuration

information now. Then continue with step 5.
v Select Use predefined connection properties if you want to use a

connection factory configuration that already exists.
If you decide to use predefined connection properties, you must ensure that
your resource adapter name matches the name of the installed adapter,
because this is how the adapter instance is associated with these properties.
If you want to change the resource adapter name in the import or export,
use the assembly editor in IBM Integration Designer to change the value in
the import or export.
When you select Use predefined connection properties, the JNDI Lookup
Name field is displayed in place of the properties.
a. Type a value for JNDI Lookup Name.
b. Click Next.
c. Go to step 9.

5. In the Connection properties section, set or change any connection properties
that apply to your configuration.
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See “Managed connection factory properties” on page 138 for more
information about these properties.
Properties marked with an asterisk (*) are required.

6. To set additional properties, click Advanced and expand the sections.
v Process illegal XML characters

a. From the Illegal XML character processing drop-down list, select one of
the options that correspond to your requirement:
– Do not validate illegal XML characters, if you want to work with the

default adapter behavior.
– Throw exception if contents in the BO contains illegal XML

characters, if you want to proceed after you get an exception
message, and log the illegal XML characters in the trace file, at
runtime.

– Discard all illegal XML characters and related logs, if you want the
adapter to discard the illegal XML characters, and log the characters
in the trace file, at runtime.

Figure 21. Service Generation and Deployment Configuration window, showing the
Connection properties
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v Logging and tracing

– If you have multiple instances of the adapter, set Adapter ID to a value
that is unique for this instance.

7. Click Next.
8. Create a new module.

a. In the Specify the Location Properties window, click New in the Module
field.

b. In the Select a Business Integration Project Type window, select Create a
module project or Create a mediation module project, then click Next.

c. In the Create a Module window, type a name for the module.

Note: As you type the name, it is added to the workplace directory
specified in the Location field.

This is the default location. If you want to specify a different location,
remove the check from Use default location and type a new location, or
click Browse and select the location.

d. Specify whether you want to open the module in the assembly diagram
(for module projects) or whether you want to create a mediation flow
component (for mediation module projects). By default, these choices are
selected.

e. Click Finish. The new module is created. When the creation process is
finished, the New Module window closes, and the new module appears in
the Module list in the Service Location Properties window.

9. In the Specify the Location Properties window, you can specify deployment
properties for the new module by performing the following steps.
a. If you want to change the default namespace, clear the Use Default

Namespace check box and type a new path in the Namespace field.
b. Specify the folder within the module where the service description should

be saved by typing a name in the Folder field or by browsing for a folder.
c. Change the name of the interface.

The default name is JDEOutboundInterface. You can change it to a more
descriptive title if you prefer.

d. If you want to save the business objects so that they can be used by
another application, click Save business objects to a library, then select a
library from the list, or click New to create a new library.

e. Type a description of the module.

Figure 22. Processing methods for illegal XML characters
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10. Click Finish.

Results

The new module is created, configured and saved to the Business Integration
perspective of IBM Integration Designer.

What to do next

Export the module as an EAR file for deployment.

Generating XML Lists using external service discovery
To configure WebSphere Adapter for JD Edwards EnterpriseOne using XML Lists,
use the external service wizard in IBM Integration Designer to select XML Lists
that are in the JD Edwards EnterpriseOne server, and generate business object
definitions and related artifacts for outbound processing.

Selecting business objects and services
To specify which data you want to process for the XML List, you provide
information in the external service wizard.

Before you begin

Make sure you have set the connection properties for the external service wizard.
Also, make sure you have gathered the table information, including table names
and table types, for the XML Lists you want to create.

Tip: Use the JD Edwards EnterpriseOne Universal Table Browser (UTB) to gather
the table information for the XML Lists you want to create. For information about
using the JD Edwards EnterpriseOne UTB, refer to the JD Edwards EnterpriseOne
Tools 8.96 System Administration Guide.

About this task

Specify search criteria that the external service wizard uses to discover database
table information on the JD Edwards EnterpriseOne server. The external service
wizard returns a list of objects that meet the search criteria.

To specify the search criteria for creating an XML List, use the following procedure.

Procedure
1. In the Specify Composite Properties window, edit the query to prepare it to

find the table information that is required for creating the XML List.
a. Click Edit Query.
b. In the Query Properties window, select XML Lists.

Note: You can optionally clear the check box for Business Functions so the
query finds only XML Lists. If you leave Business Functions selected, the
query returns both XML Lists and business functions.

c. To add the table name, click Add.
d. In the Add window, enter the name of the database table you want to add

to the query. For example, enter F0116 for the database table. If you do not
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know the name of the table you need, you can use the JD Edwards
EnterpriseOne Universal Table Browser (UTB) to find it on the JD Edwards
EnterpriseOne server.

e. Click OK in the Add window. The table name you entered is displayed in
the Tables list.

f. Click OK in the Query Properties window.

The query is now ready to discover the JD Edwards EnterpriseOne database
table you specified in order to create the XML List.

2. Run the XML List query to find and discover the table in the JD Edwards
EnterpriseOne server that matches the table you specified.
a. Click Run Query. The external service wizard queries the JD Edwards

EnterpriseOne server. The results of the query appear in the Discovered
objects list.

b. In the Discovered objects list, expand the XML Lists.
c. Navigate to the table that matches the table you created.
d. Click the arrow button to add the table to the Selected objects list.

Figure 23. Find Objects in the Enterprise System window, showing the Query field ready to
run an XML List query
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3. In the Specify Composite Properties window, add search criteria to the XML
List query before importing the data from the JD Edwards EnterpriseOne
server. This allows you to specify query parameters such as table type and
sorting conditions.
a. In the Business Object Name field, you can either keep the default business

object name or rename it to suit your needs. The default name is the name
of the table.

Note: The business object name has no semantic value, so you can give it a
meaningful name, and the name you assign it will not impact how the
business object functions.

b. In the Table type field, select the type of table from the list. For example,
select OWTABLE table type for the F0116 table.

Figure 24. Click arrow to add the discovered table to Selected objects list
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The following table types are available.

Table 3. Table types for XML Lists

Table type Description When to use

OWTABLE A JD Edwards EnterpriseOne database
table

Use this table type if the table you want
is located in the JD Edwards
EnterpriseOne database.

OWVIEW A business view used to define the
relationship between two or more tables
and joins the data into a single view

Use this business view as input to the
TABLE_CONVERSION table type.

Figure 25. Specify Configuration Properties window, showing OWTABLE selected in the Table
type field
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Table 3. Table types for XML Lists (continued)

Table type Description When to use

FOREIGN_TABLE A non-JD Edwards EnterpriseOne
database table that resides in a database
supported by JD Edwards EnterpriseOne,
such as Oracle, Access, iSeries®, or SQL
Server

Use this table type if the table you want
is located in a non-JD Edwards
EnterpriseOne database.

TABLE_CONVERSION A table type that uses batch processes
which allow you to rapidly manipulate
data in tables. You can set up table
conversions as templates, running them
multiples times, then revising them using
different versions to suit the needs of
your environment.

Use this table type if you plan to
manipulate batches of data in one of the
following ways:

v Data Conversion: allows you to
transfer data from an input table or
business view into output tables; also
allows you to update records in a table
or business view

v Data Copy: allows you to copy tables
from one data source or environment
to another data source or environment
when the tables are identical

v Data Copy with Table Input: allows
you to copy tables based on
information from an input table.

v Batch Delete: allows you to delete
records from a table or business view

c. To add a sorting condition to the query, click Add Sorting, click Select to
select the attribute you want sorted, then select ASCENDING or
DESCENDING from the Sorting list.

Note: If you want to remove a sorting condition, click Remove Sorting
Condition.

d. To add other conditions to the query, click Add Condition, then select one
of the following conditions.
v Attribute: Select the attribute for which you want to add a condition.
v Clause: Select the clause for the query condition. The default is Where.
v Operator: Select the operator when comparing the attribute to the column

value.
v Use Attribute Value: Select an attribute to compare to.
v Default: Specify the default value for the query condition.

Note: If no conditions are specified, all records are retrieved. If you want to
add multiple conditions to the query, click Add Condition again. If you
want to remove any unwanted conditions, click Remove condition.

e. Click OK. The table name is displayed in the Selected objects list.
4. Click Next.

Results

You have selected the table you want to work with and configured it for the XML
List you want to create.
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What to do next

From the Specify Composite Properties window, you can optionally specify a
namespace and directory to which the generated XML List will be stored.

Configuring the selected objects
To configure the XML List, you need to specify information about the object, such
as the maximum number of records to retrieve.

Before you begin

Make sure you have selected and imported the XML List.

About this task

To configure the XML List, use the following procedure.

Procedure
1. Optional: In the Specify Composite Properties window, enter the following

information.

Figure 26. Specify Composite Properties window, showing optional configuration settings for
XML Lists
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a. If you do not want the XML List to be enclosed within the business graph,
do not select the Business Graph check box. To enclose the XML List within
a business graph, select the Business Graph check box.

b. In the Business object namespace field, use the default namespace
(http://www.ibm.com/xmlns/prod/websphere/j2ca/jde) except in the
following circumstance: if you are adding the XML List to an existing
module and the module already includes that XML List (from an earlier run
of the external service wizard), change the namespace value. For example,
you could change the namespace to http://www.ibm.com/xmlns/prod/
websphere/j2ca/jde1.

c. In the Relative path field, specify the directory to store the XML List.
d. In the Maximum number of records field, specify the maximum number of

records to retrieve when processing a RetrieveAll operation. The default
value is 100.

e. In the Timeout (milliseconds) field, specify a timeout value in milliseconds.
If no value is set, the default value is 30,000 milliseconds (or 30 seconds).

Important: The business object container name and associated operation for the
XML List is set by default as follows:
v Business object container name: <XML_List_object>Container
v Operation: RetrieveAll

2. Click Next.

Results

You have set optional configuration parameters for the XML List object. The
external service wizard automatically assigned the business object container name
and associated operation for the XML List. The Generate Artifacts window opens.

What to do next

Generate a deployable module that includes the adapter and the business object.

Setting deployment properties and generating the service
To generate the module, which is the artifact that is deployed on IBM Business
Process Manager or WebSphere Enterprise Service Bus, you create the module, and
associate the adapter with the module.

Before you begin

Make sure you have configured the XML List. The Specify the Service Generation
and Deployment Properties window should be displayed.

About this task

Generate the module, which includes the adapter and configured business object.
The module is the artifact you deploy on the server.

To generate the module, use the following procedure.

Procedure
1. Optional: To change the default operation name, use the following procedure.

a. Click Edit Operations.
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b. In the Edit Operation Names window, select the operation you want to
edit, then click Edit.

c. In the Add/Edit properties window, type a new operation name and
optional description, then click Finish.

2. Indicate whether you will use an authentication alias (instead of typing a user
ID and password) to establish a connection to the JD Edwards EnterpriseOne
server:
v To specify an authentication alias, leave Specify a Java Authentication and

Authorization Services (JAAS) alias security credential selected. Then, in
the J2C Authentication Data Entry field, enter the name you specified in
the Security section of the administrative console.

v If you are not going to use an authentication alias, clear Specify a Java
Authentication and Authorization Services (JAAS) alias security
credential.

3. Select With module for use by single application to embed the adapter files
in a module that is deployed to the application server, or select On server for
use by multiple applications to install the adapter files as a stand-alone
adapter.
v With module for use by single application: With the adapter files

embedded in the module, you can deploy the module to any application
server. Use an embedded adapter when you have a single module using the
adapter or if multiple modules need to run different versions of the adapter.
Using an embedded adapter enables you to upgrade the adapter in a single
module without the risk of destabilizing other modules by changing their
adapter version.

v On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter
on each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.

4. If you selected On server for use by multiple applications in the previous
step, the Connection properties list becomes active. Make one of the
following selections:
v Select Specify connection properties if you want to provide configuration

information now. Then continue with step 5.
v Select Use predefined connection properties if you want to use a

connection factory configuration that already exists.
If you decide to use predefined connection properties, you must ensure that
your resource adapter name matches the name of the installed adapter,
because this is how the adapter instance is associated with these properties.
If you want to change the resource adapter name in the import or export,
use the assembly editor inIBM Integration Designer to change the value in
the import or export.
When you select Use predefined connection properties, the JNDI Lookup
Name field is displayed in place of the properties.
a. Type a value for JNDI Lookup Name.
b. Click Next.
c. Go to step 9.
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5. In the Connection properties section, set or change any connection properties
that apply to your configuration.

See “Managed connection factory properties” on page 138 for more
information about these properties.
Properties marked with an asterisk (*) are required.

6. To set additional properties, click Advanced and expand the sections.
v Process illegal XML characters

a. From the Illegal XML character processing drop-down list, select one of
the options that correspond to your requirement:

Figure 27. Specify the Service Generation and Deployment Properties window, showing the
Connection properties section
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– Do not validate illegal XML characters, if you want to work with the
default adapter behavior.

– Throw exception if contents in the BO contains illegal XML
characters, if you want to proceed after you get an exception
message, and log the illegal XML characters in the trace file, at
runtime.

– Discard all illegal XML characters and related logs, if you want the
adapter to discard the illegal XML characters, and log the characters
in the trace file, at runtime.

v Logging and tracing

– If you have multiple instances of the adapter, set Adapter ID to a value
that is unique for this instance.

7. Click Next.
8. Create a new module.

a. In the Specify the Location Properties window, click New in the Module
field.

b. In the Integration Project window, select Create a module project or
Create a mediation module project, then click Next.

c. In the New Module window, type a name for the module.

Note: As you type the name, it is added to the workplace directory
specified in the Location field.

This is the default location. If you want to specify a different location,
remove the check from Use default location and type a new location, or
click Browse and select the location.

d. Specify whether you want to open the module in the assembly diagram
(for module projects) or whether you want to create a mediation flow
component (for mediation module projects). By default, these choices are
selected.

e. Click Finish. The new module is created. When the creation process is
finished, the New Module window closes, and the new module appears in
the Module list in the Service Location Properties window.

9. In the Specify the Location Properties window, perform the following steps to
complete the process of generating the module.
a. If you want to change the default namespace, clear the Use Default

Namespace check box and type a new path in the Namespace field.

Figure 28. Processing methods for illegal XML characters
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b. Specify the folder within the module where the service description should
be saved by typing a name in the Folder field or by browsing for a folder.

c. Change the name of the interface.
The default name is JDEOutboundInterface. You can change it to a more
descriptive title if you prefer.

d. If you want to save the business objects so that they can be used by
another application, click Save business objects to a library, then select a
library from the list, or click New to create a new library.

e. Type a description of the module.
10. Click Finish.

Results

The new module is created, configured and saved to the Business Integration
perspective of IBM Integration Designer.

What to do next

Export the module as an EAR file for deployment.

Configuring the module for inbound processing
To configure a module to use the adapter for inbound processing, use the external
service wizard in IBM Integration Designer to find and select business objects and
services from the JD Edwards EnterpriseOne server, and to generate business
object definitions and related artifacts.

Selecting business objects and services
To specify which real-time events you want to work with, you provide information
in the external service wizard.

Before you begin

Make sure you have set the connection properties correctly for the external service
wizard.

About this task

Specify search criteria that the external service wizard uses to discover real-time
events on the JD Edwards EnterpriseOne server. The external service wizard
returns a list of business functions that meet the search criteria.

To specify the search criteria and select a real-time event, use the following
procedure.

Procedure
1. In the Find Objects in the Enterprise System window, make sure the query is

set up to find real-time events in the JD Edwards EnterpriseOne server. In the
Query field, make sure you see the following query criteria: Real-Time
Events=true. If you see Real-Time=false, use the following procedure to set it
to true.
a. Click Edit Query.
b. In the Query Properties window, select Real-Time Events.
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c. Click OK.
2. Click Run Query.
3. In the Discovered objects list, expand the following root node: Real-Time

Events and select one or more real-time events you want to work with.
4. Click the arrow button to add the real-time event to the Selected objects list.

5. In the Specify the Configuration Properties for 'object' window, you can
associate an operation with the action needed for the selected real-time event.
This is required for real-time events which do not already have an operation
field to store the action for the real-time event. If the real-time event already
has an operation field, then you need only specify the name of the operation,
not the field containing the associated action.
v To associate an operation field with the selected real-time event, use the

following procedure.
a. In the Selection field, select Configuration with Operation Field. The

Specify the Configuration Properties for 'object' window expands, as
shown in the following figure.

Figure 29. Click arrow to add the RTCOOUT real-time event to Selected objects list
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b. In the expanded window, enter information in the following fields:
– List Children: All single real-time events which are contained by the

container real-time event or the single real-time event itself
– Operation Field: The operation field stores the action information

associated with the operation.
1) Click Select to select a value for the operation field.
2) In the Select window, select the action for the operation, then click

OK.

Figure 30. Specify the Configuration Properties window

70 IBM WebSphere Adapters: IBM WebSphere Adapter for JD Edwards EnterpriseOne User Guide



– User-defined: Create: Leave the default number ("1") to use for
mapping the Create operation to the selected action, or specify a new
number.

– User-defined: Update: Leave the default number ("2") to use for
mapping the Update operation to the selected action, or specify a new
number.

– User-defined: Delete: Leave the default number ("3") to use for
mapping the Delete operation to the selected action, or specify a new
number.

c. Click OK.
v To select the real-time event without associating an operation field, use the

following procedure.
a. In the Selection field, select Configuration without Operation Field.
b. In the Find Objects in the Enterprise System window, specify the

operation to use with the selected real-time event.

Figure 31. Select window, showing possible actions to select
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c. Click OK.

The selected real-time event is added to the Selected objects list.

6. Click Next.

Figure 32. Configuration Properties window

Figure 33. The selected real-time event displayed in the Selected objects list
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Results

You have selected the real-time event you want to work with and configured the
appropriate operation mapping relationship for it.

What to do next

From the Specify Composite Properties window, you specify the directory where to
store the real-time events.

Configuring the selected objects
To configure the real-time event, you specify information about the object.

Before you begin

Make sure you have selected and imported the real-time event.

About this task

To configure the real-time event, use the following procedure.

Procedure
1. In the Specify Composite Properties window, specify the directory to store the

business object in the Relative path field.
2. Click Next.

Results

You specified a location to store the real-time event. The Specify the Service
Generation and Deployment Properties window is displayed.

What to do next

Generate a deployable module that includes the adapter and the real-time event.

Setting deployment properties and generating the service
To generate the module, which is the artifact that is deployed on IBM Business
Process Manager or WebSphere Enterprise Service Bus, you create the module, and
associate the adapter with the module.

Before you begin

Make sure you have configured the real-time event. The Specify the Service
Generation and Deployment Properties window should be displayed.

About this task

Generate the module, which includes the adapter and configured business object.
The module is the artifact you deploy on the server.

To generate the module, use the following procedure.
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Procedure
1. Optional: To change the default operation name, use the following procedure.

a. Click Edit Operations.
b. In the Edit Operation Names window, select the operation you want to

edit, then click Edit.
c. In the Add/Edit properties window, type a new operation name and

optional description, then click Finish.
2. Indicate whether you will use an authentication alias (instead of typing a user

ID and password) to establish a connection to the JD Edwards EnterpriseOne
server:
v To specify an authentication alias, leave Specify a Java Authentication and

Authorization Services (JAAS) alias security credential selected. Then, in
the J2C Authentication Data Entry field, enter the name you specified in
the Security section of the administrative console.

v If you are not going to use an authentication alias, clear Specify a Java
Authentication and Authorization Services (JAAS) alias security
credential.
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3. Select With module for use by single application to embed the adapter files
in a module that is deployed to the application server, or select On server for
use by multiple applications to install the adapter files as a stand-alone
adapter.
v With module for use by single application: With the adapter files

embedded in the module, you can deploy the module to any application
server. Use an embedded adapter when you have a single module using the
adapter or if multiple modules need to run different versions of the adapter.

Figure 34. Specify the Service Generation and Deployment Properties window, showing the
Connection properties section
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Using an embedded adapter enables you to upgrade the adapter in a single
module without the risk of destabilizing other modules by changing their
adapter version.

v On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter
on each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.

4. If you selected On server for use by multiple applications in the previous
step, the Connection properties list becomes active. Make one of the
following selections:
v Select Specify connection properties if you want to provide configuration

information now. Then continue with step 5.
v Select Use predefined connection properties if you want to use a

connection factory configuration that already exists.
If you decide to use predefined connection properties, you must ensure that
your resource adapter name matches the name of the installed adapter,
because this is how the adapter instance is associated with these properties.
If you want to change the resource adapter name in the import or export,
use the assembly editor in IBM Integration Designer to change the value in
the import or export.
When you select Use predefined connection properties, the JNDI Lookup
Name field is displayed in place of the properties.
a. Type a value for JNDI Lookup Name.
b. Click Next.
c. Go to step 9.

5. In the Connection properties section, set or change any connection properties
that apply to your configuration.
See “Setting connection properties for the external service wizard” on page
131 for more information about these properties.
Properties marked with an asterisk (*) are required.

6. Optional: To set additional properties, click Advanced and expand the
following sections:
v Event polling configuration
v Event delivery configuration
v Process illegal XML characters
v Logging and tracing properties

The following figure shows the advanced property sections on the Service
Generation and Deployment Configuration window.
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Note: See “Activation specification properties” on page 152 and “Resource
adapter properties” on page 134 for more information about these optional
properties.
v Event polling configuration

a. In Interval between polling periods, type the number of milliseconds
that the adapter waits between polling periods. For more information,
see “Interval between polling periods (PollPeriod)” on page 155.

b. In Maximum events in polling period, type the number of events to
deliver in each polling period. For more information, see “Maximum
events in polling period (PollQuantity)” on page 156.

c. In Retry interval if connection fails, type the number of milliseconds to
wait before trying to connect after a connection failure during polling.
For more information, see “Retry interval if connection fails
(RetryInterval)” on page 158.

d. In Number of times to retry the system connection, type the number of
times to retry the connection before reporting a polling error. For more
information, see “Number of times to retry the system connection
(RetryLimit)” on page 157.

e. If you want the adapter to stop if polling errors occur, select Stop the
adapter when an error is encountered while polling. If you do not
select this option, the adapter logs an exception but continues to run.
For more information, see “Stop the adapter when an error is
encountered while polling (StopPollingOnError)” on page 159.

f. You can select Retry EIS connection on startup if you want the adapter
to retry an inbound connection that was not made to the JDE application
when starting. Only communication failures to the JDE application are
considered. For more information, see “Retry EIS connection on startup
(RetryConnectionOnStartup)” on page 157.

v Event delivery configuration

a. In Type of delivery, select the delivery method. The methods are
described in “Delivery type (DeliveryType)” on page 154.

b. If you want to ensure that events are delivered only once and to only
one export, select Ensure once-only delivery. This option might reduce
performance but does not result in duplicate or missing event delivery.
For more information, see “Ensure once-only event delivery
(AssuredOnceDelivery)” on page 154.

c. Under Number of connections for event delivery, specify the minimum
and maximum number of connections to use to deliver events. For more
information, see “Minimum connections (MinimumConnections)” on
page 156 and “Maximum connections (MaximumConnections)” on page
156.

Figure 35. The Specify the Service Generation and Deployment Properties window, showing
the advanced property sections after clicking the Advanced button
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v Process illegal XML characters

a. From the Illegal XML character processing drop-down list, select one of
the options that correspond to your requirement:
– Do not validate illegal XML characters, if you want to work with the

default adapter behavior.
– Throw exception if contents in the BO contains illegal XML

characters, if you want to proceed after you get an exception
message, and log the illegal XML characters in the trace file, at
runtime.

– Discard all illegal XML characters and related logs, if you want the
adapter to discard the illegal XML characters, and log the characters
in the trace file, at runtime.

v Logging and tracing

– If you have multiple instances of the adapter, set Adapter ID to a value
that is unique for this instance.

– If you want to mask sensitive information in log and trace files (for
example, if you want to avoid making customer information visible in
these files) expand Logging and tracing, provide an ID for the adapter
instance (or accept the default value), and select Disguise user data as
"XXX" in log and trace files.

7. Click Next.
8. Create a new module.

a. In the Specify the Location Properties window, click New in the Module
field.

b. In the Select a Business Integration Project Type window, select Create a
module project or Create a mediation module project, then click Next.

c. In the Create a Module window, type a name for the module.

Note: As you type the name, it is added to the workplace directory
specified in the Location field.

This is the default location. If you want to specify a different location,
remove the check from Use default location and type a new location, or
click Browse and select the location.

d. Specify whether you want to open the module in the assembly diagram
(for module projects) or whether you want to create a mediation flow
component (for mediation module projects). By default, these choices are
selected.

Figure 36. Processing methods for illegal XML characters
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e. Click Finish. The new module is created. When the creation process is
finished, the New Module window closes, and the new module appears in
the Module list in the Service Location Properties window.

v Calendar based scheduling

Select the calendar based scheduling option to create calendar based polling
for inbound activities. You can schedule your business activities, when you
create a new calendar in IBM Integration Designer. The option of working
with the calendar based scheduling feature is only possible with IBM
Integration Designer as the tooling environment. The following figure helps
you to schedule a calendar polling option.

You can either select a blank calendar or create a new calendar for a
module or library. When you select a blank calendar, you will not be able to
set pre-defined time intervals. You have to define your time intervals. When
you create a calendar using a pre-defined template, you can define time
intervals for each template.
a. Click New to create a new calendar entry for a module or library.

You can choose an existing calendar, or create a new calendar instance.
– Click Browse to select an existing calendar module. Or click New to

create a module for the new calendar.
– Click Browse to choose a folder for the calendar. (Optional).
– Enter a name for the new calendar.
– Click Next if you want to generate the calendar, through a predefined

template. Or, click Finish, to create a non template calendar.
b. Click Browse to select an existing calendar for a module or library. In

the Select a Business Calendar screen you can search for all currently
existing calendar files (*cal) in the IBM Integration Designer workspace.
– In the Name field, type the calendar name or click the calendar in the

Matching business calendars screen. Click OK to open the external
service wizard.

– In the WebSphere Integration workspace, select the Calendar
module, and browse Integration logic->Calendars, to view or modify
the calendar schedules. You can modify the intervals and exceptions,
or add new entries for these elements. For more information, refer to
the information at http://publib.boulder.ibm.com/infocenter/
dmndhelp/v7r5mx/index.jsp?topic=/com.ibm.wbpm.wid.bpel.doc/
topics/cbuscal.html.

Figure 37. Polling based on calendar
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Note: You must deploy the Business Calendar module to the same
IBM Business Process Manager or WebSphere Enterprise Service Bus
instance, along with the inbound application. If you do not map these
two connections to the same server instance, the inbound application
using the business calendar will by default, poll as there is no
calendar configured.

9. In the Specify the Location Properties window, you can specify deployment
properties for the new module by performing the following steps.
a. If you want to change the default namespace, clear the Use Default

Namespace check box and type a new path in the Namespace field.
b. Specify the folder within the module where the service description should

be saved by typing a name in the Folder field or by browsing for a folder.
c. Change the name of the interface.

The default name is JDEInboundInterface. You can change it to a more
descriptive title if you prefer.

d. If you want to save the business objects so that they can be used by
another application, click Save business objects to a library, then select a
library from the list, or click New to create a new library.

e. Type a description of the module.
10. Click Finish.

Results

The new module is created, configured and saved to the Business Integration
perspective of IBM Integration Designer.

What to do next

Export the module as an EAR file for deployment.
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Chapter 5. Modifying artifacts

Often business requirements mandate changes to the backend enterprise
information system (EIS) data structures. These changes call for regeneration and
reconfiguration of artifacts (import and export) that were previously generated
using the external service wizard.

A few business scenarios where the output from one enterprise service discovery
flow can be reused in successive flows, are outlined as follows:
v When you want to add a new object to the object set.
v When you want to modify configurations on selected objects like changes to

operations, operation names, and service level settings like security, transactions,
and reliability.

v When you want to remove a discovered object from the object set.
v When you want to rediscover existing objects in the service to synchronize the

service if the objects in the back-end system have been updated.

To modify existing artifacts, you can invoke the wizard in one of the following
ways. The external service wizard is initialized with previously configured settings.
v In the assembly editor, select the component you want to modify, right-click, and

select Edit Binding.
v In the Business Integration view, select the component you want to modify,

right-click, and select Edit Binding.
v Select the component in the assembly editor and select the Properties view. In

the Binding tab, click the Edit link.

Note: The Edit Binding option is available for artifacts generated using IBM
Integration Designer 7.0 only. If you are importing a project interchange from an
earlier version of IBM Integration Designer, the Edit Binding option is not
available. If you have made any manual changes to the configuration, running the
wizard again will overwrite these changes.

Modifying service import
Modify an import component by rediscovering and reconfiguring the objects using
the Edit Binding option in IBM Integration Designer.

About this task

You can invoke the external service wizard to modify the information of a service
import interface. The wizard automatically populates the existing information for
the selected import interface. You can modify the objects and services, and then
regenerate the import component with the modified data.

Procedure
1. Invoke the external service wizard for the selected service interface import

component using one of the following methods.
v In the assembly editor, select the component you want to modify, right-click

and select Edit Binding.
v In the Business Integration view, select the component you want to modify,

right-click and select Edit Binding.
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v Select the interface in the assembly editor and select the Properties view. In
the Binding tab, click the Edit link.

The Find Objects in the Enterprise System window of the external service
wizard is displayed. The external service wizard automatically populates the
existing configuration details for the selected import interface.

2. In the Find Objects in the Enterprise System window, make the required
changes.
a. You can select and configure the following objects:

v To specify the search criteria and select a business function, see “Selecting
business objects and services” on page 44.

v To specify the search criteria for creating an XML List, see “Selecting
business objects and services” on page 58.

b. To modify the configuration of an object from the Selected objects list,
select the object name and then click the (Edit) icon.

c. To remove an object from the Selected objects list, select the object name

and then click the (Remove) button.
3. Click Next. If you click Cancel, the changes you made in the previous step

does not take effect.
4. In the Specify Composite Properties window, specify properties that apply to

all business objects. For more information, to configure the business function,
see “Configuring the selected objects” on page 48 and to configure the XML
List, see “Configuring the selected objects” on page 63.

5. Click Next.
6. In the Service Generation window, modify the service operations if required.
7. Click Finish. The artifacts are regenerated.

Results

The artifacts are regenerated.

What to do next

You can test and deploy your module.

Modifying service export
Modify an export component by rediscovering and reconfiguring the objects using
the Edit Binding option in IBM Integration Designer.

About this task

You can invoke the external service wizard to modify the information of a service
export interface. The wizard automatically populates the existing information for
the selected export interface. You can modify the objects and services, and then
regenerate the export component with the modified data.

Procedure
1. Invoke the external service wizard for the selected service interface export

component using one of the following methods.
v In the assembly editor, select the component you want to modify, right-click

and select Edit Binding.
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v In the Business Integration view, select the component you want to modify,
right-click and select Edit Binding.

v Select the interface in the assembly editor and select the Properties view. In
the Binding tab, click the Edit link.

The Object Discovery and Selection window of the external service wizard is
displayed. The external service wizard automatically populates the existing
configuration details for the selected export interface.

2. In the Find Objects in the Enterprise System window, make the required
changes.
a. You can select and configure the following objects:

v To specify the search criteria that the external service wizard uses to
discover real-time events, see “Selecting business objects and services” on
page 68.

b. To modify the configuration of an object from the Selected objects list,
select the object name and then click the (Edit) icon.

c. To remove an object from the Selected objects list, select the object name

and then click the (Remove) button.
3. Click Next. If you click Cancel, the changes you made in the previous step

does not take effect.
4. In the Specify Composite Properties window, specify properties that apply to

all business objects. For more information, see “Configuring the selected
objects” on page 73.

5. Click Next.
6. In the Service Generation window, modify the service operations if required.
7. Click Finish. The artifacts are regenerated.

Results

The artifacts are regenerated.

What to do next

You can test and deploy your module.
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Chapter 6. Changing interaction specification properties

To change interaction specification properties for your adapter module after
generating the service, use the assembly editor in IBM Integration Designer.

Before you begin

You must have used the external service wizard to generate a service for the
adapter.

About this task

You might want to change interaction specification properties after you have
generated a service for the adapter. Interaction specification properties, which are
optional, are set at the method level, for a specific operation on a specific business
object. The values you specify appear as defaults in all parent business objects
generated by the external service wizard. You can change these properties before
you export the EAR file. You cannot change these properties after you deploy the
application.

To change the interaction specification properties, use the following procedure:

Procedure
1. From the Business Integration perspective of IBM Integration Designer, expand

the module name.
2. Expand Assembly Diagram and double-click the interface.
3. Click the interface in the assembly editor. The module properties are displayed.
4. Click the Properties tab. You can also right-click the interface in the assembly

diagram and click Show in Properties.
5. Under Binding, click Method bindings. The methods for the interface are

displayed, one for each combination of business object and operation.
6. Select the method whose interaction specification property you want to change.
7. Change the property in the Generic tab. Repeat this step for each method

whose interaction specification property you want to change.

Results

The interaction specification properties associated with your adapter module are
changed.

What to do next

Deploy the module.
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Chapter 7. Deploying the module

Deploy a module to place the files that make up your module and adapter into an
operational environment for production or testing. In IBM Integration Designer, the
integrated test environment features runtime support for IBM Business Process
Manager or WebSphere Enterprise Service Bus, or both, depending on the test
environment profiles that you selected during installation.

Deployment environments
There are test and production environments into which you can deploy modules
and adapters.

In IBM Integration Designer, you can deploy your modules to one or more servers
in the test environment. This is typically the most common practice for running
and testing business integration modules. However, you can also export modules
for server deployment on IBM Business Process Manager or WebSphere Enterprise
Service Bus as EAR files using the administrative console or command-line tools.

Deploying the module for testing
In IBM Integration Designer, you can deploy a module that includes an embedded
adapter to the test environment and work with server tools that enable you to
perform such tasks as editing server configurations, starting and stopping servers
and testing the module code for errors. The testing is generally performed on the
interface operations of your components, which enables you to determine whether
the components are correctly implemented.

Adding external dependencies
Dependent JARs have to be added to the libraries directory or packaged in the
EAR.

About this task

The JARs are set in the class path and these dependent libraries have to be made
available for run time when the module is deployed. There are two ways to make
the dependent libraries available, one for either stand-alone deployment or
embedded deployment and the other for embedded deployment only.

Adding external software dependencies to the server runtime
environment
You must copy the required external software dependency files to your runtime
environment before you can run your adapter applications.

About this task

To copy the required files to IBM Business Process Manager or WebSphere
Enterprise Service Bus, use the following procedure.

Procedure
1. Obtain the external software dependency files from your JD Edwards

EnterpriseOne administrator. The files are listed in Table 4 on page 88.
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Table 4. External software dependency files required by JD Edwards EnterpriseOne Tools

JD Edwards
EnterpriseOne Tools,
version 8.9 (SP1, SP2),
8.93

JD Edwards
EnterpriseOne Tools,
version 8.94

JD Edwards EnterpriseOne
Tools, version 8.95, 8.96

JD Edwards EnterpriseOne
Tools, version 8.97, 8.98

connector.jar Common_Jar.jar ApplicationAPIs_JAR.jar ApplicationAPIs_JAR.jar

database.jar Connector.jar ApplicationLogic_JAR.jar ApplicationLogic_JAR.jar

jdeinterop.ini database.jar Base_JAR.jar Base_JAR.jar

jdeLog.properties EventProcessor_EJB.jar BizLogicContainer_JAR.jar BizLogicContainerClient_JAR.jar

kernel.jar jdeutil.jar BizLogicContainerClient_JAR.jar BizLogicContainer_JAR.jar

log4j.jar jdbj.ini bootstrap.jar BusinessLogicServices_Jar.jar

owra.jar jdeinterop.ini castor.jar castor.jar

xalan.jar jdelog.properties Connector.jar commons-httpclient-3.0.jar

xerces.jar kernel.jar ecutils.jar commons-logging.jar

JDBC driver files

For example, if you are
using an Oracle
database server, use the
following JDBC driver
files:

v tnsnames.ora

v ojdbc6.jar

log4j.jar EventProcessor_JAR.jar Connector.jar

xalan.jar EventProcessor_EJB.jar EventProcessor_EJB.jar

xerces.jar jdbj.ini EventProcessor_JAR.jar

JDBC driver files

For example, if you are
using an Oracle
database server, use the
following JDBC driver
files:

v tnsnames.ora

v ojdbc6.jar

JdbjBase_JAR.jar Generator_JAR.jar

JdbjInterfaces_JAR.jar jdbj.ini

jdeinterop.ini JdbjBase_JAR.jar

jdelog.properties JdbjInterfaces_JAR.jar

JdeNet_JAR.jar jdeinterop.ini

lmproxy.jar jdelog.properties

log4j.jar JdeNet_JAR.jar

messagingClient.jar jmxremote.jar

naming.jar jmxremote_optional.jar

PMApi_JAR.jar jmxri.jar

Spec_JAR.jar log4j.jar

System_JAR.jar ManagementAgent_JAR.jar

urlprotocols.jar Metadata.jar

xalan.jar MetadataInterfaces_JAR.jar
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Table 4. External software dependency files required by JD Edwards EnterpriseOne Tools (continued)

JD Edwards
EnterpriseOne Tools,
version 8.9 (SP1, SP2),
8.93

JD Edwards
EnterpriseOne Tools,
version 8.94

JD Edwards EnterpriseOne
Tools, version 8.95, 8.96

JD Edwards EnterpriseOne
Tools, version 8.97, 8.98

xerces.jar PMApi_JAR.jar

JDBC driver files

For example, if you are using
an Oracle database server, use
the following JDBC driver files:

v tnsnames.ora

v ojdbc6.jar

Spec_JAR.jar

SystemInterfaces_JAR.jar

System_JAR.jar

xalan.jar

xerces.jar

xmlparserv2.jar

JDBC driver files

For example, if you are using
an Oracle database server, use
the following JDBC driver files:

v tnsnames.ora

v classes12.zip

2. Copy the files to the server.
v In a testing environment in Integration Designer, copy the files to the

${WAS_INSTALL_ROOT}/runtimes/bi_v7/lib/ext directory.
v In a production environment, copy the files to the ${WAS_INSTALL_ROOT}/

lib/ext directory of IBM Business Process Manager or WebSphere Enterprise
Service Bus.

Results

The external software dependency files for JD Edwards EnterpriseOne are now
part of your runtime environment.

Adding external software dependencies when the adapter is
bundled
You must copy the dependent JAR files to the EAR application before you can run
your adapter applications. You must use this method only for embedded
deployment.

About this task

To obtain the required files and copy them to the EAR application, use the
following procedure:
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Procedure
1. From the appropriate module, go to the workspace and copy the JAR files to

the directory. For example if the name of the module is ModuleName, then go
to the workspace and copy the JAR files to the ModuleNameApp/EarContent
directory.

2. Modify the adapter RAR's manifest file, manifest.mf, with the list of JAR files
required by the adapter. Add the JAR files in the following format: Class-Path:
dependantjar1.jar, dependantjar2.jar.

3. Copy the native libraries to the run time bin directory and deploy the
application.

Results

The vendor software libraries are now a part of your run time environment.

Generating and wiring a target component for testing inbound
processing

Before deploying to the test environment a module that includes an adapter for
inbound processing, you must first generate and wire a target component. This
target component serves as the destination to which the adapter sends events.

Before you begin

You must have generated an export module, using the external service wizard.

About this task

Generating and wiring a target component for inbound processing is required in a
testing environment only. It is not necessary when deploying the adapter in a
production environment.

The target component receives events. You wire the export to the target component
(connecting the two components) using the assembly editor in IBM Integration
Designer. The adapter uses the wire to pass event data (from the export to the
target component).

Procedure
1. Create the target component.

a. From the Business Integration perspective of IBM Integration Designer,
expand Assembly Diagram and double-click the export component. If you
did not change the default value, the name of the export component is the
name of your adapter + InboundInterface.
An interface specifies the operations that can be called and the data that is
passed, such as input arguments, returned values, and exceptions. The
InboundInterface contains the operations required by the adapter to
support inbound processing and is created when you run the external
service wizard.

b. Create a new component by expanding Components, selecting Untyped
Component, and dragging the component to the Assembly Diagram.
The cursor changes to the placement icon.

c. Click the component to have it displayed in the Assembly Diagram.
2. Wire the components.
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a. Click and drag the export component to the new component.
b. Save the assembly diagram. Click File > Save.

3. Generate an implementation for the new component.
a. Right-click on the new component and select Generate Implementation >

Java.
b. Select (default package) and click OK. This creates an endpoint for the

inbound module.
The Java implementation is displayed in a separate tab.

c. Optional: Add print statements to print the data object received at the
endpoint for each of the endpoint methods.

d. Click File > Save to save the changes.

What to do next

Continue deploying the module for testing.

Adding the module to the server
In IBM Integration Designer, you can add modules to one or more servers in the
test environment.

About this task

In order to test your module and its use of the adapter, you need to add the
module to the server.

Procedure
1. Add the module to the server

a. Switch to the servers view. In IBM Integration Designer, select Windows >
Show View > Servers

a. Start the server. In the Servers tab in the lower-right pane of the IBM
Integration Designerscreen, right-click on the server, and then select Start.

2. When the server status is Started, right-click on the server, and select Add and
remove projects.

3. In the Add and Remove Projects screen, select your project and click Add. The
project moves from the Available projects list to the Configured projects list.

4. Click Finish. This deploys the module on the server.
The Console tab in the lower-right pane displays a log while the module is
being added to the server.

What to do next

Test the functionality of your module and the adapter.

Testing the module for outbound processing using the test
client

Test the assembled module and adapter for outbound processing using the IBM
Integration Designer integration test client.

Before you begin

You need to add the module to the server first.
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About this task

Testing a module is performed on the interface operations of your components,
which enables you to determine whether the components are correctly
implemented and the references are correctly wired.

Procedure
1. Select the module you want to test, right-click on it, and select Test > Test

Module.
2. For information about testing a module using the test client, see the Testing

modules and components topic in the IBM Integration Designer information
center.

What to do next

If you are satisfied with the results of testing your module and adapter, you can
deploy the module and adapter to the production environment.

Deploying the module for production
Deploying a module created with the external service wizard to IBM Business
Process Manager or WebSphere Enterprise Service Bus in a production
environment is a two-step process. First, you export the module in IBM Integration
Designer as an enterprise archive (EAR) file. Second, you deploy the EAR file
using the IBM Business Process Manager or WebSphere Enterprise Service Bus
administrative console.

Adding external software dependencies to the server runtime
environment

You must copy the required external software dependency files to your runtime
environment before you can run your adapter applications.

About this task

To copy the required files to IBM Business Process Manager or WebSphere
Enterprise Service Bus, use the following procedure.

Procedure
1. Obtain the external software dependency files from your JD Edwards

EnterpriseOne administrator. The files are listed in Table 5.

Table 5. External software dependency files required by JD Edwards EnterpriseOne Tools

JD Edwards
EnterpriseOne Tools,
version 8.9 (SP1, SP2),
8.93

JD Edwards
EnterpriseOne Tools,
version 8.94

JD Edwards EnterpriseOne
Tools, version 8.95, 8.96

JD Edwards EnterpriseOne
Tools, version 8.97, 8.98

connector.jar Common_Jar.jar ApplicationAPIs_JAR.jar ApplicationAPIs_JAR.jar

database.jar Connector.jar ApplicationLogic_JAR.jar ApplicationLogic_JAR.jar

jdeinterop.ini database.jar Base_JAR.jar Base_JAR.jar

jdeLog.properties EventProcessor_EJB.jar BizLogicContainer_JAR.jar BizLogicContainerClient_JAR.jar

kernel.jar jdeutil.jar BizLogicContainerClient_JAR.jar BizLogicContainer_JAR.jar

log4j.jar jdbj.ini bootstrap.jar BusinessLogicServices_Jar.jar
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Table 5. External software dependency files required by JD Edwards EnterpriseOne Tools (continued)

JD Edwards
EnterpriseOne Tools,
version 8.9 (SP1, SP2),
8.93

JD Edwards
EnterpriseOne Tools,
version 8.94

JD Edwards EnterpriseOne
Tools, version 8.95, 8.96

JD Edwards EnterpriseOne
Tools, version 8.97, 8.98

owra.jar jdeinterop.ini castor.jar castor.jar

xalan.jar jdelog.properties Connector.jar commons-httpclient-3.0.jar

xerces.jar kernel.jar ecutils.jar commons-logging.jar

JDBC driver files

For example, if you are
using an Oracle
database server, use the
following JDBC driver
files:

v tnsnames.ora

v ojdbc6.jar

log4j.jar EventProcessor_JAR.jar Connector.jar

xalan.jar EventProcessor_EJB.jar EventProcessor_EJB.jar

xerces.jar jdbj.ini EventProcessor_JAR.jar

JDBC driver files

For example, if you are
using an Oracle
database server, use the
following JDBC driver
files:

v tnsnames.ora

v ojdbc6.jar

JdbjBase_JAR.jar Generator_JAR.jar

JdbjInterfaces_JAR.jar jdbj.ini

jdeinterop.ini JdbjBase_JAR.jar

jdelog.properties JdbjInterfaces_JAR.jar

JdeNet_JAR.jar jdeinterop.ini

lmproxy.jar jdelog.properties

log4j.jar JdeNet_JAR.jar

messagingClient.jar jmxremote.jar

naming.jar jmxremote_optional.jar

PMApi_JAR.jar jmxri.jar

Spec_JAR.jar log4j.jar

System_JAR.jar ManagementAgent_JAR.jar

urlprotocols.jar Metadata.jar

xalan.jar MetadataInterfaces_JAR.jar

xerces.jar PMApi_JAR.jar

JDBC driver files

For example, if you are using
an Oracle database server, use
the following JDBC driver files:

v tnsnames.ora

v ojdbc6.jar

Spec_JAR.jar
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Table 5. External software dependency files required by JD Edwards EnterpriseOne Tools (continued)

JD Edwards
EnterpriseOne Tools,
version 8.9 (SP1, SP2),
8.93

JD Edwards
EnterpriseOne Tools,
version 8.94

JD Edwards EnterpriseOne
Tools, version 8.95, 8.96

JD Edwards EnterpriseOne
Tools, version 8.97, 8.98

SystemInterfaces_JAR.jar

System_JAR.jar

xalan.jar

xerces.jar

xmlparserv2.jar

JDBC driver files

For example, if you are using
an Oracle database server, use
the following JDBC driver files:

v tnsnames.ora

v classes12.zip

2. Copy the files to the server.
v In a testing environment in Integration Designer, copy the files to the

${WAS_INSTALL_ROOT}/runtimes/bi_v7/lib/ext directory.
v In a production environment, copy the files to the ${WAS_INSTALL_ROOT}/

lib/ext directory of IBM Business Process Manager or WebSphere Enterprise
Service Bus.

Results

The external software dependency files for JD Edwards EnterpriseOne are now
part of your runtime environment.

Installing the RAR file (for modules using stand-alone
adapters only)

If you chose not to embed the adapter with your module, but instead choose to
make the adapter available to all deployed applications in the server instance, you
need to install the adapter in the form of a RAR file to the application server. A
RAR file is a Java archive (JAR) file that is used to package a resource adapter for
the Java 2 Connector (J2C) architecture.

Before you begin

You must set Deploy connector project to On server for use by multiple adapters
in the Specify the Service Generation and Deployment Properties window of the
external service wizard.

About this task

Installing the adapter in the form of a RAR file results in the adapter being
available to all J2EE application components running in the server run time.

Procedure
1. If the server is not running, right-click your server in the Servers view and

select Start.
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2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.
4. Click Resources > Resource Adapters > Resource adapters.
5. In the Resource adapters page, click Install RAR.

6. In the Install RAR file page, click Browse and navigate to the RAR file for
your adapter.
The RAR files are typically installed in the following path:
IID_installation_directory/ResourceAdapters/adapter_name/adapter.rar

7. Click Next.
8. Optional: In the Resource adapters page, change the name of the adapter and

add a description.
9. Click OK.

10. Click Save in the Messages box at the top of the page.

What to do next

The next step is to export the module as an EAR file that you can deploy on the
server.

Exporting the module as an EAR file
Using IBM Integration Designer, export your module as an EAR file. By creating
an EAR file, you capture all of the contents of your module in a format that can be
easily deployed to IBM Business Process Manager or WebSphere Enterprise Service
Bus.

Figure 38. The Install RAR button on the Resource adapters page
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Before you begin

Before you can export a module as an EAR file, you must have created a module
to communicate with your service. The module should be displayed in the IBM
Integration Designer Business Integration perspective.

About this task

To export the module as an EAR file, perform the following procedure.

Procedure
1. Right-click the module and select Export.
2. In the Select window, expand Java EE.
3. Select EAR file and click Next.
4. Optional: Select the correct EAR application. The EAR application is named

after your module, but with “App” added to the end of the name.
5. Browse for the folder on the local file system where the EAR file will be placed.
6. To export the source files, select the Export source files check box. This option

is provided in case you want to export the source files in addition to the EAR
file. Source files include files associated with Java components, data maps, and
so on.

7. To overwrite an existing file, click Overwrite existing file.
8. Click Finish.

Results

The contents of the module are exported as an EAR file.

What to do next

Install the module in the administrative console. This deploys the module to IBM
Business Process Manager or WebSphere Enterprise Service Bus.

Installing the EAR file
Installing the EAR file is the last step of the deployment process. When you install
the EAR file on the server and run it, the adapter, which is embedded as part of
the EAR file, runs as part of the installed application.

Before you begin

You must have exported your module as an EAR file before you can install it on
IBM Business Process Manager or WebSphere Enterprise Service Bus.

About this task

To install the EAR file, perform the following procedure. For more information
about clustering adapter module applications, see the http://www.ibm.com/
software/webservers/appserv/was/library/.

Procedure
1. If the server is not running, right-click your server in the Servers view and

select Start.

96 IBM WebSphere Adapters: IBM WebSphere Adapter for JD Edwards EnterpriseOne User Guide

http://www.ibm.com/software/webservers/appserv/was/library/
http://www.ibm.com/software/webservers/appserv/was/library/


2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.
4. Click Applications > New Application > New Enterprise Application.

5. Click Browse to locate your EAR file and click Next. The EAR file name is the
name of the module followed by "App."

6. Optional: If you are deploying to a clustered environment, complete the
following steps.
a. On the Step 2: Map modules to servers window, select the module and

click Next.
b. Select the name of the server cluster.
c. Click Apply.

7. Click Next. In the Summary page, verify the settings and click Finish.
8. Optional: If you are using an authentication alias, complete the following steps:

a. Expand Security and select Business Integration Security.
b. Select the authentication alias that you want to configure. You must have

administrator or operator rights to change the authentication alias
configurations.

c. Optional: If it is not already specified, type the User name.
d. If it is not already specified, type the Password.
e. If it is not already specified, type the password again in the Confirm

Password field.
f. Click OK.

Results

The project is now deployed and the Enterprise Applications window is displayed.

Figure 39. Preparing for the application installation window
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What to do next

If you want to set or reset any properties or you would like to cluster adapter
project applications, make those changes using the administrative console before
configuring troubleshooting tools.
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Chapter 8. Administering the adapter module

When you are running the adapter in a stand-alone deployment, use the
administrative console of the server to start, stop, monitor, and troubleshoot the
adapter module. In an application that uses an embedded adapter, the adapter
module starts or stops when the application is started or stopped.

Changing configuration properties for embedded adapters
To change the configuration properties after you deploy the adapter as part of a
module, you use the administrative console of the runtime environment. You can
update resource adapter properties (used for general adapter operation) and
managed connection factory properties (used for outbound processing).

Setting resource adapter properties for embedded adapters
To set resource adapter properties for your adapter after it has been deployed as
part of a module, use the administrative console. You select the name of the
property you want to configure and then change or set the value.

Before you begin

Your adapter module must be deployed on IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

Custom properties are default configuration properties shared by all IBM
WebSphere Adapters.

To configure properties using the administrative console, use the following
procedure:

Procedure
1. If the server is not running, right-click your server in the Servers view and

select Start.
2. When the server status changes to Started, right-click the server and select

Administration > Run administrative console.
3. Log on to the administrative console.
4. Select Applications > Application Types > WebSphere enterprise

application.
5. From the Enterprise Applications list, click the name of the adapter module

whose properties you want to change. The Configuration page is displayed.
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6. Under Modules, click Manage Modules.
7. Click IBM WebSphere Adapter for JD Edwards EnterpriseOne.
8. From the Additional Properties list, click Resource Adapter.
9. On the next page, from the Additional Properties list, click Custom

properties.
10. For each property you want to change, perform the following steps.

Note: See “Resource adapter properties” on page 134 for more information
about these properties.
a. Click the name of the property. The Configuration page for the selected

property is displayed.
b. Change the contents of the Value field or type a value, if the field is

empty.
c. Click OK.

11. In the Messages area, click Save.

Results

The resource adapter properties associated with your adapter module are changed.

Figure 40. The Manage Modules selection in the Configuration tab

100 IBM WebSphere Adapters: IBM WebSphere Adapter for JD Edwards EnterpriseOne User Guide



Setting managed (J2C) connection factory properties for
embedded adapters

To set managed connection factory properties for your adapter after it has been
deployed as part of a module, use the administrative console. You select the name
of the property you want to configure and then change or set the value.

Before you begin

Your adapter module must be deployed on IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

You use managed connection factory properties to configure the target JD Edwards
EnterpriseOne server instance.

Note: In the administrative console, the properties are referred to as "J2C
connection factory properties."

To configure properties using the administrative console, use the following
procedure.

Procedure
1. If the server is not running, right-click your server in the Servers view and

select Start.
2. When the server status changes to Started, right-click the server and select

Administration > Run administrative console.
3. Log on to the administrative console.
4. Select Applications > Application Types > WebSphere enterprise

application.
5. In the Enterprise Applications list, click the name of the adapter module

whose properties you want to change.
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6. Under Modules, click Manage Modules.
7. Click IBM WebSphere Adapter for JD Edwards EnterpriseOne.
8. In the Additional Properties list, click Resource Adapter.
9. On the next page, from the Additional Properties list, click J2C connection

factories.
10. Click the name of the connection factory associated with your adapter

module.
11. In the Additional Properties list, click Custom properties.

Custom properties are those J2C connection factory properties that are unique
to IBM WebSphere Adapter for JD Edwards EnterpriseOne. Connection pool
and advanced connection factory properties are properties you configure if
you are developing your own adapter.

12. For each property you want to change, perform the following steps.

Note: See “Managed connection factory properties” on page 138 for more
information about these properties.
a. Click the name of the property.
b. Change the contents of the Value field or type a value, if the field is

empty.
c. Click OK.

13. In the Messages area, click Save.

Figure 41. The Manage Modules selection in the Configuration tab
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Results

The managed connection factory properties associated with your adapter module
are changed.

Setting activation specification properties for embedded
adapters

To set activation specification properties for your adapter after it has been
deployed as part of a module, use the administrative console. You select the name
of the message endpoint property you want to configure, and then change or set
the value.

Before you begin

Your adapter module must be deployed on IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

You use activation specification properties to configure the endpoint for inbound
processing.

To configure properties using the administrative console, use the following
procedure.

Procedure
1. If the server is not running, right-click your server in the Servers view and

select Start.
2. When the server status changes to Started, right-click the server and select

Administration > Run administrative console.
3. Log on to the administrative console.
4. Select Applications > Application Types > WebSphere enterprise

application.
5. From the Enterprise Applications list, click the name of the adapter module

whose properties you want to change.
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6. Under Modules, click Manage Modules.
7. Click IBM WebSphere Adapter for JD Edwards EnterpriseOne.
8. From the Additional Properties list, click Resource Adapter.
9. On the next page, from the Additional Properties list, click J2C activation

specifications.
10. Click the name of the activation specification associated with the adapter

module.
11. From the Additional Properties list, click J2C activation specification custom

properties.
12. For each property you want to change, perform the following steps.

Note: See “Activation specification properties” on page 152 for more
information about these properties.
a. Click the name of the property.
b. Change the contents of the Value field or type a value, if the field is

empty.
c. Click OK.

13. In the Messages area, click Save.

Results

The activation specification properties associated with your adapter module are
changed.

Figure 42. The Manage Modules selection in the Configuration tab

104 IBM WebSphere Adapters: IBM WebSphere Adapter for JD Edwards EnterpriseOne User Guide



Changing configuration properties for stand-alone adapters
To set configuration properties after you install a stand-alone adapter, use the
administrative console of the runtime environment. Provide the general
information about the adapter and then set the resource adapter properties (which
are used for general adapter operation). If the adapter is used for outbound
operations, create a connection factory and then set the properties for it.

Setting resource adapter properties for stand-alone adapters
To set resource adapter properties for your stand-alone adapter after it has been
installed on IBM Business Process Manager or WebSphere Enterprise Service Bus,
use the administrative console. You select the name of the property you want to
configure and then change or set the value.

Before you begin

Your adapter must be installed on IBM Business Process Manager or WebSphere
Enterprise Service Bus.

About this task

Custom properties are default configuration properties shared by all IBM
WebSphere Adapters.

To configure properties using the administrative console, use the following
procedure:

Procedure
1. If the server is not running, right-click your server in the Servers view and

select Start.
2. When the server status changes to Started, right-click the server and select

Administration > Run administrative console.
3. Log on to the administrative console.
4. Click Resources > Resource Adapters > Resource adapters.
5. In the Resource adapters page, click IBM WebSphere Adapter for JD Edwards

EnterpriseOne.
6. In the Additional Properties list, click Custom properties.
7. For each property you want to change, perform the following steps.

Note: See “Resource adapter properties” on page 134 for more information
about these properties.
a. Click the name of the property.
b. Change the contents of the Value field or type a value, if the field is empty.
c. Click OK.

8. In the Messages area, click Save.

Results

The resource adapter properties associated with your adapter are changed.
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Setting managed (J2C) connection factory properties for
stand-alone adapters

To set managed connection factory properties for your stand-alone adapter after it
has been installed on IBM Business Process Manager or WebSphere Enterprise
Service Bus, use the administrative console. You select the name of the property
you want to configure and then change or set the value.

Before you begin

Your adapter must be installed on IBM Business Process Manager or WebSphere
Enterprise Service Bus.

About this task

You use managed connection factory properties to configure the target JD Edwards
EnterpriseOne server instance.

Note: In the administrative console, the properties are referred to as "J2C
connection factory properties."

To configure properties using the administrative console, use the following
procedure:

Procedure
1. If the server is not running, right-click your server in the Servers view and

select Start.
2. When the server status changes to Started, right-click the server and select

Administration > Run administrative console.
3. Log on to the administrative console.
4. Click Resources > Resource Adapters > Resource adapters.
5. In the Resource adapters page, click IBM WebSphere Adapter for JD

Edwards EnterpriseOne.
6. In the Additional Properties list, click J2C connection factories.
7. If you are going to use an existing connection factory, skip ahead to select

from the list of existing connection factories.

Note: If you have selected Specify connection properties when you use the
external service wizard to configure the adapter module, you do not need to
create a connection factory.
If you are creating a connection factory, perform the following steps:
a. Click New.
b. In the General Properties section of the Configuration tab, type a name

for the connection factory. For example, you can type AdapterCF.
c. Type a value for JNDI name. For example, you can type

com/eis/AdapterCF.
d. Optional: Select an authentication alias from the Component-managed

authentication alias list.
e. Click OK.
f. In the Messages area, click Save.

The newly created connection factory is displayed.
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8. In the list of connection factories, click the one you want to use.
9. In the Additional Properties list, click Custom properties.

Custom properties are those J2C connection factory properties that are unique
to WebSphere Adapter for JD Edwards EnterpriseOne. Connection pool and
advanced connection factory properties are properties you configure if you are
developing your own adapter.

10. For each property you want to change, perform the following steps.

Note: See “Managed connection factory properties” on page 138 for more
information about these properties.
a. Click the name of the property.
b. Change the contents of the Value field or type a value, if the field is

empty.
c. Click OK.

11. After you have finished setting properties, click Apply.
12. In the Messages area, click Save.

Results

The managed connection factory properties associated with your adapter are set.

Setting activation specification properties for stand-alone
adapters

To set activation specification properties for your stand-alone adapter after it has
been installed on IBM Business Process Manager or WebSphere Enterprise Service
Bus, use the administrative console. You select the name of the message endpoint
property you want to configure, and then change or set the value.

Before you begin

Your adapter must be installed on IBM Business Process Manager or WebSphere
Enterprise Service Bus.

About this task

You use activation specification properties to configure the endpoint for inbound
processing.

To configure properties using the administrative console, use the following
procedure.

Figure 43. User-defined connection factories for use with the resource adapter
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Procedure
1. If the server is not running, right-click your server in the Servers view and

select Start.
2. When the server status changes to Started, right-click the server and select

Administration > Run administrative console.
3. Log on to the administrative console.
4. Click Resources > Resource Adapters > Resource adapters.
5. In the Resource adapters page, click IBM WebSphere Adapter for JD

Edwards EnterpriseOne.
6. In the Additional Properties list, click J2C activation specifications.
7. If you are going to use an existing activation specification, skip ahead to select

from an existing list of activation specifications.

Note: If you have selected Use predefined connection properties when you
use the external service wizard to configure the adapter module, you must
create an activation specification.
If you are creating an activation specification, perform the following steps:
a. Click New.
b. In the General Properties section of the Configuration tab, type a name

for the activation specification. For example, you can type AdapterAS.
c. Type a value for JNDI name. For example, you can type

com/eis/AdapterAS.
d. Optional: Select an authentication alias from the Authentication alias list.
e. Select a message listener type.
f. Click OK.
g. Click Save in the Messages box at the top of the page.

The newly created activation specification is displayed.
8. In the list of activation specifications, click the one you want to use.
9. In the Additional Properties list, click J2C activation specification custom

properties.
10. For each property you want to set, perform the following steps.

Note: See “Activation specification properties” on page 152 for more
information about these properties.
a. Click the name of the property.
b. Change the contents of the Value field or type a value, if the field is

empty.
c. Click OK.

Note: Add the operationMapping property manually as this is a required
property. This value must be copied from the ".export" file in the Web
application. For example: for an application named 'Test', you can locate the
.export file in the following directory: <WPS_INSTALL_DIR>\profiles\
<ProccssServer_Name>\installedApps\<Cell_Name>\TestApp.ear\Test.jar.

Open this file and copy the value between the <operationMapping> and
</operationMapping> . Now, insert this value to the <operationMapping>
property in the activation specification property.

11. After you have finished setting properties, click Apply.
12. In the Messages area, click Save.

108 IBM WebSphere Adapters: IBM WebSphere Adapter for JD Edwards EnterpriseOne User Guide



Results

The activation specification properties associated with your adapter are set.

Adding dependency libraries to the deployed resource adapter
The deployed resource adapter running in the WebSphere Application Server
requires the same dependency libraries as it does in IBM Integration Designer to
process requests. The method for adding these library files depends on the mode
of the resource adapter deployment: standalone or embedded in the EAR file.

Stand-alone deployment
The dependency libraries may be added to the resource adapter deployed
stand-alone either during initial deployment of the RAR file or by configuring the
Resource Adapter properties after deployment. To set the values during initial
deployment of the RAR file, specify Class path and Native path locations. Class
path is used to point to JAR files, and Native path is used to point to native
libraries, such as *.dll, *.so. To set the dependency library path files after the
adapter has been installed on WebSphere Application Server, use the
administrative console to modify the values for the Resource Adapter.

EAR deployment
For the rare case when the connector needs to be embedded in the EAR file, the
dependant libraries are added as shared libraries. Define the appropriate shared
library containing external dependencies and associate them with the EAR file.

About this task

There are two methods to do this task:
v Using enhanced EAR editor in IBM Integration Designer
v Using administrative console of the IBM Business Process Manager or

WebSphere Enterprise Service Bus

Using enhanced EAR editor:

You can use the EAR editor in IBM Integration Designer to add the dependency
libraries.

About this task

To create shared libraries using the EAR editor, use the following procedure.

Procedure

1. Open Enhanced EAR editor.
2. Click the Deployment tab.
3. Expand Shared Library section.
4. Click Add to add new shared library.
5. Specify the shared library parameters and click OK.
6. Deploy the EAR to the server.

Results

The dependent libraries are added as shared libraries.

Using administrative console of the WebSphere Application Server:
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You can use the administrative console of the IBM Business Process Manager or
WebSphere Enterprise Service Bus to add the dependency libraries.

Before you begin

Ensure that the dependent files are available on the server machine in the separate
folder. If needed, copy the dependent files on the server machine.

Procedure

1. Define WebSphere variables to point to appropriate folders.
2. Define the shared library through the server administrative console; you can

specify it using WebSphere variables defined in step 1.
3. Deploy the EAR to the server.
4. Configure the EAR to reference defined shared library.

Results

The dependent libraries are added as shared libraries.

Starting the application that uses the adapter
Use the administrative console of the server to start an application that uses the
adapter. By default, the application starts automatically when the server starts.

About this task

Use this procedure to start the application, whether it is using an embedded or a
stand-alone adapter. For an application that uses an embedded adapter, the
adapter starts when the application starts. For an application that uses a
stand-alone adapter, the adapter starts when the application server starts.

Procedure
1. If the server is not running, right-click your server in the Servers view and

select Start.
2. When the server status changes to Started, right-click the server and select

Administration > Run administrative console.
3. Log on to the administrative console.
4. Click Applications > Application Types > WebSphere enterprise applications.

Note: The administrative console is labeled “Integrated Solutions Console”.
5. Select the application that you want to start. The application name is the name

of the EAR file you installed, without the .EAR file extension.
6. Click Start.

Results

The status of the application changes to Started, and a message stating that the
application has started displays at the top of the administrative console.

Stopping the application that uses the adapter
Use the administrative console of the server to stop an application that uses the
adapter. By default, the application stops automatically when the server stops.
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About this task

Use this procedure to stop the application, whether it is using an embedded or a
stand-alone adapter. For an application with an embedded adapter, the adapter
stops when the application stops. For an application that uses a stand-alone
adapter, the adapter stops when the application server stops.

Procedure
1. If the server is not running, right-click your server in the Servers view and

select Start.
2. When the server status changes to Started, right-click the server and select

Administration > Run administrative console.
3. Log on to the administrative console.
4. Click Applications > Application Types > WebSphere enterprise applications.

Note: The administrative console is labeled “Integrated Solutions Console”.
5. Select the application that you want to stop. The application name is the name

of the EAR file you installed, without the .EAR file extension.
6. Click Stop.

Results

The status of the application changes to Stopped, and a message stating that the
application has stopped is displayed at the top of the administrative console.

Monitoring performance using Performance Monitoring Infrastructure
Performance Monitoring Infrastructure (PMI) is a feature of the administrative
console that allows you to dynamically monitor the performance of components in
the production environment, including IBM WebSphere Adapter for JD Edwards
EnterpriseOne. PMI collects adapter performance data, such as average response
time and total number of requests, from various components in the server and
organizes the data into a tree structure. You can view the data through the Tivoli®

Performance Viewer, a graphical monitoring tool that is integrated with the
administrative console in IBM Business Process Manager or WebSphere Enterprise
Service Bus.

About this task

Before you enable and configure PMI for your adapter, you must first set the level
of tracing detail and run some events from which to gather performance data.

To learn more about how PMI can help you monitor and improve the overall
performance of your adapter environment, search for PMI on the IBM Business
Process Manager or WebSphere Enterprise Service Bus website:
http://www.ibm.com/software/webservers/appserv/was/library/.

Configuring Performance Monitoring Infrastructure
You can configure Performance Monitoring Infrastructure (PMI) to gather adapter
performance data, such as average response time and total number of requests.
After you configure PMI for your adapter, you can monitor the adapter
performance using Tivoli Performance viewer.
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Before you begin

Before you can configure PMI for your adapter, you must first set the level of
tracing detail and run some events to gather the performance data.
1. To enable tracing and to receive event data, the trace level must be set to either

fine, finer, finest, or all. After *=info, add a colon and a string, for example:
*=info: WBILocationMonitor.CEI.ResourceAdapter.
*=finest: WBILocationMonitor.LOG.ResourceAdapter.*=finest:

For instructions on setting the trace level, see “Enabling tracing with the
Common Event Infrastructure” on page 114.

2. Generate at least one outbound request to produce performance data that you
can configure.

Procedure
1. Enable PMI for your adapter.

a. In the administrative console, expand Monitoring and Tuning, and then
select Performance Monitoring Infrastructure (PMI).

b. From the list of servers, click the name of your server.
c. Select the Configuration tab, and then select the Enable Performance

Monitoring (PMI) check box.
d. Select Custom to selectively enable or disable statistics.

e. Click Apply or OK.
f. Click Save. PMI is now enabled.

2. Configure PMI for your adapter.
a. In the administrative console, expand Monitoring and Tuning, and then

select Performance Monitoring Infrastructure (PMI).
b. From the list of servers, click the name of your server.

Figure 44. Enabling Performance Monitoring Infrastructure
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c. Select Custom.
d. Select the Runtime tab. The following figure shows the Runtime tab.

e. Click WBIStats.RootGroup. This is a PMI sub module for data collected in
the root group. This example uses the name WBIStats for the root group.

f. Click ResourceAdapter. This is a sub module for the data collected for the
JCA adapters.

g. Click the name of your adapter, and select the processes you want to
monitor.

h. In the right pane, select the check boxes for the statistics you want to
gather, and then click Enable.

Results

PMI is configured for your adapter.

What to do next

Now you can view the performance statistics for your adapter.

Viewing performance statistics
You can view adapter performance data through the graphical monitoring tool,
Tivoli Performance Viewer. Tivoli Performance Viewer is integrated with the
administrative console in IBM Business Process Manager or WebSphere Enterprise
Service Bus.

Before you begin

Configure Performance Monitoring Infrastructure for your adapter.

Figure 45. Runtime tab used for configuring PMI
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Procedure
1. In the administrative console, expand Monitoring and Tuning, expand

Performance Viewer, then select Current Activity.
2. In the list of servers, click the name of your server.
3. Under your server name, expand Performance Modules.
4. Click WBIStatsRootGroup.
5. Click ResourceAdapter and the name of your adapter module.
6. If there is more than one process, select the check boxes for the processes

whose statistics you want to view.

Results

The statistics are displayed in the right panel. You can click View Graph to view a
graph of the data, or View Table to see the statistics in a table format.

The following figure shows adapter performance statistics.

Enabling tracing with the Common Event Infrastructure
The adapter can use the Common Event Infrastructure (CEI), a component
embedded in the server, to report data about critical business events such as the
starting or stopping of a poll cycle. Event data can be written to a database or a
trace log file depending on configuration settings.

Figure 46. Adapter performance statistics, using graph view
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About this task

Use this procedure to report CEI entries in the trace log file by using the Common
Base Event Browser within the administrative console.

Procedure
1. In the administrative console, click Troubleshooting.
2. Click Logs and Trace.
3. From the list of servers, click the name of your server.
4. In the Change Log Detail Levels box, click the name of the CEI database (for

example, WBIEventMonitor.CEI.ResourceAdapter.*) or the trace log file (for
example, WBIEventMonitor.LOG.ResourceAdapter.*) to which you want the
adapter to write event data.

5. Select the level of detail about business events that you want the adapter to
write to the database or trace log file, and (optionally) adjust the granularity of
detail associated with messages and traces.
v No Logging. Turns off event logging.
v Messages Only. The adapter reports an event.
v All Messages and Traces. The adapter reports details about an event.
v Message and Trace Levels. Settings for controlling the degree of detail the

adapter reports about the business object payload associated with an event. If
you want to adjust the detail level, select one of the following options:
Fine. The adapter reports the event but none of the business object payload.
Finer. The adapter reports the event and the business object payload
description.
Finest. The adapter reports the event and the entire business object payload.

6. Click OK.

Results

Event logging is enabled. You can view CEI entries in the trace log file or by using
the Common Base Event Browser within the administrative console.
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Chapter 9. Troubleshooting and support

Common troubleshooting techniques and self-help information help you identify
and solve problems quickly.

Adapter returns version conflict exception message
Adapter returns version conflict exception message

Problem

When you install multiple adapters with different versions of
CWYBS_AdapterFoundation.jar, and if a lower version of the
CWYBS_AdapterFoundation.jar is loaded during runtime, the adapter will return
the ResourceAdapterInternalException error message, due to a version conflict. For
example, when you install Oracle E-Business Suite adapter version 7.0.0.3 and
WebSphere Adapter for JD Edwards EnterpriseOne version 7.5, the following error
message is displayed: IBM WebSphere Adapter for JD Edwards EnterpriseOne has
loaded file:/C:/IBM/WebSphere/ProcServer7/profiles/ProcSrv01/
installedConnectors/CWYOE_OracleEBS.rar/CWYBS_AdapterFoundation.jar with
version 7.0.0.3. However, the base level of this jar required is version 7.5. When
you install multiple adapters with different CWYBS_AdapterFoundation.jar
versions, the adapter returns the ResourceAdapterInternalException message, due
to a version conflict.

Solution

Migrate all adapters to the same version level.

For further assistance, visit http://www-947.ibm.com/support/entry/portal/
Overview/Software/WebSphere/WebSphere_Adapters_Family.

Log and Trace Analyzer
The adapter creates log and trace files that can be viewed with the Log and Trace
Analyzer.

The Log and Trace Analyzer can filter log and trace files to isolate the messages
and trace information for the adapter. It can also highlight the adapter's messages
and trace information in the log viewer.

The adapter's component ID for filtering and highlighting is a string composed of
the characters JDERA plus the value of the adapter ID property. For example, if the
adapter ID property is set to 001, the component ID is JDERA001.

If you run multiple instances of the same adapter, ensure that the first eight
characters of the adapter ID property are unique for each instance so that you can
correlate the log and trace information to a particular adapter instance. By making
the first seven characters of an adapter ID property unique, the component ID for
multiple instances of that adapter is also unique, allowing you to correlate the log
and trace information to a particular instance of an adapter. For example, when
you set the adapter ID property of two instances of WebSphere Adapter for JD
Edwards EnterpriseOne to 001 and 002. The component IDs for those instances,
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JDERA001 and JDERA002, are short enough to remain unique, enabling you to
distinguish them as separate adapter instances. However, instances with longer
adapter ID properties cannot be distinguished from each other. If you set the
adapter ID properties of two instances to Instance01 and Instance02, you will not
be able to examine the log and trace information for each adapter instance because
the component ID for both instances is truncated to JDERAInstance.

For outbound processing, the adapter ID property is located in both the resource
adapter and managed connection factory property groups. If you update the
adapter ID property after using the external service wizard to configure the
adapter for outbound processing, be sure to set the resource adapter and managed
connection factory properties consistently. It prevents inconsistent marking of the
log and trace entries. For inbound processing, the adapter ID property is located
only in the resource adapter properties, so this consideration does not apply.

For more information, see the “Adapter ID (AdapterID)” on page 135 property.

Configuring logging and tracing
Configure logging and tracing to suit your requirements. Enable logging for the
adapter to control the status of event processing. Change the adapter log and trace
file names to separate them from other log and trace files.

Configuring logging properties
Use the administrative console to enable logging and to set the output properties
for a log, including the location, level of detail, and output format of the log.

About this task

Before the adapters can log monitored events, you must specify the service
component event points that you want to monitor, what level of detail you require
for each event, and format of the output used to publish the events to the logs.
Use the administrative console to perform the following tasks:
v Enable or disable a particular event log
v Specify the level of detail in a log
v Specify where log files are stored and how many log files are kept
v Specify the format for log output

If you set the output for log analyzer format, you can open trace output using
the Log Analyzer tool, which is an application included with your IBM Process
Server. This is useful if you are trying to correlate traces from two different
server processes, because it allows you to use the merge capability of the Log
Analyzer.

Note: For more information about monitoring on a IBM Process Server, including
service components and event points, see http://publib.boulder.ibm.com/
infocenter/dmndhelp/v7r5mx/topic/com.ibm.wbpm.admin.doc/topics/
welcome_wps_mon.html.

You can change the log configuration statically or dynamically. Static configuration
takes effect when you start or restart the application server. Dynamic or run time
configuration changes apply immediately.

When a log is created, the detail level for that log is set from the configuration
data. If no configuration data is available for a particular log name, the level for
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that log is obtained from the parent of the log. If no configuration data exists for
the parent log, the parent of that log is checked, and so on, up the tree, until a log
with a non-null level value is found. When you change the level of a log, the
change is propagated to the child logs, which recursively propagate the change to
their child log, as necessary.

To enable logging and set the output properties for a log, use the following
procedure.

Procedure
1. In the navigation pane of the administrative console, select Servers >

Application Servers.
2. Click the name of the server that you want to work with.
3. Under Troubleshooting, click Logs and trace.
4. Click Change Log Detail Levels.
5. Specify when you want the change to take effect:

v For a static change to the configuration, click the Configuration tab.
v For a dynamic change to the configuration, click the Runtime tab.

6. Click the names of the packages whose logging level you want to modify. The
package names for WebSphere Adapters start with com.ibm.j2ca.*:
v For the adapter base component, select com.ibm.j2ca.base.*.
v For the adapter base component and all deployed adapters, select

com.ibm.j2ca.*.
v For the WebSphere Adapter for JD Edwards EnterpriseOne only, select the

com.ibm.j2ca.jde.* package.
7. Select the logging level.

Logging Level Description

Fatal The task cannot continue or the component cannot function.

Severe The task cannot continue, but the component can still function.
This logging level also includes conditions that indicate an
impending fatal error, that is, situations that strongly suggest that
resources are on the verge of being depleted.

Warning A potential error has occurred or a severe error is impending.
This logging level also includes conditions that indicate a
progressive failure, for example, the potential leaking of
resources.

Audit A significant event has occurred that affects the server state or
resources.

Info The task is running. This logging level includes general
information outlining the overall progress of a task.

Config The status of a configuration is reported or a configuration
change has occurred.

Detail The subtask is running. This logging level includes general
information detailing the progress of a subtask.

8. Click Apply.
9. Click OK.

10. To have static configuration changes take effect, stop and then restart the IBM
Process Server.

Chapter 9. Troubleshooting and support 119



Results

Log entries from this point forward contain the specified level of information for
the selected adapter components.

Changing the log and trace file names
To keep the adapter log and trace information separate from other processes, use
the administrative console to change the file names. By default, log and trace
information for all processes and applications on a IBM Process Server is written to
the SystemOut.log and trace.log files.

Before you begin

You can change the log and trace file names at any time after the adapter module
has been deployed to an application server.

About this task

You can change the log and trace file names statically or dynamically. Static
changes take effect when you start or restart the application server. Dynamic or
run time changes apply immediately.

Log and trace files are in the install_root/profiles/profile_name/logs/
server_name folder.

To set or change the log and trace file names, use the following procedure.

Procedure
1. In the navigation pane of the administrative console, select Applications >

Enterprise Applications.
2. In the Enterprise Applications list, click the name of the adapter application.

This is the name of the EAR file for the adapter, but without the ear file
extension. For example, if the EAR file is named Accounting_OutboundApp.ear,
then click Accounting_OutboundApp.

3. In the Configuration tab, in the Modules list, click Manage Modules.
4. In the list of modules, click IBM WebSphere Adapter for JD Edwards

EnterpriseOne.
5. In the Configuration tab, under Additional Properties, click Resource Adapter.
6. In the Configuration tab, under Additional Properties, click Custom properties.
7. In the Custom Properties table, change the file names.

a. Click either logFilename to change the name of the log file or
traceFilename to change the name of the trace file.

b. In the Configuration tab, type the new name in the Value field. By default,
the log file is called SystemOut.log and the trace file is called trace.log.

c. Click Apply or OK. Your changes are saved on your local machine.
d. To save your changes to the master configuration on the server, use one of

the following procedures:
v Static change: Stop and restart the server. This method allows you to

make changes, but those changes do not take effect until you stop and
start the server.

v Dynamic change: Click the Save link in the Messages box above the
Custom properties table. Click Save again when prompted.
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Add and Remove buttons in the EMD wizard do not function properly
Problem

When the EMD is run with the same JDBC RAR file consecutively, and the
imported JDBC driver libraries are selected to be removed, all the libraries, even
those not selected, are removed. For example, the DB2® driver libraries consists of
a driver JAR file and a license JAR file. During the second run, if you try to
remove one of the JAR files, both the JAR files are removed.

Cause

This is caused because of an issue with Rational® Application Developer for
WebSphere Software.

Error displayed when using external service discovery wizard
Problem

An error message is displayed when you use the external service discovery wizard
in the following scenario:
1. Add a JDBC driver file in the Locate the Required Files and Libraries page.
2. Click Next and move to the Specify the Discovery Properties panel.
3. Click Back and go to the Locate the Required Files and Libraries page, and add

another JDBC driver file.
4. Click Next and move to the Specify the Discovery Properties panel.

IBM WebSphere Adapter for JDBC returns the following error: 'Failure in
connection to EIS. Failed to load the driver: com.ibm.db2.jcc.DB2Driver. Check that
the JDBC driver classes are in the class path'.

Cause

This is an Eclipse limitation for class loading.

Solution

Close the connector project and reopen it to add the JDBC driver files again

First-failure data capture (FFDC) support
The adapter supports first-failure data capture (FFDC), which provides persistent
records of failures and significant software incidents that occur during run time in
IBM Business Process Manager or WebSphere Enterprise Service Bus.

The FFDC feature runs in the background and collects events and errors that occur
at run time. The feature provides a means for associating failures to one another,
allowing software to link the effects of a failure to their causes, and thereby
facilitate the quick location of the root cause of a failure. The data that is captured
can be used to identify exception processing that occurred during the adapter run
time.

When a problem occurs, the adapter writes exception messages and context data to
a log file, which is located in the install_root/profiles/profile/logs/ffdc
directory.
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For more information about first-failure data capture (FFDC), see the IBM Business
Process Manager or WebSphere Enterprise Service Bus documentation.

Disabling end point applications of the passive adapter

Problem

In the active-passive configuration mode of the adapters, the endpoint application
of the passive adapter instance also listens to the events or messages even if the
enableHASupport property is set to True.

Cause

By default, in WebSphere Application Server, version 7.0, the
alwaysactivateAllMDBs property in the JMS activation specification is set to True.
This enables the endpoint application of all the adapter (active or passive)
instances to listen to the events.

Solution

To stop the endpoint application of the passive adapter instance from listening to
the events, you must set the alwaysactivateAllMDBs property value to False. The
JMS activation specification is associated with one or more MDBs and provides the
necessary configuration to receive events. If the alwaysActivateAllMDBs property is
set to False, then the endpoint application of only the active adapter instance
receives the events.

Perform the following procedure, to set the alwaysActivateAllMDBs property to
False.
1. Log on to the administrative console.
2. Go to Resources> JMS > Activation specifications.
3. Click the activation specification corresponding to the application from the list.
4. Click Custom properties under Additional properties.
5. Click alwaysActivateAllMDBs.
6. Change the value to False.
7. Click Apply and OK.

Result

The endpoint application of only the active adapter instance listens to the events.

Self-help resources
Use the resources of IBM software support to get the most current support
information, obtain technical documentation, download support tools and fixes,
and avoid problems with WebSphere Adapters. The self-help resources also help
you diagnose problems with the adapter and provide information about how to
contact IBM software support.

Support website

The WebSphere Adapters software support website at http://www-947.ibm.com/
support/entry/portal/Overview/Software/WebSphere/
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WebSphere_Adapters_Family provides links to many resources to help you learn
about, use, and troubleshoot WebSphere Adapters, including:
v Flashes (alerts about the product)
v Technical information including the product information center, manuals, IBM

Redbooks®, and whitepapers
v Educational offerings
v Technotes

Recommended fixes

A list of recommended fixes you must apply is available at the following location:
http://www.ibm.com/support/docview.wss?fdoc=aimadp&rs=695
&uid=swg27010397.

Technotes

Technotes provide the most current documentation about WebSphere Adapter for
JD Edwards EnterpriseOne, including the following topics:
v Problems and their currently available solutions
v Answers to frequently asked questions
v How to information about installing, configuring, using, and troubleshooting the

adapter
v IBM Software Support Handbook

For a list of technotes for WebSphere Adapters, visit this address:

http://www.ibm.com/support/search.wss?tc=SSMKUK&rs=695&rank=8
&dc=DB520+D800+D900+DA900+DA800+DB560&dtm.

Plug-in for IBM Support Assistant

WebSphere Adapter for JD Edwards EnterpriseOne provides a plug-in for IBM
Support Assistant, which is a free, local software serviceability workbench. The
plug-in supports the dynamic trace feature. For information about installing or
using IBM Support Assistant, visit this address:

http://www.ibm.com/software/support/isa/.
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Chapter 10. Reference information

To support you in your tasks, reference information includes details about business
objects that are generated by the external service wizard and information about
adapter properties, including those that support bidirectional transformation. It
also includes pointers to adapter messages and related product information.

Business object information
You can determine the purpose of a business object by examining both the
application-specific information within the business object definition file and the
name of the business object. The application-specific information dictates what
operations can be performed on the JD Edwards EnterpriseOne server. The name
typically reflects the operation to be performed and the structure of the business
object.

Application-specific information
Application-specific information (ASI) is metadata that specifies adapter-dependent
information about how to process business objects for the adapter for JD Edwards
EnterpriseOne.

When the external service wizard generates a business object, it automatically
generates a business object definition, which is saved as an XSD (XML Schema
Definition) file. The business object definition contains the application-specific
information for that business object. If you want to change the generated ASI, you
can modify the metadata values either from the Properties tab in the Business
Integration perspective of IBM Integration Designer or by using the business
object editor.

The adapter for JD Edwards EnterpriseOne uses application-specific information
(ASI) to create queries for Create, Retrieve, Update, and Delete operations. ASI is
generated by the external service wizard at three levels: the business-object level,
the property level, and the operation level.

Application-specific information at the business-object-level

Application-specific information (ASI) at the business-object level is typically used
to specify the name of the corresponding database table and to provide
information necessary to perform a physical or logical delete operation. The
following table describes the ASI at the business-object level.

Table 6. Application-specific information at the business-object level

Application-specific information Description

Name Name of operation

BSFN List of business functions associated with the operation
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Table 6. Application-specific information at the business-object level (continued)

Application-specific information Description

AlwaysReturnResponse Used to designate if the adapter returns a response business object for every
request.

If the value is set to true, the adapter always returns a response business
object.

If the value is set to false, an exception is generated after a JDE business
function is executed. This exception is generated against the user's component.

The default value is false.

Note: For runtime exceptions, for example, if the adapter cannot establish a
connection with the JD Edwards EnterpriseOne server, the exception is still
generated against the user's component.

Application-specific information at the property level

Application-specific information (ASI) at the property level is typically used to
specify the metadata for a property. ASI at the property level represents either
child objects or an array of child objects. The following table describes the ASI of a
complex property (a child) or a structure or table property (an array of child
objects).

Table 7. Application-specific information at the property level

Application-specific
information Description Possible values

Name The business function parameter name
as represented in JD Edwards
EnterpriseOne

BSFNName

Type The type of the business function
parameter as it exists in JD Edwards
EnterpriseOne

BSFN

IOType The type of the business function
parameter as it exists in JD Edwards
EnterpriseOne

v IN: the parameter is mapped from the
business object to the business function.

v OUT: the parameter is mapped from the
business function to the business object.

v INOUT: the parameter is mapped both ways.

v DEFAULT: the parameter is mapped using the
default JD Edwards EnterpriseOne value. For
adapter purposes, it is processed as INOUT.

RequiredType Identifies if the parameter is required v YES: the parameter is required.

v NO: the parameter is not required.

v DEFAULT: the parameter is using the JD
Edwards EnterpriseOne value. For adapter
purposes, it is processed as NO.

Length The maximum possible length for the
parameter value

None
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Table 7. Application-specific information at the property level (continued)

Application-specific
information Description Possible values

Reference The xpath of the business object
property that is used to obtain the value
of this attribute. The xpath expression
starts at the business function level

BusinessFunctionContainer
BusinessFunction1
Prop1

BusinessFunction2
Prop2

If BusinessFunction2/Prop2 property needs to
be set with the value of BusinessFunction1/
Prop1, the value of Reference for
BusinessFunction2/Prop2 needs to be set to
BusinessFunction1/Prop1.

Application-specific information at the operation level

Application-specific information (ASI) at the operation level is used by the adapter
to perform operations, such as to retrieve or update information in the JD Edwards
EnterpriseOne server. The following table describes the ASI at the operation level.

Table 8. Application-specific information at the operation level

Application-specific
information Description Value

Name The name of the business object operation v Create

v Retrieve

v Update

v Delete

v RetrieveAll

BSFN.Name The name of the business functions to
process

v Name

v RollbackOnWarnings

BSFN.RollbackOnWarnings Indicates if the adapter needs to rollback
the current transaction when the business
function returns with warnings

False (default setting)
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Table 8. Application-specific information at the operation level (continued)

Application-specific
information Description Value

RunOnError Used to designate if the adapter should
continue to process the sequential JDE
business functions when a business
function encounters an error while
executing the business function.

If the value is set to Yes, the adapter will
continue to process the subsequent
business functions, even if the business
function fails. The error message is stored
to the attribute, BSFNExecutionErrors.

If the value is set to false, the adapter will
stop the execution process and a rollback
operation is performed.

Note: If the ASI RunOnError is set to True
for all business functions, the rollback
operation is not performed. An error
message for each business function that
has failed is stored in the attribute
BSFNExecutionErrors, against each
business function in the response business
object.

False (default setting)

Supported operations
An operation is the action that an adapter can perform on the JD Edwards
EnterpriseOne server during outbound processing. The name of the operation
typically indicates the type of action that the adapter takes, such as create or update.

The following tables defines the operations that the adapter for JD Edwards
EnterpriseOne supports during outbound processing for business functions and
XML Lists.

Table 9. Supported operations of business functions

Operation Definition

Create The top-level business object and all contained children are created.

Update The top-level business object is modified. This operation can include adding and
deleting child objects.

Delete The top-level business object and any contained children are deleted.

Retrieve The top-level business object and any contained children are retrieved.

Table 10. Supported operations of XML Lists

Operation Definition

RetrieveAll Retrieves all records from the JD Edwards EnterpriseOne server that correspond to the
query values specified in the XML List. Returns a result set in the form of a container of
JD Edwards EnterpriseOne query business objects, which represent the data for each
row retrieved from the table.
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Naming conventions
When the external service wizard generates a business object, it provides a name
for the business object based on the name of the object in the JD Edwards
EnterpriseOne server that it uses to build the business object.

When the external service wizard provides a name for the business object, it
converts the name of the object to mixed case, which means that it removes any
separators, such as spaces or underscores, and then capitalizes the first letter of
each word. For example, if the external service wizard uses a JD Edwards
EnterpriseOne server object called CUSTOMER_ADDRESS to generate a business
object, it generates a business object called CustomerAddress.

The generated business object name can indicate the structure of the business
object. However, business objects names have no semantic value to the adapter.
This means that if you change the business object name, the behavior of the
business object remains the same.

Important: If you choose to rename a business object, use the refactoring
functionality in IBM Integration Designer to ensure that you update all of the
business object dependencies. For instructions on using refactoring to rename
business objects, refer to the following link: http://publib.boulder.ibm.com/
infocenter/dmndhelp/v7r5mx/topic/com.ibm.wbpm.wid.bpel.doc/selector/
topics/trefacts.html.

Table 11. Naming conventions

Element Naming convention Example

Name of the
business
graph

The business graph that contains the parent
business object is named for the contained
business object, followed by the string "BG."

GetEffectiveAddressContainerBG

Name of the
business
object
container

<name_of_business_object> Container GetEffectiveAddressContainer

Name of the
business
function

Name of the business function discovered by the
external service wizard

GetEffectiveAddress

Name of the
XML List

Name of the XML List table discovered by the
external service wizard

F0116

Note: Business graph generation is optional and is supported for IBM Business
Process Manager or WebSphere Enterprise Service Bus only.

Outbound configuration properties
IBM WebSphere Adapter for JD Edwards EnterpriseOne has several categories of
outbound connection configuration properties, which you set with the external
service wizard while generating or creating objects and services. You can change
the resource adapter and managed connection factory properties after you deploy
the module to IBM Business Process Manager or WebSphere Enterprise Service Bus
using IBM Integration Designer or the administrative console, but connection
properties for the external service wizard cannot be changed after deployment.
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Guide to information about properties
The properties used to configure WebSphere Adapter for JD Edwards
EnterpriseOne are described in detail in tables included in each of the
configuration properties topics, such as Resource adapter properties, Managed
connection factory properties, and so on. To help you use these tables, information
about each row you might see is explained here.

The following table explains the meaning of each row that might be displayed in
the table for a configuration property.

Row Explanation

Required A required field (property) must have a value in order for the adapter to work.
Sometimes the external service wizard provides a default value for required
properties.

Removing a default value from a required field on the external service wizard
will not change that default value. When a required field contains no value at all,
the external service wizard processes the field using its assigned default value,
and that default value is displayed on the administrative console.

Possible values are Yes and No.

Sometimes a property is required only when another property has a specific
value. When this is the case, the table will note this dependency. For example,

v Yes, when the EventQueryType property is set to Dynamic

v Yes, for Oracle databases

Possible values Lists and describes the possible values that you can select for the property.

Default The predefined value that is set by the external service wizard. When the
property is required, you must either accept the default value or specify one
yourself. If a property has no default value, the table will state No default
value.

The word None is an acceptable default value, and does not mean that there is
no default value.

Unit of measure Specifies how the property is measured, for example in kilobytes or seconds.

Property type Describes the property type. Valid property types include:

v Boolean

v String

v Integer

Usage Describes usage conditions or restrictions that might apply to the property. For
instance, here is how a restriction would be documented:

For Rational® Application Developer for WebSphere Software version 6.40 or
earlier, the password:

v Must be uppercase

v Must be 8 characters in length

For versions of Rational Application Developer for WebSphere Software later
than 6.40, the password:

v Is not case sensitive

v Can be up to 40 characters in length.

This section lists other properties that affect this property or the properties that
are affected by this property and describes the nature of the conditional
relationship.
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Row Explanation

Example Provides sample property values, for example:

"If Language is set to JA (Japanese), code page number is set to 8000".

Globalized If a property is globalized, it has national language support, meaning that you
can set the value in your national language.

Valid values are Yes and No.

Bidi supported Indicates whether the property is supported in bidirectional (bidi) processing.
Bidirectional processing refers to the task of processing data that contains both
right-to-left (Hebrew or Arabic, for example) and left-to-right (a URL or file
path, for example) semantic content within the same file.

Valid values are Yes and No.

Setting connection properties for the external service wizard
External service discovery connection properties establish a connection between the
external service wizard of IBM Integration Designer, a tool that is used to create
business objects, and the JD Edwards EnterpriseOne server. The properties you
configure in the external service wizard specify such things as connection
configuration, bidi properties, and logging and tracing options.

Once a connection between the external service wizard and the JD Edwards
EnterpriseOne server is established, the external service wizard is able to access the
metadata it needs from the JD Edwards EnterpriseOne server to create business
objects.

Note: Some of the properties that you set in the external service wizard are used
as the initial value for the resource adapter and managed connection factory
properties that you can specify at a later time in the wizard.

The external service connection properties and their purposes are described in the
following table. A complete description of each property is provided in the sections
that follow the table. For information on how to read the property detail tables in
the sections that follow, see “Guide to information about properties” on page 130.

Important: If you set any of these connection properties using bidirectional script,
you must set values that identify the format of the bidirectional script entered for
that property.

Table 12. External service connection properties for Adapter for JD Edwards EnterpriseOne

Property name Description

“Environment” on page 132 Specifies the JD Edwards EnterpriseOne environment name

“Log file output location” on page 132 Specifies the location of the log file for external service

“Logging level” on page 132 Specifies the type error for which logging will occur during external
service

“Password” on page 133 Password of the adapter user account on the JD Edwards EnterpriseOne
environment

“Role” on page 133 Name of the role that is associated with the user name used to access the
JD Edwards EnterpriseOne environment.

“User name” on page 134 Name of the adapter user account on the JD Edwards EnterpriseOne
environment
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Environment

This property specifies the JD Edwards EnterpriseOne environment name.

Table 13. Environment details

Required Yes

Default No default value

Property type String

Usage A JD Edwards EnterpriseOne environment is a user-defined pointer that indicates the location
of data and objects on a JD Edwards EnterpriseOne server. Users can be authorized to use
multiple JD Edwards EnterpriseOne environments on a single JD Edwards EnterpriseOne
server.

Globalized Yes

Bidi supported Yes

Log file output location

This property specifies the location of the log file for external service.

Table 14. Log file output location details

Required Yes

Default The .metadata directory of the workspace

Property type String

Usage Use this directory to hold the log file that will list the errors that occur during the discovery
process. The type of discovery errors for which logging occurs is controlled by the Logging
level property.

Example C:\IBM\wid6.1.0\workspace\.metadata\JDEMetadataDiscovery.log

Globalized Yes

Bidi supported No

Logging level

This property specifies the type error for which logging will occur during external
service.

Table 15. Logging level details

Required No

Possible values ALL
OFF
FINE
FINER
FINEST
CONFIG
INFO
SEVERE
WARNING

Default SEVERE

Property type String

Usage Use this property to tailor tracing capabilities. By specifying an error type, you are indicating
that trace operations will occur only for errors of the type specified.
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Table 15. Logging level details (continued)

Example Accepting the default value of SEVERE will provide trace information on errors that fall into
the SEVERE category. Severe errors mean that an operation cannot continue, though the
adapter can still function. Severe errors also include error conditions that indicate an
impending fatal error, that is, reporting on situations that strongly suggest that resources are on
the verge of being depleted.

Other error descriptions are as follows:

v Fatal – Adapter cannot continue. Adapter cannot function

v Warning – Potential error or impending error. This also includes conditions that indicate a
progressive failure, for example, the potential leaking of resources.

v Audit – Significant event affecting adapter state or resources

v Info – General information outlining overall operation progress

v Config – Configuration change or status

v Detail – General information detailing operation progress

Globalized Yes

Bidi supported No

Password

This property specifies the password of the adapter user account on the JD
Edwards EnterpriseOne environment.

Table 16. Password details

Required Yes

Default No default value

Property type String

Usage Passwords are created and named by the JD Edwards EnterpriseOne administrator. There are
no restrictions on the type of characters used, the number of characters used, or the case of the
characters used in passwords.

Globalized No

Bidi supported Yes

Role

This property specifies the name of the role that is associated with the user name
used to access the JD Edwards EnterpriseOne environment.

Table 17. Role details

Required Yes

Default No default value

Property type String

Usage Roles define what authority users have. Users can have multiple roles. A user's access to
applications, forms, table columns, data sources, and so on, is based on one or more roles to
which the user is assigned. Roles are created and named by the JD Edwards EnterpriseOne
administrator.

Examples v System administrator

v Human resources

v Accounting
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Table 17. Role details (continued)

Globalized No

Bidi supported Yes

User name

This property specifies the name of the adapter user account on the JD Edwards
EnterpriseOne environment.

Table 18. User name details

Required Yes

Default No default value

Property type String

Usage User names are created by the JD Edwards EnterpriseOne administrator. There are no
restrictions on the type of characters used, the number of characters used, or the case of the
characters used in user names.

Globalized Yes

Bidi supported Yes

Resource adapter properties
The resource adapter properties control the general operation of the adapter. You
set the resource adapter properties using the external service wizard when you
configure the adapter. After deploying the adapter, use the administrative console
to change these properties.

The following properties for logging and tracing are deprecated:
v LogFileMaxSize
v LogFileName
v LogNumberOfFiles
v TraceFileMaxSize
v TraceFileName
v TraceNumberOfFiles

The following property that was specified as a resource adapter property in
Version 6.2.x applies to the managed connection factory property group in Version
7.0.
v Timeout

The following table lists and describes the resource adapter properties. A more
detailed description of each property is provided in the sections that follow the
table. For information on how to read the property detail tables in the sections that
follow, see “Guide to information about properties” on page 130.

Table 19. Resource adapter properties for Adapter for JD Edwards EnterpriseOne

Name

DescriptionIn the wizard
In the administrative
console

Adapter ID AdapterID Identifies the adapter instance for PMI events and for
logging and tracing.
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Table 19. Resource adapter properties for Adapter for JD Edwards EnterpriseOne (continued)

Name

DescriptionIn the wizard
In the administrative
console

Disguise user data as "XXX"
in log and trace files

HideConfidentialTrace Specifies whether to disguise potentially sensitive
information by writing X strings instead of user data in
the log and trace files.

(Not available) enableHASupport Do not change this property.

(Not available) LogFileSize Deprecated

(Not available) LogFilename Deprecated

(Not available) LogNumberOfFiles Deprecated

(Not available) TraceFileSize Deprecated

(Not available) TraceFileName Deprecated

(Not available) TraceNumberOfFiles Deprecated

Adapter ID (AdapterID)

This property identifies a specific deployment or instance of the adapter.

Table 20. Adapter ID details

Required Yes

Default 001

Property type String

Usage This property identifies the adapter instance in the log and trace files, and also helps
identify the adapter instance while monitoring adapters. The adapter ID is used with an
adapter-specific identifier, JDERA, to form the component name used by the Log and Trace
Analyzer tool. For example, if the adapter ID property is set to 001, the component ID is
JDERA001.

If you run multiple instances of the same adapter, ensure that the first eight characters of
the adapter ID property are unique for each instance so that you can correlate the log and
trace information to a particular adapter instance. By making the first seven characters of
an adapter ID property unique, the component ID for multiple instances of that adapter is
also unique, allowing you to correlate the log and trace information to a particular instance
of an adapter.

For example, when you set the adapter ID property of two instances of WebSphere Adapter
for JD Edwards EnterpriseOne to 001 and 002. The component IDs for those instances,
JDERA001 and JDERA002, are short enough to remain unique, enabling you to distinguish
them as separate adapter instances. However, instances with longer adapter ID properties
cannot be distinguished from each other. If you set the adapter ID properties of two
instances to Instance01 and Instance02, you will not be able to examine the log and trace
information for each adapter instance because the component ID for both instances is
truncated to JDERAInstance.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized Yes

Chapter 10. Reference 135



Table 20. Adapter ID details (continued)

Bidi supported No

Disguise user data as "XXX" in log and trace files
(HideConfidentialTrace)

This property specifies whether to replace user data in log and trace files with a
string of X's to prevent unauthorized disclosure of potentially sensitive data.

Table 21. Disguise user data as "XXX" in log and trace files details

Required No

Possible values True
False

Default False

Property type Boolean

Usage If you set this property to True, the adapter replaces user data with a string of X's when
writing to log and trace files.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized No

Bidi supported No

Enable high availability support (enableHASupport)

Do not change this property. It must be set to true.

Log file maximum size (LogFileMaxSize)

This property specifies the size of the log files in kilobytes.

Table 22. Log file maximum size details

Required No

Default 0

Property type Integer

Usage When the log file reaches it maximum size, the adapter start using a new log file. If the file size
is specified as 0 or no maximum size is specified, the file does not have a maximum size.

Globalized Yes

Bidi supported No
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Log file name (LogFilename)

This property specifies the full path name of the log file.

Table 23. Log file name details

Required No

Default No default value

Property type String

Usage This property is deprecated.

Globalized Yes

Bidi supported Yes

Log number of files (LogNumberOfFiles)

This property specifies the number of log files.

Table 24. Log number of files details

Required No

Default 1

Property type Integer

Usage When a log file reaches its maximum size, the adapter starts using another log file. If no value
is specified, the adapter creates a single log file.

Globalized Yes

Bidi supported No

Trace file maximum size (TraceFileMaxSize)

This property specifies the size of the trace files in kilobytes.

Table 25. Trace file maximum size details

Required No

Default 0

Property type Integer

Usage If no value is specified, then the trace file has no maximum size.

Globalized Yes

Bidi supported No

Trace file name (TraceFilename)

This property specifies the full path of the trace file.

Table 26. Trace file name details

Required No

Default No default value

Unit of measure Kilobytes

Property type String

Usage This property is deprecated.
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Table 26. Trace file name details (continued)

Globalized Yes

Bidi supported Yes

Trace number of files (TraceNumberOfFiles)

This property specifies the number of trace files to use. When a trace file reaches
its maximum size, the adapter starts using another trace file.

Table 27. Trace number of files details

Required No

Default 1

Property type Integer

Usage If no value is specified, the adapter uses a single trace file.

Globalized Yes

Bidi supported No

Managed connection factory properties
Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the JD Edwards EnterpriseOne server.

You set the managed connection factory properties using either the external service
wizard or the administrative console (after deployment).

The following table lists and describes the managed connection factory properties.
A more detailed description of each property is provided in the sections that
follow the table. For information on how to read the property detail tables in the
sections that follow, see “Guide to information about properties” on page 130.

Note: The external service wizard refers to these properties as managed connection
factory properties and IBM Business Process Manager or WebSphere Enterprise
Service Bus administrative console refers to these as (J2C) connection factory
properties.

Table 28. Managed connection factory properties for Adapter for JD Edwards EnterpriseOne

Property name

DescriptionIn the wizard
In the administrative
console

Adapter ID AdapterID Identifies the adapter instance for PMI events and for
logging and tracing.

Disguise user data as "XXX"
in log and trace files

HideConfidentialTrace Specifies whether to disguise potentially sensitive
information by writing X strings instead of user data in
the log and trace files.

“Environment” on page 140 environment Specifies the JD Edwards EnterpriseOne environment
name

“Password” on page 140 password Password of the adapter user account on the JD
Edwards EnterpriseOne environment

“Role” on page 141 role Name of the role that is associated with the user name
used to access the JD Edwards EnterpriseOne
environment.
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Table 28. Managed connection factory properties for Adapter for JD Edwards EnterpriseOne (continued)

Property name

DescriptionIn the wizard
In the administrative
console

“Timeout” on page 141 timeout This property is the global timeout value, in
milliseconds, set on the XML List request execute call.

“User name” on page 142 userName Name of the adapter user account on the JD Edwards
EnterpriseOne environment

“Maximum retries on
connection failure
(connectionRetryLimit) ” on
page 142

connectionRetryLimit Specifies the maximum number of times the adapter
attempts to connect to the Enterprise Information
System (EIS) to reestablish the connection.

“Retry interval if connection
fails
(connectionRetryInterval)”
on page 142

connectionRetryInterval Specifies the time interval between the attempts to
reconnect to EIS, if the connection fails.

Adapter ID (AdapterID)

This property identifies a specific deployment or instance of the adapter.

Table 29. Adapter ID details

Required Yes

Default 001

Property type String

Usage This property identifies the adapter instance in the log and trace files, and also helps
identify the adapter instance while monitoring adapters. The adapter ID is used with an
adapter-specific identifier, JDERA, to form the component name used by the Log and Trace
Analyzer tool. For example, if the adapter ID property is set to 001, the component ID is
JDERA001.

If you run multiple instances of the same adapter, ensure that the first eight characters of
the adapter ID property are unique for each instance so that you can correlate the log and
trace information to a particular adapter instance. By making the first seven characters of
an adapter ID property unique, the component ID for multiple instances of that adapter is
also unique, allowing you to correlate the log and trace information to a particular instance
of an adapter.

For example, when you set the adapter ID property of two instances of WebSphere Adapter
for JD Edwards EnterpriseOne to 001 and 002. The component IDs for those instances,
JDERA001 and JDERA002, are short enough to remain unique, enabling you to distinguish
them as separate adapter instances. However, instances with longer adapter ID properties
cannot be distinguished from each other. If you set the adapter ID properties of two
instances to Instance01 and Instance02, you will not be able to examine the log and trace
information for each adapter instance because the component ID for both instances is
truncated to JDERAInstance.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized Yes
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Table 29. Adapter ID details (continued)

Bidi supported No

Disguise user data as "XXX" in log and trace files
(HideConfidentialTrace)

This property specifies whether to replace user data in log and trace files with a
string of X's to prevent unauthorized disclosure of potentially sensitive data.

Table 30. Disguise user data as "XXX" in log and trace files details

Required No

Possible values True
False

Default False

Property type Boolean

Usage If you set this property to True, the adapter replaces user data with a string of X's when
writing to log and trace files.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized No

Bidi supported No

Environment

This property specifies the JD Edwards EnterpriseOne environment name.

Table 31. Environment details

Required Yes

Default No default value

Property type String

Usage A JD Edwards EnterpriseOne environment is a user-defined pointer that indicates the location
of data and objects on a JD Edwards EnterpriseOne server. Users can be authorized to use
multiple JD Edwards EnterpriseOne environments on a single JD Edwards EnterpriseOne
server.

Example

Globalized Yes

Bidi supported Yes

Password

This property specifies the password of the adapter user account on the JD
Edwards EnterpriseOne environment.
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Table 32. Password details

Required Yes

Default No default value

Property type String

Usage Passwords are created and named by the JD Edwards EnterpriseOne administrator. There are
no restrictions on the type of characters used, the number of characters used, or the case of the
characters used in passwords.

Example

Globalized No

Bidi supported Yes

Role

This property specifies the name of the role that is associated with the user name
used to access the JD Edwards EnterpriseOne environment.

Table 33. Role details

Required Yes

Default No default value

Property type String

Usage Roles define what authority users have. Users can have multiple roles. A user's access to
applications, forms, table columns, data sources, and so on, is based on one or more roles to
which the user is assigned. Roles are created and named by the JD Edwards EnterpriseOne
administrator.

Examples v System administrator

v Human resources

v Accounting

Globalized No

Bidi supported Yes

Timeout

This property specifies the timeout value, in milliseconds, set on the XML List
request call.

Table 34. Timeout details

Required Yes

Default 30,000

Unit of measure Milliseconds

Property type Integer

Usage Use the Timeout property to specify the amount of time the adapter should take to perform a
RetrieveAll operation using an XML List. If no value is specified, the adapter will time out after
30 seconds (30,000 milliseconds).

Globalized Yes

Bidi supported No
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User name

This property specifies the name of the adapter user account on the JD Edwards
EnterpriseOne environment.

Table 35. User name details

Required Yes

Default No default value

Property type String

Usage User names are created by the JD Edwards EnterpriseOne administrator. There are no
restrictions on the type of characters used, the number of characters used, or the case of the
characters used in user names.

Example

Globalized Yes

Bidi supported Yes

Maximum retries on connection failure (connectionRetryLimit)

This property specifies the maximum number of times the adapter will attempt to
reestablish a connection to the EIS server, when the adapter encounters an error
related to the outbound connection.

Table 36. Maximum retries on connection failure property characteristics

Required No

Possible values Integers equal to and greater than zero

Default 0

Property type Integer

Usage When this property is set to:0

v The adapter does not attempt to connect to the EIS server, if an error occurs during startup
and or while establishing a connection. The adapter does not verify if the connection to the
EIS server is valid when there is an outbound request during runtime.

>0

v The adapter attempts to connect to the EIS server for the specified number of times, if an
error occurs during startup or while establishing a connection.

v The adapter verifies if the connection to the EIS server is valid when there is an outbound
request during runtime. If the connection is not valid, it is terminated and a new connection
is created to process the request.

If the adapter fails to establish a connection after trying for the specified number of times, a
connection error is generated.

If the adapter is successful in re-establishing the connection, the outbound operation is
completed.

Globalized No

Bidi supported No

Retry interval if connection fails (connectionRetryInterval)

This property specifies the time interval between the attempts to reconnect to EIS
server if the connection fails.
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Table 37. Retry interval if connection fails property characteristics

Required No

Possible values Integers equal to and greater than zero

Default 60000

Property type Milliseconds

Usage This property is applicable only if the value of the property “Maximum retries on connection
failure” is set to greater than 0.

When the adapter encounters an error while establishing a connection to the EIS server, this
property specifies the time interval the adapter waits between attempts to reestablish a
connection.

Globalized No

Bidi supported No

Interaction specification properties
Interaction specification properties control the interaction for an operation. The
external service wizard sets the interaction specification properties when you
configure the adapter. Typically, you do not need to change these properties.
However, some properties for outbound operations can be changed by the user.

One reason to change the interaction specification properties is to increase the
value of the property that specifies the maximum number of records to be returned
by a RetrieveAll operation, if your RetrieveAll operations do not return complete
information. To change these properties after the application is deployed, use the
assembly editor in IBM Integration Designer. The properties reside in the method
binding of the import.

The following tables list and describe the interaction specification property that
you can set. For information about how to read the property details table, see
“Guide to information about properties” on page 130.

Table 38. Interaction specification property for the Adapter for JD Edwards EnterpriseOne

Property name

DescriptionIn the wizard In the assembly editor

Maximum records for
RetrieveAll operation

Maximum number of
records

Maximum number of records to return during a
RetrieveAll operation

Maximum number of records for RetrieveAll operation

This property specifies the maximum number of records to return for a RetrieveAll
operation.

Table 39. Maximum records for RetrieveAll operation details

Required Yes

Default 100

Usage If the number of hits in the database exceeds the value of the Maximum number of records
property, the adapter returns the error MatchesExceededLimitException and
MatchesExceededLimitFault. Use this property to avoid out-of-memory issues.

Property type Integer

Globalized No
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Table 39. Maximum records for RetrieveAll operation details (continued)

Bidi supported No

Inbound configuration properties
WebSphere Adapter for JD Edwards EnterpriseOne has several categories of
inbound connection configuration properties, which you set with the external
service wizard while generating or creating objects and services. You can change
the resource adapter and activation specification properties after you deploy the
module using IBM Integration Designer or the administrative console, but
connection properties for the external service wizard cannot be changed after
deployment.

Guide to information about properties
The properties used to configure WebSphere Adapter for JD Edwards
EnterpriseOne are described in detail in tables included in each of the
configuration properties topics, such as Resource adapter properties, Managed
connection factory properties, and so on. To help you use these tables, information
about each row you might see is explained here.

The following table explains the meaning of each row that might be displayed in
the table for a configuration property.

Row Explanation

Required A required field (property) must have a value in order for the adapter to work.
Sometimes the external service wizard provides a default value for required
properties.

Removing a default value from a required field on the external service wizard
will not change that default value. When a required field contains no value at all,
the external service wizard processes the field using its assigned default value,
and that default value is displayed on the administrative console.

Possible values are Yes and No.

Sometimes a property is required only when another property has a specific
value. When this is the case, the table will note this dependency. For example,

v Yes, when the EventQueryType property is set to Dynamic

v Yes, for Oracle databases

Possible values Lists and describes the possible values that you can select for the property.

Default The predefined value that is set by the external service wizard. When the
property is required, you must either accept the default value or specify one
yourself. If a property has no default value, the table will state No default
value.

The word None is an acceptable default value, and does not mean that there is
no default value.

Unit of measure Specifies how the property is measured, for example in kilobytes or seconds.

Property type Describes the property type. Valid property types include:

v Boolean

v String

v Integer
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Row Explanation

Usage Describes usage conditions or restrictions that might apply to the property. For
instance, here is how a restriction would be documented:

For Rational Application Developer for WebSphere Software version 6.40 or
earlier, the password:

v Must be uppercase

v Must be 8 characters in length

For versions of Rational Application Developer for WebSphere Software later
than 6.40, the password:

v Is not case sensitive

v Can be up to 40 characters in length.

This section lists other properties that affect this property or the properties that
are affected by this property and describes the nature of the conditional
relationship.

Example Provides sample property values, for example:

"If Language is set to JA (Japanese), code page number is set to 8000".

Globalized If a property is globalized, it has national language support, meaning that you
can set the value in your national language.

Valid values are Yes and No.

Bidi supported Indicates whether the property is supported in bidirectional (bidi) processing.
Bidirectional processing refers to the task of processing data that contains both
right-to-left (Hebrew or Arabic, for example) and left-to-right (a URL or file
path, for example) semantic content within the same file.

Valid values are Yes and No.

Setting connection properties for the external service wizard
External service discovery connection properties establish a connection between the
external service wizard of IBM Integration Designer, a tool that is used to create
business objects, and the JD Edwards EnterpriseOne server. The properties you
configure in the external service wizard specify such things as connection
configuration, bidi properties, and logging and tracing options.

Once a connection between the external service wizard and the JD Edwards
EnterpriseOne server is established, the external service wizard is able to access the
metadata it needs from the JD Edwards EnterpriseOne server to create business
objects.

Note: Some of the properties that you set in the external service wizard are used
as the initial value for the resource adapter and managed connection factory
properties that you can specify at a later time in the wizard.

The external service connection properties and their purposes are described in the
following table. A complete description of each property is provided in the sections
that follow the table. For information on how to read the property detail tables in
the sections that follow, see “Guide to information about properties” on page 130.

Important: If you set any of these connection properties using bidirectional script,
you must set values that identify the format of the bidirectional script entered for
that property.

Chapter 10. Reference 145



Table 40. External service connection properties for Adapter for JD Edwards EnterpriseOne

Property name Description

“Environment” Specifies the JD Edwards EnterpriseOne environment name

“Log file output location” Specifies the location of the log file for external service

“Logging level” Specifies the type error for which logging will occur during external
service

“Password” on page 147 Password of the adapter user account on the JD Edwards EnterpriseOne
environment

“Role” on page 147 Name of the role that is associated with the user name used to access the
JD Edwards EnterpriseOne environment.

“User name” on page 148 Name of the adapter user account on the JD Edwards EnterpriseOne
environment

Environment

This property specifies the JD Edwards EnterpriseOne environment name.

Table 41. Environment details

Required Yes

Default No default value

Property type String

Usage A JD Edwards EnterpriseOne environment is a user-defined pointer that indicates the location
of data and objects on a JD Edwards EnterpriseOne server. Users can be authorized to use
multiple JD Edwards EnterpriseOne environments on a single JD Edwards EnterpriseOne
server.

Globalized Yes

Bidi supported Yes

Log file output location

This property specifies the location of the log file for external service.

Table 42. Log file output location details

Required Yes

Default The .metadata directory of the workspace

Property type String

Usage Use this directory to hold the log file that will list the errors that occur during the discovery
process. The type of discovery errors for which logging occurs is controlled by the Logging
level property.

Example C:\IBM\wid6.1.0\workspace\.metadata\JDEMetadataDiscovery.log

Globalized Yes

Bidi supported No

Logging level

This property specifies the type error for which logging will occur during external
service.
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Table 43. Logging level details

Required No

Possible values ALL
OFF
FINE
FINER
FINEST
CONFIG
INFO
SEVERE
WARNING

Default SEVERE

Property type String

Usage Use this property to tailor tracing capabilities. By specifying an error type, you are indicating
that trace operations will occur only for errors of the type specified.

Example Accepting the default value of SEVERE will provide trace information on errors that fall into
the SEVERE category. Severe errors mean that an operation cannot continue, though the
adapter can still function. Severe errors also include error conditions that indicate an
impending fatal error, that is, reporting on situations that strongly suggest that resources are on
the verge of being depleted.

Other error descriptions are as follows:

v Fatal – Adapter cannot continue. Adapter cannot function

v Warning – Potential error or impending error. This also includes conditions that indicate a
progressive failure, for example, the potential leaking of resources.

v Audit – Significant event affecting adapter state or resources

v Info – General information outlining overall operation progress

v Config – Configuration change or status

v Detail – General information detailing operation progress

Globalized Yes

Bidi supported No

Password

This property specifies the password of the adapter user account on the JD
Edwards EnterpriseOne environment.

Table 44. Password details

Required Yes

Default No default value

Property type String

Usage Passwords are created and named by the JD Edwards EnterpriseOne administrator. There are
no restrictions on the type of characters used, the number of characters used, or the case of the
characters used in passwords.

Globalized No

Bidi supported Yes

Role

This property specifies the name of the role that is associated with the user name
used to access the JD Edwards EnterpriseOne environment.
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Table 45. Role details

Required Yes

Default No default value

Property type String

Usage Roles define what authority users have. Users can have multiple roles. A user's access to
applications, forms, table columns, data sources, and so on, is based on one or more roles to
which the user is assigned. Roles are created and named by the JD Edwards EnterpriseOne
administrator.

Examples v System administrator

v Human resources

v Accounting

Globalized No

Bidi supported Yes

User name

This property specifies the name of the adapter user account on the JD Edwards
EnterpriseOne environment.

Table 46. User name details

Required Yes

Default No default value

Property type String

Usage User names are created by the JD Edwards EnterpriseOne administrator. There are no
restrictions on the type of characters used, the number of characters used, or the case of the
characters used in user names.

Globalized Yes

Bidi supported Yes

Resource adapter properties
The resource adapter properties control the general operation of the adapter. You
set the resource adapter properties using the external service wizard when you
configure the adapter. After deploying the adapter, use the administrative console
to change these properties.

The following properties for logging and tracing are deprecated:
v LogFileMaxSize
v LogFileName
v LogNumberOfFiles
v TraceFileMaxSize
v TraceFileName
v TraceNumberOfFiles

The following property that was specified as a resource adapter property in
Version 6.2.x applies to the managed connection factory property group in Version
7.0.
v Timeout

148 IBM WebSphere Adapters: IBM WebSphere Adapter for JD Edwards EnterpriseOne User Guide



The following table lists and describes the resource adapter properties. A more
detailed description of each property is provided in the sections that follow the
table. For information on how to read the property detail tables in the sections that
follow, see “Guide to information about properties” on page 130.

Table 47. Resource adapter properties for Adapter for JD Edwards EnterpriseOne

Name

DescriptionIn the wizard
In the administrative
console

Adapter ID AdapterID Identifies the adapter instance for PMI events and for
logging and tracing.

Disguise user data as "XXX"
in log and trace files

HideConfidentialTrace Specifies whether to disguise potentially sensitive
information by writing X strings instead of user data in
the log and trace files.

(Not available) enableHASupport Do not change this property.

(Not available) LogFileSize Deprecated

(Not available) LogFilename Deprecated

(Not available) LogNumberOfFiles Deprecated

(Not available) TraceFileSize Deprecated

(Not available) TraceFileName Deprecated

(Not available) TraceNumberOfFiles Deprecated

Adapter ID (AdapterID)

This property identifies a specific deployment or instance of the adapter.

Table 48. Adapter ID details

Required Yes

Default 001

Property type String
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Table 48. Adapter ID details (continued)

Usage This property identifies the adapter instance in the log and trace files, and also helps
identify the adapter instance while monitoring adapters. The adapter ID is used with an
adapter-specific identifier, JDERA, to form the component name used by the Log and Trace
Analyzer tool. For example, if the adapter ID property is set to 001, the component ID is
JDERA001.

If you run multiple instances of the same adapter, ensure that the first eight characters of
the adapter ID property are unique for each instance so that you can correlate the log and
trace information to a particular adapter instance. By making the first seven characters of
an adapter ID property unique, the component ID for multiple instances of that adapter is
also unique, allowing you to correlate the log and trace information to a particular instance
of an adapter.

For example, when you set the adapter ID property of two instances of WebSphere Adapter
for JD Edwards EnterpriseOne to 001 and 002. The component IDs for those instances,
JDERA001 and JDERA002, are short enough to remain unique, enabling you to distinguish
them as separate adapter instances. However, instances with longer adapter ID properties
cannot be distinguished from each other. If you set the adapter ID properties of two
instances to Instance01 and Instance02, you will not be able to examine the log and trace
information for each adapter instance because the component ID for both instances is
truncated to JDERAInstance.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized Yes

Bidi supported No

Disguise user data as "XXX" in log and trace files
(HideConfidentialTrace)

This property specifies whether to replace user data in log and trace files with a
string of X's to prevent unauthorized disclosure of potentially sensitive data.

Table 49. Disguise user data as "XXX" in log and trace files details

Required No

Possible values True
False

Default False

Property type Boolean

Usage If you set this property to True, the adapter replaces user data with a string of X's when
writing to log and trace files.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized No
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Table 49. Disguise user data as "XXX" in log and trace files details (continued)

Bidi supported No

Enable high availability support (enableHASupport)

Do not change this property. It must be set to true.

Log file maximum size (LogFileMaxSize)

This property specifies the size of the log files in kilobytes.

Table 50. Log file maximum size details

Required No

Default 0

Property type Integer

Usage When the log file reaches it maximum size, the adapter start using a new log file. If the file size
is specified as 0 or no maximum size is specified, the file does not have a maximum size.

Globalized Yes

Bidi supported No

Log file name (LogFilename)

This property specifies the full path name of the log file.

Table 51. Log file name details

Required No

Default No default value

Property type String

Usage This property is deprecated.

Globalized Yes

Bidi supported Yes

Log number of files (LogNumberOfFiles)

This property specifies the number of log files.

Table 52. Log number of files details

Required No

Default 1

Property type Integer

Usage When a log file reaches its maximum size, the adapter starts using another log file. If no value
is specified, the adapter creates a single log file.

Globalized Yes

Bidi supported No
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Trace file maximum size (TraceFileMaxSize)

This property specifies the size of the trace files in kilobytes.

Table 53. Trace file maximum size details

Required No

Default 0

Property type Integer

Usage If no value is specified, then the trace file has no maximum size.

Globalized Yes

Bidi supported No

Trace file name (TraceFilename)

This property specifies the full path of the trace file.

Table 54. Trace file name details

Required No

Default No default value

Unit of measure Kilobytes

Property type String

Usage This property is deprecated.

Globalized Yes

Bidi supported Yes

Trace number of files (TraceNumberOfFiles)

This property specifies the number of trace files to use. When a trace file reaches
its maximum size, the adapter starts using another trace file.

Table 55. Trace number of files details

Required No

Default 1

Property type Integer

Usage If no value is specified, the adapter uses a single trace file.

Globalized Yes

Bidi supported No

Activation specification properties
Activation specification properties hold the inbound event processing configuration
information for a message endpoint. You can set activation specification properties
using either the external service wizard or the administrative console.

Activation specification properties are used during endpoint activation to notify
the adapter of eligible event listeners. During inbound processing, the adapter uses
these event listeners to receive events before forwarding them to the endpoint.
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The following table lists the activation specification properties for inbound
communication. You set the activation specification properties using the external
service wizard and can change them using the IBM Integration Designer Assembly
Editor, or after deployment through the administrative console. A more detailed
description of each property is provided in the sections that follow the table. For
information about how to read the property detail tables in the sections that follow,
see “Guide to information about properties” on page 130.

Table 56. Activation specification properties

Property name

DescriptionIn the wizard
In the administrative
console

Auto Acknowledge AutoAcknowledge Specifies the event acknowledge mode that is used.

Delivery type DeliveryType Determines the order in which events are delivered by
the adapter to the export..

Ensure once-only event
delivery

AssuredOnceDelivery Specifies whether the adapter provides assured once
delivery of events..

Retry limit for failed events FailedEventRetryLimit The number of times the adapter attempts to redeliver
an event before marking the event as failed.

Interval between polling
periods

PollPeriod The length of time that the adapter waits between
polling periods..

Maximum connections MaximumConnections The maximum number of connections that the adapter
can use for inbound event delivery..

Maximum events in polling
period

PollQuantity The number of events the adapter delivers to the
export during each poll period..

Minimum connections MinimumConnections The minimum number of connections that the adapter
can use for inbound event delivery..

No Wait NoWait Specifies whether the adapter waits for a time interval
to get an event from the JD Edwards EnterpriseOne
transaction server by invoking the Dynamic Java
Connector API.

Maximum number of retries
in case of system connection
failure

RetryLimit The number of times the adapter tries to reestablish an
inbound connection after an error..

Retry EIS connection on
startup

RetryConnectionOnStartup Controls whether the adapter retries the connection to
the JD Edwards EnterpriseOne server if it cannot
connect at startup.

Time between retries in case
of system connection failure
(milliseconds)

RetryInterval The length of time that the adapter waits between
attempts to reestablish connection after an error during
inbound operations..

Stop the adapter when an
error is encountered while
polling

StopPollingOnError Specifies whether the adapter stops polling for events
when it encounters an error during polling..

Wait Time WaitTime Specifies the waiting time if the No Wait property is
false.

“Stop the adapter when an
error is encountered while
polling
(StopPollingOnError)” on
page 159

StopPollingOnError Specifies whether the adapter stops polling for events
when it encounters an error during polling
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Auto acknowledge (AutoAcknowledge)

This property specifies the event acknowledge mode that is used. You can specify
either the auto acknowledge mode or the client acknowledge mode.

Table 57. Auto acknowledge details

Required No

Possible values True
False

Default False

Property type Boolean

Usage Specifies the event acknowledge mode, which is either the auto acknowledge mode or the
client acknowledge mode.

Example False

Globalized No

Bidi supported Yes

Delivery type (DeliveryType)

This property specifies the order in which events are delivered by the adapter to
the export.

Table 58. Delivery type details

Required No

Possible values ORDERED
UNORDERED

Default ORDERED

Property type String

Usage The following values are supported:

v ORDERED: The adapter delivers events to the export one at a time.

v UNORDERED: The adapter delivers all events to the export at once.

Globalized No

Bidi supported No

Ensure once-only event delivery (AssuredOnceDelivery)

This property specifies whether to provide ensure once-only event delivery for
inbound events.

Table 59. Ensure once-only event delivery details

Required Yes

Possible values True
False

Default True

Property type Boolean
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Table 59. Ensure once-only event delivery details (continued)

Usage When this property is set to True, the adapter provides assured once event
delivery. This means that each event will be delivered once and only once. A
value of False does not provide assured once event delivery, but provides better
performance.

When this property is set to True, the adapter attempts to store transaction
(XID) information in the event store. If it is set to False, the adapter does not
attempt to store the information.

This property is used only if the export component is transactional. If it is not,
no transaction can be used, regardless of the value of this property.

Globalized No

Bidi supported No

Retry limit for failed events (FailedEventRetryLimit)

This property specifies the number of times that the adapter attempts to redeliver
an event before marking the event as failed.

Table 60. Retry limit for failed events details

Required No

Possible values Integers

Default 5

Property type Integer

Usage Use this property to control how many times the adapter tries to send an event
before marking it as failed. It accepts the following values:

Default
If this property is not set, the adapter tries five additional times before
marking the event as failed.

0 The adapter tries to deliver the event an infinite number of times.
When the property is set to 0, the event remains in the event store and
the event is never marked as failed.

> 0 For integers greater than zero, the adapter retries the specified number
of times before marking the event as failed.

< 0 For negative integers, the adapter does not retry failed events.

Globalized No

Bidi supported No

Interval between polling periods (PollPeriod)

This property specifies the length of time that the adapter waits between polling
periods.

Table 61. Interval between polling periods details

Required Yes

Possible values Integers greater than or equal to 0.

Default 2000

Unit of measure Milliseconds

Property type Integer
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Table 61. Interval between polling periods details (continued)

Usage The poll period is established at a fixed rate, which means that if running the
poll cycle is delayed for any reason (for example, if a prior poll cycle takes
longer than expected to complete) the next poll cycle will occur immediately to
make up for the lost time caused by the delay.

Globalized No

Bidi supported No

Maximum connections (MaximumConnections)

This property specifies the maximum number of connections that the adapter can
use for inbound event delivery.

Table 62. Maximum connections details

Required No

Default 1

Property type Integer

Usage Only positive values are valid. Any value less than 1 is treated as 1 by the
adapter.

Globalized No

Bidi supported No

Maximum events in polling period (PollQuantity)

This property specifies the number of events that the adapter delivers to the export
during each poll period.

Table 63. Maximum events in polling period details

Required Yes

Default 10

Property type Integer

Usage The value must be greater than 0. If this value is increased, more events are
processed per polling period and the adapter may perform less efficiently. If this
value is decreased, fewer events are processed per polling period and the
adapter's performance might improve slightly.

Globalized No

Bidi supported No

Minimum connections (MinimumConnections)

This property specifies the minimum number of connections that the adapter can
use for inbound event delivery.

Table 64. Minimum connections details

Required No

Default 1

Property type Integer
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Table 64. Minimum connections details (continued)

Usage Only positive values are valid. Any value less than 1 is treated as 1 by the
adapter.

Globalized No

Bidi supported No

No wait (NoWait)

This property specifies whether the adapter waits for a time interval to get an
event from the JD Edwards EnterpriseOne transaction server by invoking the
Dynamic Java Connector API.

Table 65. No wait details

Required No

Possible values True
False

Default True

Property type Boolean

Usage Specifies whether the adapter waits for a time interval to get an event from the JD Edwards
EnterpriseOne transaction server by invoking the Dynamic Java Connector API.

Example True

Globalized No

Bidi supported Yes

Number of times to retry the system connection (RetryLimit)

This property specifies the number of times the adapter tries to reestablish an
inbound connection.

Table 66. Number of times to retry the system connection details

Required No

Possible values 0 and positive integers

Default 0

Property type Integer

Usage This property controls how many times the adapter retries the connection if the
adapter cannot connect to the JD Edwards EnterpriseOne server to perform
inbound processing. A value of 0 indicates an infinite number of retries.

To control whether the adapter retries if it cannot connect to the JD Edwards
EnterpriseOne server when it is first started, use the RetryConnectionOnStartup
property.

Globalized No

Bidi supported No

Retry EIS connection on startup (RetryConnectionOnStartup)

This property controls whether the adapter attempts to connect again to the JD
Edwards EnterpriseOne server if it cannot connect at startup.
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Table 67. Retry EIS connection on startup details

Required No

Possible values True
False

Default False

Property type Boolean

Usage This property indicates whether the adapter should retry the connection to the
JD Edwards EnterpriseOne server if the connection cannot be made when the
adapter is started:

v Set the property to False when you want immediate feedback about whether
the adapter can establish a connection to the JD Edwards EnterpriseOne
server, for example, when you are building and testing the application that
receives events from the adapter. If the adapter cannot connect, the adapter
writes log and trace information and stops. The administrative console shows
the application status as Stopped. After you resolve the connection problem,
start the adapter manually.

v Set the property to True if you do not need immediate feedback about the
connection. If the adapter cannot connect during startup, it writes log and
trace information, and then attempts to reconnect, using the RetryInterval
property to determine how frequently to retry and the value of the
RetryLimit property to retry multiple times until that value is reached. The
administrative console shows the application status as Started.

Globalized No

Bidi supported No

Retry interval if connection fails (RetryInterval)

When the adapter encounters an error related to the inbound connection, this
property specifies the length of time the adapter waits before trying to reestablish a
connection.

Table 68. Retry interval details

Required Yes

Default 2000

Unit of measure Milliseconds

Property type Integer

Usage Only positive values are valid. When the adapter encounters an error related to
the inbound connection, this property specifies the length of time the adapter
waits before trying to establish a new connection.

Globalized No

Bidi supported No

Stop the adapter when an error is encountered while polling
(StopPollingOnError)

This property specifies whether the adapter will stop polling for events when it
encounters an error during polling.

Table 69. Stop the adapter when an error is encountered while polling details

Required No
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Table 69. Stop the adapter when an error is encountered while polling details (continued)

Possible values True
False

Default False

Property type Boolean

Usage If this property is set to True, the adapter stops polling when it encounters an error.

If this property is set to False, the adapter logs an exception when it encounters an error
during polling and continues polling.

Globalized No

Bidi supported No

Wait time (WaitTime)

This property specifies the waiting time if the No Wait property is false.

Table 70. Wait time details

Required No

Possible values Any positive integer. Any negative integer will be treated as the default value (3000
milliseconds)

Default 3000

Unit of measure Millisecond

Property type Integer

Usage This property specifies the waiting time if the No Wait property is false.

Example 5000

Globalized No

Bidi supported Yes

Stop the adapter when an error is encountered while polling
(StopPollingOnError)

This property specifies whether the adapter will stop polling for events when it
encounters an error during polling.

Table 71. Stop the adapter when an error is encountered while polling details

Required No

Possible values True

Default False

Property type Boolean

Usage If this property is set to True, the adapter stops polling when it encounters an error.

If this property is set to False, the adapter logs an exception when it encounters an error during
polling and continues polling.

Globalized No

Bidi supported No

Chapter 10. Reference 159



Fault business objects
The adapter supports business faults, which are exceptions that are anticipated and
declared in the outbound service description, or import. Business faults occur at
predictable points in a business process, and are caused by a business rule
violation or a constraint violation.

The JD Edwards EnterpriseOne server provides support for outbound fault
handling. The wizard creates the following fault business objects:
v InvalidRequestFault

The adapter throws this fault when it detects a data format error in an attribute
value for a business object. For example, this fault is thrown when a date value
string does not match the supported date format (yyyy-MM-dd for JDEDate
property types and yyyy-MM-dd'T'hh:mm for JDEUTime property types).

v MatchesExceededLimitFault
When processing a RetrieveAll operation, the adapter returns this fault if the
number of records returned from the database query exceeds the value for the
MaxRecords property in the interaction specification.
To increase the number of records that are returned, increase the value of the
MaxRecords property in the interaction specification properties for the
RetrieveAll operation.
The business object for this fault has only one property, matchCount, which is a
string that contains the number of matches.

v MissingDataFault
If the business object that is passed to the outbound operation does not have all
the required attributes, the adapter throws this fault. This fault can occur for the
Create, Delete, Update, Retrieve, and Execute operations.
For example, the adapter throws this exception in the following situations:
– If the requiredType application-specific information is Yes and ioType is not

Default and the property is not set
– If the reference application-specific information is set and requiredType

application-specific information is Yes and the referenced property is not set
v RecordNotFoundFault

When retrieving data, the adapter throws this fault if the record is not found in
the database for the keys specified. This fault can occur for the RetrieveAll
operation.

Globalization
WebSphere Adapter for JD Edwards EnterpriseOne is a globalized application that
can be used in multiple linguistic and cultural environments. Based on character
set support and the locale of the host server, the adapter delivers message text in
the appropriate language. The adapter supports bidirectional script data
transformation between integration components.

Globalization and bidirectional data transformation
The adapter is globalized to support single- and multi-byte character sets and
deliver message text in the specified language. The adapter also performs
bidirectional script data transformation, which refers to the task of processing data
that contains both right-to-left (Hebrew or Arabic, for example) and left-to-right (a
URL or file path, for example) semantic content within the same file.
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Globalization

Globalized software applications are designed and developed for use within
multiple linguistic and cultural environments rather than a single environment.
WebSphere Adapters, IBM Integration Designer, IBM Business Process Manager,
and WebSphere Enterprise Service Bus are written in Java. The Java run time
environment within the Java virtual machine (JVM) represents data in the Unicode
character code set. Unicode contains encodings for characters in most known
character code sets (both single- and multi-byte). Therefore, when data is
transferred between these integration system components, there is no need for
character conversion.

To log error and informational messages in the appropriate language and for the
appropriate country or region, the adapter uses the locale of the system on which
it is running.

Bidirectional script data transformation

Languages such as Arabic and Hebrew are written from right to left, yet they
contain embedded segments of text that are written left to right, resulting in
bidirectional script. When software applications handle bidirectional script data,
standards are used to display and process it. Bidirectional script data
transformation applies only to string type data. IBM Business Process Manager or
WebSphere Enterprise Service Bus use the Windows standard format, but
applications or file systems that exchange data with the server might use a
different format. The adapter transforms bidirectional script data passed between
the two systems so that it is accurately processed and displayed on both sides of a
transaction. It transforms the script data by using a set of properties that defines
the format of script data, as well as properties that identify content or metadata to
which transformation applies.

Bidirectional script data formats

IBM Business Process Manager or WebSphere Enterprise Service Bus use use the
bidirectional format of ILYNN (implicit, left-to-right, on, off, nominal). These five
attributes comprise the format used by Windows. If an application or file system
that sends or receives data from the server uses a different format, the adapter
converts the format prior to introducing the data to the server. For the conversion
to occur, you use the external service wizard to set attribute values that represent
the bidirectional format used by the sending application or file system. This is
done when you deploy the adapter for the first time.

The bidirectional format consists of five attributes. When you set bidirectional
properties, you assign values for each of these attributes. The attributes and
settings are listed in the following table.

Table 72. Bidirectional format attributes

Letter position Purpose Values Description Default setting

1 Order schema I Implicit (Logical) I

V Visual

2 Direction L Left-to-Right L

R Right-to-Left

C Contextual Left-to-Right

D Contextual Right-to-Left
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Table 72. Bidirectional format attributes (continued)

Letter position Purpose Values Description Default setting

3 Symmetric Swapping Y Symmetric swapping is on Y

N Symmetric swapping is off

4 Text Shaping S Text is shaped N

N Text is not shaped (Nominal)

I Initial shaping

M Middle shaping

F Final shaping

B Isolated shaping

5 Numeric Shaping H National (Hindi) N

C Contextual shaping

N Numbers are not shaped (Nominal)

Bidirectional properties that identify data for transformation

To identify business data subject to transformation, set the BiDiContextEIS
property. Do this by specifying values for each of the five bidirectional format
attributes (listed in the preceding table) for the property. The BiDiContextEIS
property can be set for the managed connection factory and the activation
specification.

To identify application-specific data for transformation, annotate the
BiDiContextEIS property and the BiDiMetadata property within a business object.
Do this by using the business object editor withinIBM Integration Designer to to
add the properties as application-specific elements of a business object.

Properties enabled for bidirectional data transformation
Bidirectional data transformation properties enforce the correct format of
bidirectional script data exchanged between an application and integration tools
and runtime environments. Once these properties are set, bidirectional script data
is correctly processed and displayed in IBM Integration Designer and IBM Business
Process Manager or WebSphere Enterprise Service Bus.

Managed connection properties

The following managed connection properties control bidirectional script data
transformation.
v Username
v Password
v Environment
v Role

Activation specification properties

The following activation specification properties are enabled for bidirectional script
data transformation:
v Auto acknowledge
v Guaranteed event delivery
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v No wait
v Wait time

Related information
The following information centers, IBM Redbooks, and web pages contain related
information for WebSphere Adapter for JD Edwards EnterpriseOne.

Information resources
v The WebSphere Business Process Management information resources web page

includes links to articles, Redbooks, documentation, and educational offerings to
help you learn about WebSphere Adapters: http://www14.software.ibm.com/
webapp/wsbroker/redirect?version=pix&product=wps-dist
&topic=bpmroadmaps.

v The WebSphere Adapters library page includes links to all versions of the
documentation: http://www.ibm.com/software/integration/wbiadapters/
library/infocenter/.

Information about related products
v IBM Business Process Manager, version 7.5, information center, which includes

IBM Business Process Manager, IBM WebSphere Enterprise Service Bus, and IBM
Integration Designer information: http://publib.boulder.ibm.com/infocenter/
dmndhelp/v7r5mx/index.jsp.

v IBM Business Process Manager, version 7.0, information center, which includes
IBM Business Process Manager, IBM WebSphere Enterprise Service Bus, and IBM
Integration Designer information: http://publib.boulder.ibm.com/infocenter/
dmndhelp/v7r0mx/index.jsp.

v WebSphere Adapters, version 6.2.x, information center: http://
publib.boulder.ibm.com/infocenter/dmndhelp/v6r2mx/index.jsp.

v IBM WebSphere Adapters, version 7.5 installation on WebSphere Application
Server, version 8.0 information: http://www-01.ibm.com/support/
docview.wss?rs=695&uid=swg27011040.

developerWorks® resources
v WebSphere Adapter Toolkit
v WebSphere business integration zone

Video samples
To help you use WebSphere Adapters, sample videos are available to detail some
of the scenarios.

You can find several Adapter video demos at this FTP location
ftp://ftp.software.ibm.com/software/websphere/integration/wsa/library/videos/.

To view these video samples:
1. Download the zip file of the required sample from the FTP location.
2. Extract the downloaded zip file to your system.
3. From the extracted folder, double-click the HTML file.
4. The video sample will open in your default Web browser.
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Note: The video has a built in audio narration. If you do not want to listen to
the audio, you can lower its tab to the minimum, and slide the tab to an audio
level, whenever you want the audio back.

The following demos are currently available at this location: ftp://
ftp.software.ibm.com/software/websphere/integration/wsa/library/videos/
v AFC: Scheduling Calendar based polling
v AFC: Overcoming an AFC version conflict situation
v Lotus® Domino®: Configuring notification rules for forms in database paths, and

generating their events
v IBM i: Supporting CCSID in the RPG, COBOL, and service programs
v IBM i: Discovering the PCMLS in a local file system
v JDE: Retrieving data using multiple business functions in outbound processing
v Oracle: Integrating support for an Oracle AQ activity
v Oracle: Integrating an XML gateway through JMS in Oracle E-Business Suite
v PeopleSoft: Handling a RecordNotFound fault behavior
v PeopleSoft: Handling an event filtering
v SAP: Monitoring Tivoli ITCAM for a BPM Portfolio requirement
v SAP: Adding random numbers to the end of duplicate field names
v Siebel: Adding codepage properties to both EMD and runtime for an inbound

Business Object scenario
v Siebel: Supporting more than one output argument for a Siebel Business Services

Interface in an outbound scenario
v WAT: Creating a custom adapter using WebSphere Adapter Toolkit
v WAT: Creating a custom adapter outbound interface in WebSphere Adapter

Toolkit
v WAT: Testing a module in WebSphere Adapter Toolkit
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Department 2Z4A/SOM1
294 Route 100
Somers, NY 10589-0100
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows: (c) (your company name) (year). Portions of
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this code are derived from IBM Corp. Sample Programs. (c) Copyright IBM Corp.
_enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information
Programming interface information, if provided, is intended to help you create
application software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program's tools.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning:

Do not use this diagnosis, modification, and tuning information as a programming
interface because it is subject to change.

Trademarks and service marks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other countries,
or both. These and other IBM trademarked terms are marked on their first
occurrence in this information with the appropriate symbol (® or ™), indicating US
registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law
trademarks in other countries. A complete and current list of IBM trademarks is
available on the Web at http://www.ibm.com/legal/copytrade.shtml

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.

Java and all Java based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.

This product includes software developed by the Eclipse Project
(http://www.eclipse.org).
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